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[bookmark: learning-gis-with-this-workbook][bookmark: _Toc160015423]Learning GIS with this workbook
Last Modified: 28 Feb 24, 12:23:03
This workbook contains the exercises for a GIS course in the School of Earth and Environment at University of Leeds.
This workbook is provided in Word format. You can download alternative formats via Minerva, e.g. pdf or epub. Look for the link after the download. These alternative formats are not available directly from Clare.
You are welcome to keep your own notes within your copy of the workbook. An up-to-date version will always be available to you within Minerva. Updates may be made during the module based on questions from students and whether anything appears to be unclear. The date that each chapter was last updated will be just under the chapter heading.
If you are working with both Word and GIS open, you may find it easier to use the instructions if you use Reading view in Word. To try this go to View > Read Mode (Word Desktop app) or View > Reading View in Word online. The View menu will then let you change the background colour, the column width, and some other options. You will be able to change the width of Word and the text and images will scale properly.
To exit reading view, press the Esc key on your keyboard, or the Print Layout button at the bottom of the Word window. Hover over buttons to see a tooltip.
[image: images/svg/videocam-black-24dp.png] Office365 - assistive viewing features
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: software][bookmark: _Toc160015424]Software
The exercises in this workbook are written using QGIS and instructions for gaining access to the software are available in the software document in Minerva.
This workbook acknowledges use of QGIS: QGIS Development Team, 2024. QGIS Geographic Information System. Open Source Geospatial Foundation Project.
[bookmark: how-to-use-these-exercises][bookmark: _Toc160015425]How to use these exercises
The following conventions are used:
Video clips of techniques are available in Minerva or in the list of videoclips. They aren’t fancy, just what you’d see if I gave a demonstration in class, but you may find them useful as a supplement to the written instructions.
They are shown as follows in the worksheets:
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Information boxes point out techniques that you may already know about. They are here as reminders, or as quick tips:
[image: images/svg/info-black-24dp.png] Adding a folder connection in the Catalog pane
If you can’t see your network drive or USB device in the list of folders when adding data or viewing the catalog you need to Connect to folder
For something you should do following previous instructions:
[image: images/svg/create-black-24dp.png] Change page size and orientation
Have a look for each of the tools suggested below and try them out to see what they do. Make notes in the spaces provided.
For a question:
[image: images/svg/help_outline-black-24dp.png] Question title
What do you think of this? Make your own notes either in the document (if you’re using the Word version) or however suits you best.
For a warning - take note of these, they can often save you time and trouble:
[image: images/svg/warning-black-24dp.png] Warning
If you do x it won’t always work! Make sure that you do y.
For recommended reading related to the current section:
[image: images/svg/library_books_black_24dp.png] Recommended reading
Recommendations will usually be to books from the module reading list which is linked from Minerva.
[bookmark: contact-me][bookmark: _Toc160015426]Contact me
If you find any problems with these instructions, please get in touch with me giving full details of the section and the problem and I will do my best to correct it.
Email me at: c.e.gordon@leeds.ac.uk
Clare Gordon © 2024 The University of Leeds.
[image: ../../shared/docs/images/CreativeCommons88x31.png]
Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.
[bookmark: introduction-to-gis-with-qgis][bookmark: _Toc160015427]Introduction to GIS with QGIS
Last Modified: 23 Jan 24, 12:28:43
The background to GIS and an explanation of what it is will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes][bookmark: _Toc160015428]Learning outcomes
When you have completed this section of the workbook you should be able to
· demonstrate how to open a map project in QGIS
· select appropriate tools to navigate in a map document
· use layers to organise and display information on a map
· add information to a layout and prepare it for printing or display
· demonstrate different ways of finding help when using GIS
[bookmark: introduction-to-the-exercises][bookmark: _Toc160015429]Introduction to the exercises
As a GIS specialist you have been asked by Leeds City Council to produce a map of Priority Habitats within 2 km of the Eccup Reservoir Site of Special Scientific Interest (SSSI) in north Leeds, in preparation for a study on how well the SSSI is connected to other habitats.
For this exercise I have created a basic map of the area of North Leeds around Adel and Bramhope, which includes the area of Eccup Reservoir SSSI, and provided some data so that you can explore the GIS application and get used to basic navigation and functions. In future sessions you’ll be preparing the data and setting up the basics for yourself.
[bookmark: obtaining-and-opening-the-sample-map][bookmark: _Toc160015430]Obtaining and opening the sample map
The sample map covers the Adel and Bramhope area of North Leeds and uses data from a number of sources with which you will become familiar during this module.
· Download the NorthLeeds_Q.zip file from Minerva and save it to your computer.
· Create a new folder called gis in the location in which you intend to save all your work for this module.
· Unzip the downloaded file to that folder. (There is more information about zip files in this module in Minerva.)
· In My Computer right-click on the zip file
· If you have 7-zip go to 7-zip > Extract Here[footnoteRef:1] [1:  7-zip is open-source, so if you want to install a copy on your own Windows computer you can - just download it from the 7-zip webpage.] 

· If you don’t have 7-zip, right-click Extract files... and select the location to save the files, then OK[footnoteRef:2] [2:  Note that these instructions are for Windows, if you are on a Mac or Linux computer you will still need to unzip the files, but I don’t have access to one of these to write any specific instructions.] 

[image: images/svg/warning-black-24dp.png] Warning
Never try to use the contents of a zipped file in GIS without extracting it first - it won’t work, or if it does you’ll probably run into problems soon. If you are looking for a file in QGIS and can’t find it, always check via My Computer that the file isn’t inside a zip or 7zip archive.
Once you’ve unzipped the file you should have a folder called NorthLeeds_Q. Enter that folder and have a look at the contents. They should look something like the following image with three folders called styles, gb-overview and vmd-raster_clr, and two files, one called NorthLeeds.gpkg and the other NorthLeeds.qgz.
You will also find a text file called _readme.txt which contains information about the data included in the project.
[image: images/introduction/Data_small.png]
The data inside the folder in the zip file for this project.
[bookmark: opening-the-map-project-in-qgis][bookmark: _Toc160015431]Opening the map project in QGIS
How you open the project depends on whether you are using a university computer or not.
· If you are on a University of Leeds computer, start QGIS by going to AppsAnywhere - instructions on using this will be given in class, or you can find them in the Software document in Minerva.
· If you are on your own computer, or a non-university computer and already have QGIS installed, open QGIS by searching for QGIS in the start menu of your computer. Information on how to install QGIS is in the Software document in Minerva.
· Once QGIS opens, go to Project > Open.
· Navigate to where you unzipped the project files and select NorthLeeds.qgz. If you can’t see the file, it may mean you haven’t unzipped the project correctly.
· Click Open.
· If you are on a computer with QGIS installed, or have already run it via AppsAnywhere, you can also open QGIS by double-clicking on the .qgz file in the folder.
Be patient - it can take a while to open QGIS, particularly the first time you run it on a particular computer.
The image below shows how the project will look in QGIS when you first open it. Note that yours may look different to mine as buttons and toolbars can vary in location and the colours of the contents of your map will probably be different too.
If you are using a different version of QGIS to me, you may find that you get a notice at the top warning you about that. If that happens, just ignore it or close it. It shouldn’t be a problem for you.
[image: images/introduction/QGISOpenProjectAnno.png]
The QGIS window when you first open the North Leeds project. Your toolbars and buttons may look different to mine.
[bookmark: the-browser-panel]The Browser Panel
The browser panel usually appears on the left of your map. In the image above it appears above the Layers panel, but this can vary.
The browser panel allows you to explore spatial data, add data to your map, open projects and view the properties of files. You will find out more about how to use this as you go along, but for now make sure that you know where to find it.
[bookmark: navigation-in-qgis][bookmark: _Toc160015432]Navigation in QGIS
Once you have data on a map in QGIS, there are various tools which allow you to zoom in and out and move around the map view.
[bookmark: the-map-navigation-toolbar]The Map Navigation Toolbar
A lot of the tools for zooming in and out and for moving around the map are available on the Map Navigation Toolbar.
[image: images/introduction/MapNavigationToolbarAnno.png]
The Map Navigation Toolbar.
If the toolbar isn’t already visible in QGIS go to:
· View > Toolbars
· Put a tick in the box next to Map Navigation Toolbar
[image: images/svg/create-black-24dp.png] Trying out the navigation
Try out the following tools in turn on your map so that you are aware of what they do.
Pan - use the hand cursor to “grab” the map and move it around.
Zoom in - click on the button, then on the map, or use the cursor to draw a rectangle over the map defining the area to zoom to. You can also use the middle mouse wheel to zoom in and out of your map.
Zoom out - click on the button, then on the map. You can also use the middle mouse wheel to zoom in and out of your map.
Full extent to see the whole map (you may need to be patient while it loads if it contains much data).
[bookmark: zoom-to-layer]Zoom to Layer
A lot of the work that you do in GIS will be layer-based. Each file that you add to a map is a layer and will appear in the Layers panel on the left.
Zoom to Layer is an extremely useful command to know and you’ll probably find yourself using it a lot.
If you followed the previous section, your map should be zoomed out to its full extent. Use Zoom to Layer to zoom back in to your data as follows:
· Right-click on the greenspace_site layer (sub-heading) in the Layers panel
· Select Zoom to Layer.
Your map should zoom in so that you can see a more close up view of your map which matches the extent of the green space layer.
For now, don’t worry about the odd squares in the background! That’s the GBOverviewPlus layer, which is designed to be viewed as the whole country. We’ll replace that later in this chapter.
[bookmark: changing-the-scale]Changing the scale
Instead of zooming with the mouse wheel or the tool you can change to a particular scale, e.g. 1:100 000, using the scale box at the bottom of the window to select the scale you want. This box always shows the current scale of the map and you can use the dropdown arrow to select preset scales. You can also type a scale in this box, particularly if the scale you want isn’t in the list.
[image: images/svg/help_outline-black-24dp.png] Finding the current scale
Look at the Scale dropdown at the bottom of the window. What is the current scale of your map?
· Click in the scale box at the bottom of the window and select 1:500000 (5 zeros).
The map should zoom to 1:500,000.
· Click in the scale box again but this time type 100000 (5 zeros) into the box, replacing the scale that is already there. You don’t need to type 1:, QGIS will add that automatically.
· Press Enter.
Again, the map should zoom to the scale you’ve set.
[bookmark: spatial-bookmarks][bookmark: _Toc160015433]Spatial bookmarks
Spatial bookmarks enable you to go to a view that you have set up earlier.
[image: images/svg/videocam-black-24dp.png] Spatial bookmarks in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: X01302bff7ffa17e37a27e7d44683c796ef9ab45]Using a bookmark to move to a new location
The map of North Leeds has a bookmark set up to be able to zoom to Golden Acre Park between Adel and Bramhope.
· In the Browser find the Spatial bookmarks subheading and drop it down by clicking on the small arrow to the left.
· Drop down the Project Bookmarks subheading
· You should find a bookmark called Golden Acre Park - double-click on that to be taken to the bookmark.
[image: images/introduction/SpatialBookmarks_small.png]
The Browser showing Spatial Bookmarks > Project Bookmarks. Double-click on Golden Acre Park to zoom to the bookmark.
You should find your map now looks something like the view below.
[image: images/introduction/GoldenAcreParkBookmark_small.png]
The result of double-clicking on the Golden Acre Park bookmark.
[bookmark: creating-a-spatial-bookmark]Creating a spatial bookmark
To set up your own bookmark:
· Pan the map (i.e. move it) to a different location, it doesn’t matter where. You can also zoom in or out to change the zoom-level.
· Either right-click on the Project Bookmarks heading in the Browser or use the keyboard shortcut Ctrl+B to bring up the Bookmark Editor
· Give your bookmark a name - it doesn’t matter what you call it as long as you can see it again.
· The Extent should be correct, but click on Map Canvas Extent to be sure. It will be different to the extent shown in the image below.
· Check that Saved in is set to Project Bookmarks
· Then click on Save
[image: images/introduction/BookmarkEditor_small.png]
Setting up your own bookmark in the Bookmark Editor.
Once you have saved your bookmark it should appear in the Browser.
[image: images/svg/create-black-24dp.png] Check your bookmark
Pan to a different area of the map and rescale your map. Now double-click on your new bookmark. Does it take you back to the correct view?
[bookmark: removing-a-spatial-bookmark]Removing a spatial bookmark
To remove a bookmark that you no longer need just right-click on it in the Browser and Delete Spatial Bookmark.
· Delete your new bookmark now. You won’t need it again.
[bookmark: working-with-map-layers-in-qgis][bookmark: _Toc160015434]Working with map layers in QGIS
[bookmark: what-are-layers]What are layers?
Layers are an essential part of any GIS. Each layer contains a particular set of data or shapes/images on the map.
It’s important to note that each layer is a reference to a particular data source on disk. The data for the layer is stored outside of the map document and QGIS links to it rather than including it.
Layers are controlled from the Layer panel to the left of the main map window. Have a look at the list you can see there.
[image: images/introduction/LayersPanel_small.png]
The QGIS Layers panel showing the layers that have already been added to this project.
In the North Leeds map project the layers include:
· priority_habitats_inventory_england__natural_england.
· GBOverviewPlus.
[image: images/svg/help_outline-black-24dp.png] Looking at the layers panel, what is the name of the other layer in the North Leeds map?
You’ll be working with layers a lot in this module and in any GIS you do in the future, so have a look at the video below and start to get used to the tools in QGIS.
[image: images/svg/videocam-black-24dp.png] Working with layers in QGIS
Go to the module area for this module in Minerva or go to the full list of video clips.
Watch the video clip on “Working with layers in QGIS”. Then get used to working with layers by following the instructions below.
[bookmark: viewing-contents-of-layers]Viewing contents of layers
The Layers panel will act as a “table of contents” of how features in each of your layers look on your map.
In the Layers panel:
· Click on the small black arrow next to a layer to open and close the layer contents.
· In layers with multiple categories of features, you’ll be able to see the symbols or styles for each of those categories.
[image: images/introduction/LayersPanelSymbols_small.png]
The top of the list of symbols for the priority habitats layer showing the different colours for each category.
[image: images/svg/help_outline-black-24dp.png] Looking at layer symbols
Have a look at the greenspace_site layer in the Layer panel. How many different symbols are shown, and what do they look like compared to the symbols on the map?
[bookmark: renaming-layers-in-the-layers-panel]Renaming layers in the Layers panel
You can make the layer names more useful by changing them in the Layers panel. This also means that names will be clearer when you generate legends prior to printing or exporting maps and is an essential thing to check each time you make a map.
When storing GIS data on disk you usually need to make names short and with no spaces for the benefit of the GIS program, this makes them more difficult for you or your audience to read. It’s good practice therefore, to change this in the Layers panel so the names become more “user friendly”.
Note that you are not renaming the original data file by doing this, but just how the name appears in QGIS.
· Select priority_habitats_inventory_england__natural_england in the Layers panel. You’ll see that the name includes underscores instead of spaces. To make this more readable press F2 on the keyboard, or right-click on the layer name and select Rename layer.
· Type the new name, e.g. Priority Habitats Inventory and then press Enter.
[image: images/svg/create-black-24dp.png] Renaming layers
Repeat this with the other two layers in the map to make them more readable too. I’ve suggested names below, but it’s really up to you to call them something that will help you and your audience to understand your map.
• Change greenspace_site to Green spaces.
• Change GBOverviewPlus to Background map.
[bookmark: making-layers-visible-and-invisible]Making layers visible and invisible
There will be times when you don’t want all the layers to be visible on your map, but you won’t necessarily want to remove them completely. It is simple to make layers visible and invisible.
· Click in the little box next to one of the layers - the tick will disappear and so will that layer in your map.
· To make the layer visible click in the little box again.
[image: images/introduction/LayersVisibleInvisible_small.png]
The box is unticked, so the Green spaces layer no longer appears on the map. Tick it again to make it visible once more.
You’ll notice in layers with multiple symbols that you can turn each symbol off individually too. For example:
· Fold down the Green spaces layer with the little black arrow if necessary to display the different symbols, or classes.
· Untick next to Golf Course.
The areas showing Golf Courses should disappear from your map. There are several around the north of Adel but you may need to pan a bit to see them. If you go to the Golden Acre Park spatial bookmark then move south, some should be visible.
· Make sure you tick back in the Golf Course box to show them again.
[bookmark: add-new-layers-to-your-map]Add new layers to your map
There are two simple ways to add new layers. Below I’ll show you how to use both with different types of data.
[image: images/svg/videocam-black-24dp.png] Adding new layers to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
But first, a warning…
[image: images/svg/warning-black-24dp.png] Warning
While it is possible to add data by dragging and dropping it from your file explorer it isn’t really a good idea to do that. It might look as if it has worked at first, but things can sometimes go horribly wrong… Instead use one of the following methods.
Before you add any new data to your map, we’ll start by checking that you have the Project Home heading set in your Browser panel. This will make the following sections easier.
[bookmark: project-home]Project Home
If you have followed good practice and saved your data in the same folder as the map document (.qgz file), you should be able to find everything under the Project Home heading in the Browser. For this project I’ve done that for you, but when you start creating your own projects, that’s something to remember.
[bookmark: checking-project-home-is-set]Checking Project Home is set
If you can’t see the Browser which shows you where files are on your file system, go to:
· View > Panels and tick in the box next to Browser.
To check whether Project Home is set:
· Look for the Project Home subheading in your Browser.
· Drop down to view the contents by clicking on the little black arrow to the left.
[image: images/introduction/BrowserProjectHomeAnno_small.png]
Use the Project home folder not the Home folder.
[image: images/svg/warning-black-24dp.png] Warning
Don’t get confused by the Home folder that will also be visible in the Browser. This is something different! Make sure you’re working with the Project Home which has the green folder icon next to it.
[bookmark: setting-project-home]Setting Project Home
If you can’t see the Project home heading, or there are no files underneath it, you can set it as follows:
· First, check that you have saved your map project - Project > Save or Save as... and check where you are saving it to.
This may be enough to set Project Home, but if it isn’t, and your files still don’t show up under that heading…
· Right-click on the Project Home heading and Set Project Home....
· Navigate to the folder which contains your .qgz file and the data and click to Select Folder. Note that you won’t be able to see the .qgz file, you just need to know which folder it is in.
Your data should now appear under the Project home heading.
[bookmark: adding-layers-to-qgis-with-the-browser]Adding layers to QGIS with the Browser
Have another look at the Browser panel on the left of the QGIS window.
[image: images/introduction/BrowserPanel_small.png]
The Browser Panel in QGIS.
Using the Browser you should be able to navigate to the folder to which you saved your gis project. If you have followed the instructions above, the contents of the folder should be available under Project Home.
[bookmark: refreshing-the-contents-of-the-browser]Refreshing the contents of the Browser
Sometimes you can’t see all your files in the Browser even if you know they are there. This often happens if you have added or unzipped new files after opening the project in QGIS. If this happens, don’t panic, you probably just need to refresh the Browser.
· At the top of the Browser panel look for the Refresh button (arrows going round in a circle) and click on it. Remember you can use tool tips to help you find a particular button.
[bookmark: adding-data-to-your-map]Adding data to your map
We’ll add a more detailed background map to the data that we already have on the map.
· Browse to your downloaded files and look for a folder called vmd-raster_clr.
· Have a look in the folder and find a file called vmd-raster_5337163.tif.
· Drag and drop that file from the Browser to the Layers panel.
· Right-click on the vmd-raster_5337163 layer in the Layers panel and Zoom to Layer(s).
You should zoom out. You may be able to see the new VMD raster layer, but don’t worry if you can’t! Just go onto the next section.
[image: images/introduction/VMDOverview_small.png]
QGIS once you have added the VMD raster layer to your map. Note that the new layer has been moved to the bottom of the list in the Layers panel.
[bookmark: reordering-layers-for-visibility]Reordering layers for visibility
The order of layers in the Layers panel affects how they appear on the map. Layers at the top of the list appear on top of the layers lower down. If you can’t see a layer and you’re sure it should be visible, the first thing to check is that it isn’t covered by another layer.
Whereabouts in the list of layers has your new layer appeared? If it’s at the top it will be covering the rest of the data. If it’s at the bottom, it will probably be hidden by the existing background map.
· To make your new layer visible and allow the other layers to show as well drag and drop the new VMD raster layer (vmd-raster_5337163) so that it is between the Green spaces and Background map layers in the list.
Your map should now look something like the image above, though with the Priority Habitats and Green spaces layers visible, and your Layers panel like the image below.
[image: images/introduction/OrderOfLayers_small.png]
The Layers panel showing the order of the layers. With the background map at the bottom the rest of the layers will show on your map.
[bookmark: X52e55c0ddc43d8b34094594b839315f0728f5a8]Adding vector data from a GeoPackage to a map with the Browser
The vector layers on this map are all stored in a Geopackage called NorthLeeds.gpkg.
[image: images/svg/info-black-24dp.png] Geopackage format
A Geopackage is a form of database specifically designed to store and retrieve spatial data efficiently. It has been relatively recently developed but it’s use as a GIS format has spread very quickly. QGIS encourages the use of GeoPackages and it is increasingly possible to use them in other GIS software.
During this course you will frequently use GeoPackages to store your spatial data. If you want more information about the format there is a lot on the GeoPackage website.
The file extension, .gpkg, will usually show you that your file is a GeoPackage.
If you look at a GeoPackage in your computer’s file explorer you’ll note that it looks like a single file, though if it is open in QGIS you’ll see a couple of “side-carriage” files with the same name but different extensions. If you try opening this file by double-clicking on it, your computer is very unlikely to know what to do with it and will probably present you with a list of possible apps. Just close this and carry on with the next instructions!
If you look at the GeoPackage in the Browser in QGIS you’ll see that there is a little arrow next to it and you can see the contents. This is the advantage of using the browser, it is specifically designed to work with spatial data.
[image: images/introduction/NorthLeedsGeopackage_small.png]
The North Leeds GeoPackage viewed in the Browser. There are five separate layers within the single GeoPackage.
· Drop down the little arrow next to NorthLeeds.gpkg
· You should be able to see the layers that are stored in the GeoPackage - as in the image above.
· Select the local_nature_reserves__england___natural_england layer in the Browser and drag and drop it into the Layers panel
The new layer may well be added to the top of your list of layers, but again, you may need to drag and drop it to the top of the list so it isn’t covered up by other layers.
· Go to the Golden Acre Park spatial bookmark - you should be able to see a Local Nature Reserve to the west of Otley Road. That is Breary Marsh Local Nature Reserve.
· Remember, the Layers panel will allow you to see the style, or colour, of the new layer on your map.
[bookmark: Xf0a732517b6fa88e5949e2f6b7fbb3c8f669fd9]Using the Data Source Manager to add data to a map
You can also add any data, including raster and vector layers, via the Data Source Manager.
· On the menu bar go to Layer > Data Source Manager or find the button on the toolbar by looking at the tool tips.
· Have a look at the list of formats you can add this way - there are lots!
· Click on Vector in the list on the left.
· Then click on the button with three dots to the right of the Source box
· Navigate to the NorthLeeds.gpkg GeoPackage and and click on Open then on Add
· You’ll get a choice of vector layers to add, which also shows how many features are in each layer - select sites_of_special_scientific_interest__england___natural_england
· Click on Add Layers, then on Close
[image: images/introduction/DataSourceManagerVector_small.png]
Adding a vector layer from a GeoPackage via the Data Source Manager.
The new layer will be added to your Layers panel. Try making the Priority Habitats Inventory, Green Spaces, and Local Nature Reserves layers invisible so you can see your new layer clearly. If you are zoomed in to the Golden Acre Park spatial bookmark, again, you should be able to see that there is a Site of Special Scientific Interest (SSSI) to the west of the Otley Road.
[image: images/introduction/InterimMap01_small.png]
The map with the new layers - this is zoomed in to the Golden Acre Park spatial bookmark. Your colours will probably be different.
When you’ve finished looking at your new layer make sure that you make the other layers visible again.
[bookmark: removing-layers]Removing layers
Your map has a lot of layers visible on it and may be looking rather a mess by now, so let’s clear it up.
It’s always a good idea to remove layers that you don’t need, as it keeps your Layers panel less confusing.
You won’t need the GBOverviewPlus (Background map) or Local Nature Reserves layers for the rest of this exercise, so they can be removed.
[image: images/svg/info-black-24dp.png] Removing layers doesn’t delete the data
Note that removing layers from your map just does that. You are not deleting data from your disk. They still exist but you are removing the link between the map and your data.
· Either right-click on the GBOverviewPlus layer (note that I suggested you renamed this to Background map) and Remove layer...
· Or select the layer in the Layers panel and use the keyboard shortcut - Ctrl+D
· You’ll be asked to confirm that you want to remove the layer, click on OK
· Repeat the process with the Local Nature Reserve (local_nature_reserves__england__natural_england) layer. The process is identical for raster and vector layers.
[image: images/svg/create-black-24dp.png] Rename the sites of special scientific interest layer
You will use the sites_of_special_scientific_interest__england___natural_england layer again, so rename it to “Site of Special Scientific Interest (SSSI)”.
[bookmark: grouping-layers]Grouping layers
The Priority Habitats Inventory, SSSI and Green spaces layers are related to each other and could be grouped together to organise the layers panel. Amongst other advantages this would make it easier to turn all the layers in the group on and off together.
· Select the Priority Habitats Inventory, Green spaces and SSSI layers in the Layers panel by clicking on each of them with the Ctrl key held down on your keyboard.
· Right-click on the selected layers and click on Group Selected from the context menu.
· You’ll then get a chance to give the new group a name - type Habitats and reserves as the new group heading. If you can’t type it select the group heading and press F2 or click twice slowly.
· Try making the Habitats and reserves group invisible to check that the layers are actually grouped. You should see all of the Priority habitats, Green spaces and SSSIs disappear from your map, leaving just the vmd-raster layer visible. Don’t forget to make the group visible again!
[image: images/introduction/GroupedLayers_small.png]
The grouped layers in the Layers panel.
[bookmark: layers-in-qgis-and-data-on-disk][bookmark: _Toc160015435]Layers in QGIS and data on disk
I’ve already said above, that “each layer is a reference to a particular data source on disk”. This has implications for how you manage your data, particularly if you are going to be moving your project from one computer to another or moving data within a project folder.
[bookmark: what-happens-if-you-move-your-data]What happens if you move your data?
If you’ve followed the instructions above, you’ll be able to see several layers in your map and in the Layers panel.
What happens if you move these layers outside of QGIS? Let’s have a look.
· Save your map (Ctrl-S or Project > Save) and close QGIS.
· In your system file explorer navigate to where you have saved the files for this project and go into the folder named NorthLeeds_Q.
· Create a new folder inside this one and call it Data.
· Move the NorthLeeds.gpkg file into the new folder.
· Also move the vmd-raster_clr folder into the new folder.
· Now reopen your map in QGIS.
[image: images/svg/help_outline-black-24dp.png] What happens when you open your map?
What’s the first thing that pops up when you try to open your map?
You will probably get a popup window titled Handle Unavailable Layers which lists the layers that QGIS can no longer find in their original location. (Don’t worry if you don’t!)
[image: images/introduction/HandleUnavailableLayers_small.png]
The Handle Unavailable Layers popup.
It is possible to repair the broken links using this dialog, but I find it easier to do so in the main map.
· Click on Keep Unavailable Layers on the popup to close it.
Your map should open but will be blank. Have a look at the Layers panel and you should see small warning triangles on the right next to each missing layer.
[image: images/introduction/MissingLayersWarningTriangles_small.png]
The warning triangles on the right of the layers in the Layers panel. These warn you that the layer is missing.
At this stage, don’t panic! As long as you know where the data files are stored on your computer, you can repair the links from QGIS.
[bookmark: repairing-broken-links-to-data]Repairing broken links to data
[image: images/svg/videocam-black-24dp.png] Repairing broken links to data in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To repair the broken links in the Layers panel:
· Click on the warning triangle next to the Green spaces layer.
The Repair Data Source window should open.
[image: images/introduction/RepairDataSource1_small.png]
The Repair Data Source window.
· Have a look at the bottom of the window - it shows you the Original source URI: - that’s where QGIS is looking for your layer.
· If you don’t know where your data has gone, use the Original source URI as a starting point to look for it. This will also tell you the name of the data file you are looking for.
Once you do know where your data is located on your computer you can easily repair the link by navigating to the data in the list of locations provided.
· In this case you moved all your data into a folder called “Data”, so navigate to that in the Repair Data Source window (if you have Project Home set, you should be able to see your data under that) and look for the NorthLeeds.gpkg file.
· Click on the little arrow next to NorthLeeds.gpkg and then click on the correct layer - greenspace_site.
· Click OK
[image: images/introduction/RepairDataSource2_small.png]
Selecting the correct data source.
Once you click OK you should find that the layer loads as expected, and the warning symbol disappears.
If you are selecting a layer from a GeoPackage you may even find that all the layers from the same GeoPackage load. In this case, hopefully the Sites of Special Scientific Interest and the Priority Habitats Inventory should also appear on your map.
[image: images/svg/create-black-24dp.png] Repair the link for the final layer
The vector layers in your map should be loaded now. If they haven’t all loaded, repeat the process to load each one individually.
You also have a raster layer on your map which won’t have loaded along with the vector layers - vmd-raster_5337163. That will still have the warning symbol.
Use the same instructions as above to load the raster layer, but this time you’ll need to look in the vmd-raster_clr folder for the data, instead of inside the GeoPackage.
Once you’ve done this your map should be complete again and there should be no warning symbols in the Layers panel.
[bookmark: avoiding-missing-file-links]Avoiding missing file links
If you know where your data files are located, you should be able to fix missing links now, but it would be better to avoid needing to in the first place.
· Check that Save paths are set to Relative.
· Go to Project > Properties and make sure you’re on the top tab - General settings.
· In the top section look for Save paths and check that it is set to Relative, not Absolute [footnoteRef:3]. [3:  Setting the save paths to relative instead of absolute means that if the drive letter changes, or you work on a different machine, QGIS still looks for the data in the same relative location compared to the map, rather than expecting them to still be on the original machine.] 

· Click on OK.
· When you download data or set up a new project make sure that you start with a single folder for the project and save everything for that project into that folder. Be disciplined. If you download something, move it to the project folder straight away or you’ll forget and lose it.
· When you download the North Leeds project, all the files are stored in the same folder. This means that if you want to move the project, or save it to another drive, all the data is together. You can move the main folder or zip the whole thing and move that. You don’t need to worry about losing files.
· If you are working on a University computer, make sure you never save your data to the Desktop, the C: drive, or the Downloads folder. Once you’ve logged off the computer, you may lose data that is saved to any of those locations. On these computers, make sure you save everything to your own OneDrive space and give it a chance to synchronise before you log off the computer. If you’re not sure what you’re doing, please ask.
[image: images/svg/warning-black-24dp.png] Warning
Please bear in mind that you need to be aware of where you are saving your files and take responsibility for that yourself. If you lose your files, I probably can’t help you to find them again as I don’t know where they are likely to be.
[bookmark: make-vector-layers-transparent][bookmark: _Toc160015436]Make vector layers transparent
Zoom in close to one of the Sites of Special Scientific Interest on your map. (Make sure the layer is on top of the VMD raster layer. If it isn’t, drag and drop the VMD raster layer to the bottom of the list in the Layers panel.)
You should be able to see that the polygon representing the SSSI is symbolised, or styled, in a solid colour which hides the detail of the base map underneath. We need to make the layer transparent by changing the opacity so that it is still possible to see the detail of the layers below it in the layers panel.
[bookmark: X3c27ded62696fe8b8aab44a17c0ae9f036b0346]Setting transparency/opacity for single symbol layers
[image: images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To make a vector layer transparent:
· Start by making sure that you have the Site of Special Scientific Interest and vmd-raster layers visible on your map.
· Select the Site of Special Scientific Interest layer in the Layers panel.
· Press F7 on your keyboard or click on the Open the Layer Styling Panel button at the top left of the layers panel.
A new panel should open on the right of your map. This controls layer styling, or how your data looks on your map. For now, we are only looking at Opacity.
· Click on the Symbology tab in the icons on the left of the panel - the icon looks like a coloured paint brush.
· Make sure that Fill is selected in the white box at the top - don’t select Simple Fill.
· You should see the Opacity slider below the colour dropdown - this slider controls the transparency or opacity. Move the slider to about 60% or type 60% into the box to the right.
· If you have Live update ticked at the bottom of the panel you should see the difference immediately, otherwise you’ll have to click on Apply. (Unless you have a very slow computer, it’s probably worth ticking Live update if it isn’t already ticked.)
Don’t worry about the colour of your polygons - they will probably be a different colour to my example below but that doesn’t matter.
[image: images/introduction/Opacity_small.png]
Changing opacity/transparency in the Layer Styling panel.
You should now be able to see the background map through the Site of Special Scientific Interest polygons.
Feel free to try different settings of opacity to see how it works.
[bookmark: Xee41b97a47424a8265ca5ea10358e895d3432c9]Setting transparency/opacity for categorized layers
The features in the Priority Habitats Inventory layer are also hiding the background map. Because this layer is “Categorized” - showing more than one symbol - you need to make it transparent in a slightly different way. This will also work for layers with a single symbol, such as the SSSI layer, but can sometimes cause problems when exporting maps to pdf.
· Select the Priority Habitats Inventory layer in the Layers Panel.
· If the Layer Styling panel isn’t already open to the right of the map window, press F7 on your keyboard or click on the Open the Layer Styling Panel button at the top left of the layers panel.
· On the Layer styling panel, go down to the Layer Rendering subheading at the bottom and click on the little black arrow to open the section.
· You should be able to see another Opacity slider. Again, change this to 60% and have a look at the effect it is having on the Priority Habitats Inventory layer.
[image: images/introduction/LayerRendering_small.png]
The Layer Rendering section of the Layer Styling panel showing the Opacity slider set to 60%
We’ll have another look at the options in this part of the Layer Styling panel later.
· To close the Layer Styling panel and allow your map more space, either press F7 on your keyboard again, or use the cross in the top right of the panel.
[bookmark: locating-features-in-vector-layers][bookmark: _Toc160015437]Locating features in vector layers
The layers in your map at the moment are vector feature classes and are searchable (you’ll find out more about raster and vector data types later).
[image: images/svg/videocam-black-24dp.png] Locating features in vector layers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To search features in a vector layer:
· Check all your vector layers are visible on the map - so make sure they are all ticked in the Layers Panel.
· Click on the Site of Special Scientific Interest layer to select it.
· Click in the Type to locate box at the lower left of the QGIS window or use Ctrl+K on the keyboard.
· Have a look at the list of options that pops up - it looks a bit confusing to start with but is simple to use.
[image: images/introduction/TypeToLocateOptions_small.png]
Click in the Type to Locate box to get a list of options.
· Type the following in the box: f Eccup. The f shows that you want to search for Active Layer Features - that is, individual features, or items, in the layer you have selected in the Layers panel.
· As you type a list of results will appear - double-click on Eccup Reservoir.
[image: images/introduction/TypeToLocateEccup_small.png]
Clicking on one of the Type to Locate results should take you to the feature that you chose. In this case a feature from the SSSI layer.
You should find that QGIS takes you to the polygon covering the SSSI for Eccup Reservoir and it briefly flashes red.
This can be a very useful way of finding things on your map if you are using vector layers, though it does depend on the information you want to search for being in the feature class (layer).
[image: images/svg/create-black-24dp.png] Set a bookmark for Eccup Reservoir
With Eccup Reservoir at the centre of the map set the scale to 1:10 000
Create a new spatial bookmark for this view under Project Bookmarks and call it Eccup Reservoir SSSI. You’ll need to go back to this view later.
[bookmark: identifying-features-in-layers][bookmark: _Toc160015438]Identifying features in layers
It can be really useful to be able to click on a layer and find out the values underneath the cursor and I’ll be instructing you to do so at various points in this workbook. To find the values, you can use the Identify Features tool.
[image: images/svg/videocam-black-24dp.png] Using the Identify Features tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Check that the Attributes toolbar is visible by going to View > Toolbars and checking that there is a tick next to it.
[image: images/introduction/AttributesToolbar_small.png]
The Attributes Toolbar. The Identify Features button is highlighted.
· Click on the Identify Features button (highlighted in the image above, and remember you can use tooltips if you hover over a button)
· Then click on one of the features on your map - anything from the SSSI, Priority Habitats Inventory or Green spaces layers.
· You may get a choice of layers from which to identify a feature, if so, choose any of them.
· The Identify Results window should pop up showing a tree view of the value of the feature(s) at the point you clicked on
· If nothing appears then the Mode may be set to something which only shows a single layer. In this case check the Mode at the bottom of the window. If it is not set to Current layer you can change it to Layer selection, to identify features from a little pop-up window, or Top Down to identify features on all layers at that point. If you change the setting, you will then need to click on the map again to get the result you want.
[image: images/introduction/IdentifyResults_small.png]
The Identify Results window showing the values for the feature that you clicked on from all layers at that point. This can include raster layers as well as vector.
Click on all the little black arrows to drop down the sections, and have a look at the information that is available. You should be able to see the attributes of the feature, such as its name, but also statistics about it such as the Area.
You should also be able to see that the feature(s) at the point you clicked on are highlighted on your map.
Once you’ve finished with the Identify Tool, it’s worth clicking on the Pan tool on the navigation toolbar (the hand icon) to clear the selection, otherwise the Identify window will keep popping up each time you click on the map.
[bookmark: saving-your-map][bookmark: _Toc160015439]Saving your map
Save your map projects at regular intervals. You will be doing a lot of work on them and can lose a lot of time and effort if you must do your work again because the program has crashed.
· Project > Save or alternatively Ctrl+S (Windows) or the Save Project button on the toolbar.
· If this is the first time you have saved a project, make sure you remember where you save it to and give the file a name which will help you to remember what it is.
It’s a good idea to save all your files to the same gis folder and make subfolders for each individual project. Your map project (the .qgz file) should be in the same folder as the data for that project. The aim is to be able to find your maps and data again if you come back to them weeks or months in the future!
[bookmark: backup-copies]Backup copies
It is also a good idea to keep backup copies of your project and of the data files. Particularly once you start editing, very occasionally problems can corrupt the whole file. Make a copy of your gis folder in a separate location each time you finish a session working on a project.
One way to do this is to zip the whole of the gis folder, rename it with the date, e.g. GIS_2024-01-03, then upload the zip file to your OneDrive.
[bookmark: geospatial-analysis-tools][bookmark: _Toc160015440]Geospatial analysis tools
Now that you have your data in a GIS, why not take advantage of more of its power? GIS can do much more than just display maps. It can also create new data and insights by analysing existing data.
We’ll look at a couple of simple examples in this section, but will cover analysis in more detail later in the module.
For this exercise we’ll investigate priority habitats which are at least partially within 2 km of the Eccup Reservoir SSSI.
To run the tools we’ll need a layer which shows just the outline of the Eccup Reservoir SSSI. I’ve created a layer for you that does this.
· Go to the NorthLeeds GeoPackage and add the EccupReservoirSSSI layer to your map.
The layer should be styled as transparent blue with diagonal lines.
· Have a look at the attribute table - Right-click on the layer in the Layers panel and Open Attribute Table.
You should find that this table only has one row, showing that it only contains the outline of the Eccup Reservoir SSSI.
[bookmark: creating-a-buffer]Creating a buffer
By running the buffer tool, you can create a new layer which shows the area within a certain distance of the selected features. We want to know which priority habitats are within 2 km of Eccup Reservoir SSSI, so the buffer tool is the ideal tool to use.
[image: images/svg/videocam-black-24dp.png] Using the buffer tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· On the menu bar go to Vector > Geoprocessing Tools > Buffer. You will be presented with a form with lots of spaces to add parameters, or the information the tool needs to be able to run successfully.
· Fill in the form as shown in the image below
· Under Input layer select the EccupReservoirSSSI layer.
· Set Distance to 2 and set the dropdown on the same line to kilometers. (You could also set this as 2,000 meters.)
· Leave the next four fields as the defaults
· We don’t need to tick the box next to Dissolve result - it won’t make any difference when we’re running it for a single feature.
· The Buffered field is for the output location and name. Click on the three dots button at the end of the line and select Save to Geopackage....
· Select the NorthLeeds.gpkg GeoPackage, then give the layer a name, such as Buffer2km so that you know what it shows and click on OK. It’s important you don’t put any spaces in the layer name.
· Click Run
[image: images/introduction/BufferForm_small.png]
Filling in the Buffer tool.
The tool should run and add a large polygon over the top of Eccup Reservoir.
· Drag and drop the new layer so that it is below the other habitats and reserves layers, but above the background layer.
· Make the layer transparent so that the background layer shows through.
· Right-click on the new buffer layer and Zoom to layer(s).
[image: images/introduction/Buffer_small.png]
The map showing part of the 1 km buffer around the proposed route of HS2.
[bookmark: intersecting-two-different-layers]Intersecting two different layers
It is possible now to see which priority habitats are within 2 km of Eccup Reservoir but it would be useful to save these as a new layer which can be analysed separately.
You can use GIS to select features which are within a certain distance of features in another layer and save them as a new dataset. For example, which priority habitats are within 2km of Eccup Reservoir SSSI? This might be a question you need to answer to find out whether certain species can spread from Eccup Reservoir to other suitable habitats.
We’ll use Select by location to select and export the priority habitats within the buffered area.
· Make sure that both the buffer and the Priority Habitats Inventory layer are visible in your map.
· Make the Site of special scientific interest and green spaces layers invisible by unticking them in the Layers panel.
[image: images/svg/videocam-black-24dp.png] Select by Location in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Find the Selection toolbar - if it isn’t already open go to View > Toolbars > Selection Toolbar
· Click on the button on the right - the tool tip will probably show you that this is Select by Location and that’s the one we want. If it isn’t showing as the button, dropdown the little black arrow on the left and select Select by location.
[image: images/introduction/SelectionToolbar_small.png]
The Selection Toolbar. The Select by Location button is on the right.
· Fill in the Select by Location form as follows:
· In Select features from select the Priority Habitats Inventory layer
· Under Where the features... ensure that only intersect is ticked, but note what the other choices are.
· In By comparing the features from select your Buffer2km layer
· You’ll be creating a new selection rather than a new layer so from the Modify current selection by dropdown choose creating new selection to make sure that you’re not keeping anything from a previous selection.
· Click Run
[image: images/introduction/SelectByLocation_small.png]
Selecting the local nature reserves which intersect the buffer around the HS2 route.
Once the tool has run (it could be very quick), Close the form and have a look at your map. If you look at the area of the buffer, you should spot that the priority habitats which are within or touch the buffer area are now bright yellow - the selection colour.
[image: images/introduction/SelectedPriorityHabitats_small.png]
Selected priority habitats, shown in bright yellow, within or touching the area of the 2 km buffer.
[bookmark: saving-a-selection-as-a-layer]Saving a selection as a layer
At the moment the selection is only temporary, to make this into a permanent layer do the following:
· Right-click on the Priority Habitats Inventory layer in the Layers panel
· Select Export > Save selected features as...
· Fill in the form as follows:
· Format should be Geopackage
· In the File name field choose your NorthLeeds.gpkg GeoPackage
· Under Layer name give the layer a name such as PriorityHabitat_intersect which tells you what it contains and what processes you’ve carried out on it.
· Check that Save only selected features is ticked
· Click on OK
[image: images/introduction/SelectionSave_small.png]
Saving the resulting selection as a new layer.
QGIS should run the tool and add a new layer to your Layers panel. You may need to add the layer yourself from the GeoPackage.
Check on your map that the layer only contains priority habitats that are within or overlap the buffer. You can do this by using Zoom to Layer(s).
To check that there is a difference between the original layer and the new one try the following:
· Right-click on each layer in the Layers panel in turn and select Show Feature Count
You should then be able to see how many features there are in the original Priority Habitats Inventory layer and in the new one.
[image: images/introduction/FeatureCount_small.png]
Showing how many features there are in the original layer and in the new layer.
In my case there were 2221 features in the original layer, and only 173 in the new layer. So the new layer is definitely a subset of the original one. Don’t worry if your new layer has a slightly different number of features!
Once you’ve checked, go back to the context menu for each layer (right-click) and untick Show feature count. If you leave it, it will appear on the key and it’s not necessary information.
[bookmark: X765a3f99d5a694655c510b4167666fef9bed4f0]Copying and pasting styles from one layer to another
When QGIS added your new, smaller, layer to your map, the polygons will all have been styled as a single symbol. The original layer has different colours for different habitats and these will be essential to interpreting your map.
To copy and paste these styles:
· Right-click on the original (styled) layer in the Layers panel.
· Go to Styles > Copy style > All style categories.
· Then right-click on the new layer, the one which currently only has one colour.
· Go to Styles > Paste style > All style categories.
The new layer should then be styled in the same way as the original layer.
Now remove the original Priority Habitats Inventory layer to tidy up the map and you should be left with just those reserves which you had selected as intersecting with the buffer.
Now it’s possible to have a look at the layer in the Layers panel and the attribute table and see what type of priority habitats are within the defined distance of Eccup Reservoir.
[image: images/svg/help_outline-black-24dp.png] Which Priority habitats have been selected?
Have a look at the attributes table and styling of your new priority habitats layer. Which type of priority habitat appears to be the most frequent in the vicinity of Eccup Reservoir?
[bookmark: X5f6b1caec85d9f619cc334868c7c4183cde80ad][bookmark: _Toc160015441]Layout - laying out a map for print or export
So far we have been working in the QGIS map view. If you print or export the map from here you have little control over it’s appearance. To produce a professional-looking map you need to use a layout. The information given here is just a quick introduction, you’ll cover layout and presentation in more detail in a later chapter.
I’ve set up a basic layout for you. To open it:
· In the menu bar click on Project > Layouts > Eccup Reservoir SSSI.
The layout should open in a new window and look something like the image below. You may need to use the middle mouse button to zoom in on the “page”.
[image: images/introduction/Layout.png]
The Layout window showing the Eccup Reservoir SSSI layout.
The main area shows the “page” with the current layout. On the right you’ll see the Item Properties which depend on which item from the layout is selected.
The current layout includes three items, the main map, the scale bar and the key.
· Click on the map frame, i.e. the actual map, to see the Properties, such as the scale.
· The map frame can reflect the layers and view on your main map so go back to that and go to the Eccup Reservoir SSSI spatial bookmark that you set up earlier
· Return to the layout and with the map frame selected click on the left-hand button at the top of the Item Properties to Update Map Preview
· Try out some of the tools from the toolbar on the left (yours may be at the top of the map). Remember you’ll see a tool tip if you hover over the button. A lot of these tools add a new map element.
Don’t worry if you make a mess of the map! This chapter is just about learning the basics so explore and see what happens.
[bookmark: adding-text-to-a-layout]Adding text to a layout
The most obvious thing missing from this layout is probably a title. Let’s add one now.
[image: images/svg/videocam-black-24dp.png] Adding text to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Either find the button for Add Label on the toolbar, or in the menu bar go to Add Item > Add Label
· Click and drag somewhere on the top of the page to create a text box.
· In the properties on the right click in the box which currently says Lorem ipsum
· Type the following text as a title
Eccup Reservoir SSSI and nearby Priority Habitats
· Use the buttons below the box on the Item Properties to change the font and make it larger.
· Change the Horizontal alignment to Center.
Try out some of the other options to make the title clear on your layout.
[bookmark: copyright-acknowledgement]Copyright acknowledgement
Copyright acknowledgement is important! Always check the terms and conditions for any data that you use. Most will tell you the wording that you should use - though it can take a bit of finding sometimes!
The Priory Habitats Inventory and nature reserves data is under the Open Government Licence[footnoteRef:4]. So add the text below to your map. [4:  More information about the Open Government Licence is available on the National Archives web site.] 

Contains public sector information licensed under the Open Government Licence v. 3.0.
The background map is from the Digimap service (you’ll find out more about this later in the course). For this you need to add the following acknowledgement:
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
[image: images/svg/create-black-24dp.png] Adding copyright information
Add both of those bits of text in a small font size near the bottom of the layout. You start with the same button you used to add the title above.
• To add the © symbol (on Windows), you can copy the symbol from this document and paste it into the box in the text properties panel.
• Alternatively, put the number lock on the keypad, hold down the Alt key, type 0 1 6 9 then let go of the Alt key.
• If you are on a Windows laptop and don’t have a number pad, put the text [%char(169)%] in the text box.
• If you are on Mac, either copy and paste, or use the shortcut Option + G.
The copyright acknowledgements have to be present, but for design purposes make the font very small. This can be the smallest font on the layout. I’ve used 8 pt size in my example.
[bookmark: adding-your-name-id-and-the-date]Adding your name / ID and the date
You should always add your name to your maps as the Creator. In the case of assessments, you can add your Student ID instead.
In addition it is a good idea to add the date. Features “on the ground” will inevitably change and it will be useful for you and your audience to know when your map and the data on it was created.
[image: images/svg/create-black-24dp.png] Adding a name and date
Using the instructions for adding text add your name (and Student ID if you wish) and the date to your layout.
[bookmark: sorting-out-the-keylegend]Sorting out the key/legend
I’ve added a key to this map, but at the moment it probably runs off the bottom of the page. To sort that out, we can remove some elements that don’t need to be there.
· Click on the key or legend on the map layout to open the Legend properties on the right.
· In the section that says Legend Items untick Auto update.
· Check that Only show items inside linked map is ticked.
· In the white box, select the vmd-raster_5337163 layer and click on the red minus button below. The layer should disappear from the key on the map.
[image: images/introduction/LegendItems_small.png]
Untick the Auto update box and tick Only show items inside linked map, to shorten the legend and keep it relevant.
To change the text of any of the items, return to your main map and change the text in the Layers panel by renaming the layer.
It’s good practice to do this and for this map I’d suggest you rename the buffer and intersected priority habitats to explain to your audience what those layers show.
[bookmark: printing-or-exporting-a-map-layout]Printing or exporting a map layout
Once you are happy with your map you can export it to pdf or an image
· Go to Layout on the menu bar and select either Export as image... or Export as pdf...
· Choose where to save your export and what to call it
· Click on Save - for now just accept the defaults and click Save again.
Have a look at your exported layout and check that you are happy with it.
To print your layout
· Layout > Print... from the menu bar
· Set up the printer as you would normally and click on Print
[bookmark: suggested-layout][bookmark: _Toc160015442]Suggested layout
Your final map could look something like the image below. It is unlikely to look identical as you should make your own decisions about where to place elements and how to display your map.
[image: images/introduction/FinalMap_small.png]
Possible layout for the Eccup Reservoir habitats map. Your map probably won’t look identical to this as you should make your own decisions about how to lay it out.
Note that I’ve finished off my map by doing the following:
· Changing the colour of the buffer to grey and making it transparent. The background layer shows through, but the Priority Habitats also show up against the grey colour.
· Making sure the Priority Habitats and SSSI layers are also transparent to allow the background map to show through. This helps with being able to identify where things are.
· Checking that all the layer names which appear in the key on the layout have been updated to read as clear language, e.g. spaces between words, no strange symbols (such as underscores), and using phrases that will mean something to my audience.
[image: images/svg/create-black-24dp.png] The final map
Export your final layout and bring it to the next class. I will endeavour to give feedback on maps during the class.
If you have any questions about what you have done, you can ask them in the class or via email.
[bookmark: finding-help-for-qgis][bookmark: _Toc160015443]Finding help for QGIS
There is a lot of help available for QGIS online.
The obvious place to start is the Documentation section of the QGIS website. Select the documentation appropriate to the version of QGIS that you are using (if possible!), e.g. 3.30. The page includes links to:
· User guide / Manual
· QGIS Training manual
· A gentle introduction in GIS
These go into different levels of detail, but all are very useful to have bookmarked.
If you go on to YouTube, there are a lot of videos showing techniques in QGIS. Search for QGIS then whatever you are trying to do. Keep an eye on which version of QGIS the clips show, as techniques can change with the version. Particular recommendations include videos by the following:
· Map Academy
· Klas Karlsson
· Hans van der Kwast
· Digital Geography
[bookmark: Xfc20763011a5c331f67e072460008a85bd19405][bookmark: _Toc160015444]Further information and recommended reading: Introduction to GIS
Many of the books on the reading list[footnoteRef:5] have a general introduction to GIS which explain what it is and how it is used. Specific suggestions include the following: [5:  The reading list is available in Minerva and also from the University Library by searching for SOEE2650 on the reading list page.] 

· Chapter 1: What is GIS? in Heywood, I., Cornelius, S. and Carver, S. (2011), pp. 2-30.
· Chapter 1: Systems, Science, and Study In Longley, P.A. et al. (2015), pp. 3-37.
[bookmark: Xad05efd9de5dea3d6317e48319045bca1933bfc]What is GIS? and some example applications
· ESRI UK (who publish proprietary GIS software ArcGIS) have a web page which includes an Overview of GIS and a GIS Showcase which includes examples of how GIS can be used.
· The webpage GIS for Science gives a lot more ideas of how GIS can be used by scientists and is well worth a look.
[bookmark: finding-spatial-data-to-use-in-gis][bookmark: _Toc160015445]Finding spatial data to use in GIS
Last Modified: 07 Feb 24, 14:06:29
The background to finding data will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-1][bookmark: _Toc160015446]Learning outcomes
When you have completed this section of the workbook you should be able to
· find suitable data for GIS projects from a variety of sources.
· acknowledge and cite the data that you use in your maps in a suitable fashion.
[bookmark: introduction][bookmark: _Toc160015447]Introduction
Being able to find, download and prepare your own data is an essential part of using GIS. While the data will be provided for you for many of the exercises in this module, you will find it useful to have some idea of where the data comes from, and what there is available for you to use for your own maps.
While downloading shouldn’t take too long, don’t leave it until the last minute before you have to produce a map. Websites can become unavailable either permanently or temporarily, or computers can crash.
[bookmark: digimap][bookmark: _Toc160015448]Digimap
Digimap is a service provided to Higher Education in the U.K. by EDINA at Edinburgh University. Digimap provides a front end to digital maps and data of Great Britain from the Ordnance Survey and British Geological Survey, amongst others. The University of Leeds subscribes to the collections and as a student you have access to maps and data for use as part of your studies.
[bookmark: logging-in-to-digimap]Logging in to Digimap
If you have not used Digimap before you will need to register and log in using your University ID, that is the username and password that you use to access University systems such as Minerva.
Full instructions for logging in are on the Digimap help pages.
· Go to the Digimap Collections page at https://digimap.edina.ac.uk
[image: ../../shared/docs/images/finding_data/login2023_small.png]
The Digimap initial page - note the “Log in” button at top right.
· Click the Log in button at the top right of the screen.
· type Leeds in the box and select University of Leeds from the list of available institutions.
· You should get the familiar University of Leeds log in page, so type your University username and password into the appropriate boxes and then click the Log in button. If you are already logged in to Minerva, you may find that you don’t have to enter your login details again.
If this is the first time that you’ve logged in to Digimap you’ll be asked to register for each collection separately, though you can do all at one go. You won’t need to use all the collections during this module, but it’s worth registering for all that are available to you so that you can explore them for yourself.
· Go through the list of collections, read and accept the conditions for each one, selecting Academic Works (coursework, projects, dissertations etc.) in the Purpose dropdown for each.
Once you submit all those, you should be taken to the Digimap initial page again, as shown below, but this time you should see your name at top right rather than the log in button.
[image: ../../shared/docs/images/finding_data/ChoosingDataCollection2023_small.png]
The Digimap main page again, this time with your name at the top right. You can now select a collection from the menu across the top.
The list includes options for several collections. In this workbook we’ll only be looking at the collections that are the most relevant for creating the maps you’ll need during your course, but if you are interested in any of the others feel free to explore them. EDINA have worked to make all the tools similar across each collection, so just have a go!
[bookmark: browsing-maps-on-screen]Browsing maps on screen
Digimap has recently changed the interface (Summer 2023) so the previous separate links for browsing (Roam) and downloading are now combined. If you used the previous version of Digimap, the new interface offers all the same functions but in a slightly different way.
· As an example of the Digimap interface, which is similar in all collections, click on Ordnance Survey on the menu at the top of the main screen.
· Then select OS Digimap under View maps and download data on the right.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
[image: ../../shared/docs/images/finding_data/OSDigimap01_small.png]
The OS Digimap interface for Ordnance Survey data.
Now try browsing the maps.
· Have a go at zooming in and out and exploring the map at different scales.
· Try searching for a location in the Search places, coords, postcodes... box at the top left, for example type in Leeds and press <Enter>. From the list that appears click on Leeds (Leeds) then use the cross at the top of the list to close it.
In this module we’ll be making most use of the Download functions, but it’s worth knowing how to browse the maps too, so have a quick go with a few of the tools on the left before continuing with the next exercise.
If you want more information about using the browsing interface have a look at the Digimap Help Centre which is linked from Help on the main page.
[bookmark: downloading-data-from-digimap]Downloading data from Digimap
As well as browsing data on screen you can download data from Digimap for use in GIS or CAD software. The format that the data is delivered in will determine whether you will be able to open it directly in a software package or whether you will need to convert it.
We’ll be using data from Digimap in QGIS for various exercises in the rest of this module, so you need to know your way around this section. Instructions for converting, importing and viewing file types that need it will be given later in the workbook.
As an example of the download interface, we’ll download some Ordnance Survey data but all the collections work in a similar way.
· If you’re not already in the OS Digimap interface, start from the Digimap main page (you can get back to it by clicking on the icon at the top left of any of the maps - hover over to see a tool tip).
· click on Ordnance Survey in the menu at the top of the page.
· from the right-hand side of the Ordnance Survey page choose OS Digimap.
[image: ../../shared/docs/images/finding_data/OSDigimap02_2023_small.png]
Click on OS Digimap to enter the application.
You’ll be in the same map as the one in which you were able to browse maps.
· To get to the download options, click on the Download Data option at the bottom of the left-hand menu.
The options will change to those for downloading data.
[image: ../../shared/docs/images/finding_data/OSDigimap03_small.png]
The download interface to download Ordnance Survey data.
[bookmark: selecting-an-area]Selecting an area
On the left there is a menu panel with options for selecting an area, with a search box above it.
[image: ../../shared/docs/images/finding_data/DownloadSearch2023_small.png]
Digimap Download - search for and select an area.
· Click in the Search places, coords, postcodes... box and type Otley, then press <Enter> or click on the magnifying glass to search.
· When you get the results click on Otley (Leeds) to zoom to the correct area, then close the search results.
· Under Draw click on the rectangle and use the mouse to draw a box around the area shown by an orange box in the image below, clicking once to start and again to finish the box. It doesn’t matter if the box you draw is a bit bigger but try not to make it any smaller.
[image: ../../shared/docs/images/finding_data/DownloadArea.png]
The minimum area to select using the rectangle tool.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Area view
Note that the map you see on the screen only shows the area that you will be downloading data for, not the actual data that you’ll be downloading. You’ll select the data in the next section so don’t worry what it looks like for now.
[bookmark: selecting-data-sets]Selecting data sets
Now that you have selected an area you have to select the data that you need.
· Back in the panel on the left, under Select Data Products, drop down each of the headings, e.g. Backdrop Mapping, in turn by clicking on the arrow next to them.
[image: ../../shared/docs/images/finding_data/DownloadChoices.png]
The list of data products - click the arrow next to each subheading to see the full list.
· There are a lot of different data sets here and most of them won’t mean anything to you. For now select the following data sets when you find them, by putting a tick in the box next to them.
· Backdrop mapping > VectorMap Local Raster
· Land and Height data > OS Terrain 5 Contours
You can get more information about the data sets by clicking on the arrow next to them. This includes information on licences - which you will need to know later.
The number on the right in brackets under Order Size shows how many tiles your selected area uses out of the maximum downloadable number. If you have chosen a slightly different area to me your number may be different, but you should still be well within the limit.
[image: ../../shared/docs/images/finding_data/DownloadDatasetsInfo.png]
Selecting datasets. The image shows the information for the VectorMap Local Raster dataset and that I am going to download one tile out of the maximum limit of 400.
· When you have selected the data you require click on Add to Basket (Don’t worry, despite the Basket and Checkout you won’t be charged. The University has already paid the subscription.)
Your basket should appear with details of your order.
[image: ../../shared/docs/images/finding_data/DownloadBasket2023_small.png]
Details of your order in the Basket. Yellow highlights show choices that you need to make before you can request download.
· Some datasets will give you an option to change the format. In this case click on Select Format next to the OS Terrain 5 Contours. The choices are Shape, GML3 or DWG. Choose Shape in this case.
· You may also need to select a theme. For the VectorMap Local Raster there is a choice of themes - pick Black and white for this exercise, though it is worth downloading the others to have a look at them too.
· Some items will have a Clip option. This means that the data will be sent to you clipped to the area outline that you requested. If you are short of disk space this is very useful as it restricts the amount of data you need to download, but otherwise it doesn’t hurt to have extra data around the outside of your study area. I prefer to untick this box and download full map tiles.
· Give the order a name, e.g. OtleyOS (for Ordnance Survey). This will be part of the file name of the zip file that you download, so try to make it short but helpful!
· Click on Request Download
[bookmark: downloading-your-data.]Downloading your data.
You’ll receive an email confirming your order, then another with a download link. This can sometimes take a while to arrive, depending on how busy the service is.
Make sure that you are still logged in to Digimap before you click on the download link.
[image: ../../shared/docs/images/finding_data/DownloadLink.png]
The download link in the email - click on this to download your data, not on any of the other links in your email!
Once you have clicked on the link a browser window should open telling you that your order is ready to download.
[image: ../../shared/docs/images/finding_data/DownloadDownload2023_small.png]
Order ready to download, showing the name and size. Click on the Download button.
· Click on Download
You’ll download a zip file. Make sure you save it to your computer.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
• Make sure that you remember where you have saved the zip file.
• Don’t run or open the file directly from your browser, and make sure that you DON’T save your zip file to a temp folder where you will probably be unable to unzip it.
Now open File Explorer (in Windows) and navigate to the location where you saved the zip file.
· Right-click on the compressed map data file that downloaded and choose to Extract files... - or 7-zip > Extract files... if you have 7-zip available.
· Select where you want to save the extracted files, and make a note of where you save them to
You should end up with a folder for each dataset that you requested plus text files showing citations and contents. The folders will also have the order number as part of their name.
[image: ../../shared/docs/images/finding_data/DownloadUnzipped.png]
The unzipped Ordnance Survey data showing the folder for each dataset and text files containing citations and contents lists.
[bookmark: viewing-your-data]Viewing your data
In this case the files that you have downloaded are either tiff graphics files or shapefiles.
· Navigate to the data that you downloaded in the file explorer and find the folder called something like vml-raster_bwr_3612556 (your order number will be different).
· You may also need to go into a folder with the OS grid letters - in this case for Otley it will be se
· Open one of the .tif files by double-clicking on it - the file should open in a graphics program, but that depends what you have set up on your computer. Don’t worry if it doesn’t!
You should be able to see that this is basically a “picture” of a map.
· Try opening one of the .shp files from the terrain-5_3612555 folder too. It’s unlikely that you’ll be able to. Just cancel that and don’t try finding software that will open it!
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Both folders will contain files that have similar names to the .shp and .tif files, but different file extensions. These are known as “side-car files”.
They won’t open in any programme but are essential for using the data in GIS programs such as QGIS, so make sure that you always keep these files together.
Both of these formats will open in QGIS in the same way that you added data to your map in the Introduction to GIS.
This time you don’t need to keep the files that you have just downloaded, just remember how you downloaded data from Digimap. You’ll get used to doing that for future exercises.
[bookmark: X4459649f558beb254c5bb6ee909ed6bf6074f9a]Copyright acknowledgements for Digimap data
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and add it.
When you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. The wording does change from time to time so it’s worth knowing how to check it for yourself.
To find these copyright acknowledgements:
· go back to the main Digimap home page
· go to the Digimap Help Centre (Help at the top of the main Digimap page)
· Click on the link to Copyright and Licensing from the Help page.
· In the list on the left click on the Educational User Licence for the data that you’ve used - in this case the Ordnance Survey Educational User Licence.
· then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, as of September 2023, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your maps.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
This changes from time-to-time, so it’s worth checking when you’re using it for maps for coursework etc.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
To add the copyright symbol - © - to your text (on a Windows computer)
• check that the Num lock is on on the keyboard
• hold down the Alt key on the keyboard
• then use the number pad to type 0169
• release the Alt key
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when you registered.
If you are not using U.K. Ordnance Survey data, this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself.
[bookmark: citing-maps-and-data-from-digimap]Citing maps and data from Digimap
Advice on citing Digimap data, as opposed to the copyright acknowledgement is given in the Copyright and Licensing section of Digimap Help.
The Digimap page says the following about when you should cite your data using the citations from the text file included in any download:
The citations in this document should be used to reference the maps and data when they have been included in any essays, dissertations or other academic works. You should cite the data even if it doesn’t appear as an image or map in your work if it has been used to generate findings or a new dataset that is used. (Citing Digimap Collections. Last accessed: 19th September 2023.)
The GIS Lounge page on How to cite GIS materials gives some information about citing the software as well as the data. Have a look at that and follow the suggestions to cite non-Digimap data.
[bookmark: other-digimap-collections]Other Digimap collections
In addition to Ordnance Survey Digimap you will also find that you’ll make use of some of the other collections, in particular Geology Digimap and Aerial Digimap. The Roam and Download interfaces work in a very similar way to the Ordnance Survey collection so you should find that you already know how to use them.
You have access to all these collections so feel free to have a look at what is available and to make use of any of the data or maps in your work in the future.
Try exploring the suggested collections to answer the following questions:
[image: images/svg/help_outline-black-24dp.png] What was on the site of the University of Leeds back in the 1890s?
• Go into the Historic Digimap Collection to look up the University of Leeds (search for the postcode LS2 9JT) using old maps.
• Try the 2 up view to see how you can compare old and new mapping of the same area.

[image: images/svg/help_outline-black-24dp.png] What is the bedrock geology under the Student Union Building at the University of Leeds?
• Go into the Geology Digimap collection to find the Student Union (search for coordinates 429306,434578 to get a marker on the map.)
• Click on the feature information button at the top of the map, then on the marked building on the map.
A Feature information window should pop up. What Rock Unit does it give?
[bookmark: digimap-collections-online-help]Digimap Collections online help
Digimap help is available from each of the collection pages. Click on the Question mark button at the top of the map to go directly to the Help pages.
You may find the Learning Materials particularly useful if you want to know more about how to download and use different formats of data. This section includes some case studies and webinars.
[bookmark: data-from-the-web][bookmark: _Toc160015449]Data from the web
EDINA Digimap provides a wide range of useful data covering the UK, but you are also likely to need data from outwith the UK, or UK data that isn’t provided by Digimap. It isn’t possible to cover everything in this session, but I will show you a couple of sources which you should find useful. You’ll discover others as you go through the rest of this course.
[bookmark: natural-earth-data]Natural Earth Data
Natural Earth is a free, public domain dataset consisting of raster and vector data that will allow you to make maps at general scales. If you want a map of the World, or a general map of a particular country, this is a good starting point.
· Start by going to Natural Earth in your browser.
[image: ../../shared/docs/images/finding_data/NaturalEarth01.png]
The Natural Earth front page. Free vector and raster map data at three general scales.
The front page gives an overview of the principles behind the data and an idea of the scales at which it is available. You can find more information under the Features tab, including the file formats and the coordinate system - both important for using the data within GIS.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Natural Earth data
Go to the Features page and make a note of the file types of both the raster and vector data provided by Natural Earth and of the coordinate system that the data comes in.
To download data either
· Click the Get the Data green button on the front page.
· or click on the Downloads tab at the top of the site.
· Choose the scale that you want to download and the type of data that you want, e.g. cultural, physical or raster.
For this exercise download the following data:
· Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file. Make a note of where this file is saved to on your disk.
· Medium scale data, 1:50m > Raster > Natural Earth 1 - click the Download small size button under Natural Earth 1 with Shaded Relief and Water. Again, make a note of where the zip file is saved.
Keep these data layers for later exercises. Make sure you put the zip files into your GIS folder.
Have a look at the summary of the data on the Features page. If you wish, try downloading other datasets. You can try adding them to a blank map in QGIS in the same way that you added data in the Introduction to GIS.
[bookmark: natural-earth-data-copyright]Natural Earth data copyright
Finding and acknowledging the copyright of data is very important.
· Return to the Natural Earth front page
· Look at the text in the box next to the Get the Data button. One of the links there is to the Terms of Use page. Click on that now.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Acknowledging Natural Earth data
Read the Terms of Use of Natural Earth data
How should you acknowledge the Natural Earth data if you use it in one of your maps?
The terms of use do say that “Crediting the authors is unnecessary”, however, it is still a good idea to add the data acknowledgement to your map to avoid any possibility of plagiarism. You can choose whether to use the short or long text listed on the page. Adding the url of the data can also be a very good idea.
[bookmark: xyz-tile-maps-in-qgis]XYZ Tile maps in QGIS
If all you need is background map and you don’t need to be able to make changes to it then QGIS XYZ Tile maps are probably the easiest solution. They make use of OpenStreetMap (OSM) data - be aware that this is crowd-sourced, and quality and coverage vary.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an XYZ Tile Layer to QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open QGIS - you can leave it on the welcome screen or open a new blank map by clicking on the New Project button on the toolbar or pressing Ctrl-N on your keyboard.
· In the Browser panel look for the XYZ tiles heading.
· Double-click on the OpenStreetMap layer to add it to the new map.
You should find that you have a World map and can now zoom in to wherever you want and pan around. Try that now to see the level of detail that you can get. Note that the level of mapping does depend on how actively particular areas have been mapped.
[bookmark: X1b2a378fe016dff741c592c04e2d6b154412fb3]Adding XYZ tile layers with an API key - Thunderforest API
By default the XYZ Tile choices include OpenStreetMap and maybe a couple of others (don’t worry if it doesn’t!). OpenStreetMap doesn’t need an API key and won’t have a watermark across it, others may do.
By signing up for an API key (API = Application Programming Interface, but don’t worry, we won’t be doing any programming!) you can extend the number of possible background layers you can use.
To add an API key:
· Sign up for one on Thunderforest website. You can do so for free as Hobby Project (free), but get a limited quota of views. This shouldn’t be a problem if you are just using it as a map background on your desktop.
· Once you have an API key you can see list of urls at bottom of page. Select and copy one of these, e.g. Outdoors. There is a gallery of the map styles you can check.
· In QGIS look for the XYZ Tiles subheading in the Browser panel.
· Right-click on XYZ Tiles and select New connection...
· Give the new layer a Name, e.g. Outdoors (API).
· Next to URL paste in the url that you copied, which should include your personal api key, then click OK.
[image: ../../shared/docs/images/finding_data/XYZConnection_small.png]
Setting up the XYZ tiles connection using the link from Thunderforest.
· Now you should be able to find the layer in the list of XYZ Tiles and drag and drop it into the Layers panel as you would any other layer to add it to your map.
· If you wish to edit the settings for any of the XYZ Tile layers right-click on them in the Browser and select Edit....
[image: ../../shared/docs/images/finding_data/XYZTiles_small.png]
Loading XYZ tiles - the Thunderforest Outdoors layer is displaying in the map window.
[image: images/svg/create-black-24dp.png] Add the Thunderforest Atlas layer to QGIS
Now that you have signed up for a Thunderforest api key, look for the URL for the Thunderforest Atlas layer. This is a nice clear layer that you should find useful as a background map.
[bookmark: adding-a-bing-aerial-layer]Adding a Bing Aerial layer
Tile layers are becoming more widespread, and you may be able to find other data to add to the list. If you do, there should be a URL which you can add in the same way as the Thunderforest urls above.
For example, it is possible to add a Bing aerial layer as XYZ tiles. I found this URL by searching for Bing satellite tile maps qgis then browsing some help pages.
· Try adding the following URL to the same map as the OpenStreetMap layer you added above.
       http://ecn.t3.tiles.virtualearth.net/tiles/a{q}.jpeg?g=1
If you need to change an entry later simply right-click on it in the Browser panel and click on Edit.
Once you’ve added a layer it should stay in the list in your Browser panel for you to use again in future.
[bookmark: finding-other-data-online]Finding other data online
These are just a few examples of finding useful data for GIS. Throughout the rest of the workbook, you’ll be downloading your own data from Digimap. If you need data from elsewhere, I’ll either give full instructions or provide the data for you, but tell you where I got it from so you can follow up if you’re interested.
If you are looking for data for a particular project, it is well worth searching online using your favourite search engine (e.g. Google). Put the words “gis” and “data” into your searches and it should help you to find relevant data.
I have put together a short list of possible data sources which you are welcome to use to find data and maps.
[bookmark: X5180b01f4e52f6e16e2a2fb544e2c3d865eee88][bookmark: _Toc160015450]Optional section: ArcGIS Living Atlas of the World
This section is optional. You can work through it to find out about some more layers you can add to your maps in QGIS.
If you don’t have time to do this section now, you can come back to it later if you wish to.
The ArcGIS Living Atlas of the World is an extensive collection of map layers and maps curated by a company called ESRI. ESRI produce commercial GIS software, ArcGIS, which is similar to QGIS but is not Open Source. Some of the data is only available if you subscribe to ArcGIS Online, but even without subscribing there are a lot of datasets available to use as background layers. This section will give you an idea of what is available and how you can use the layers in your maps in QGIS.
[bookmark: finding-arcgis-living-atlas-layers]Finding ArcGIS Living Atlas layers
The ArcGIS Living Atlas is online at https://livingatlas.arcgis.com/en/home/
The first page gives you an overview of the atlas. It’s worth having a look at this to see what new layers and maps have been added.
Once you’ve done that:
· Click on the Browse tab at the top of the page.
[image: ../../shared/docs/images/finding_data/LivingAtlasBrowse_small.png]
The Browse page for the Living Atlas. Note the search box at the top, and the filters below that. The main part of the page is the full list of maps and layers.
The Browse page allows you to use filters to limit the data, as well as to search.
I’ll start by showing you how to find and add layers to QGIS, then you can do some searches for yourself and see what you can find.
We’ll start by finding a background map of the Oceans and adding it to QGIS. This could be useful if you need to produce a map for a report showing a particular area of the ocean floor with some of your own data on top of it.
· Type World Ocean Base into the search box on the Browse page.
The list of results will appear below the filters. Have a look at the options you are given.
Make sure the option to view the List is selected from the three buttons above the list. You’re given more information in a clearer format if you select this.
[image: ../../shared/docs/images/finding_data/LivingAtlasResults_small.png]
Viewing the results of your search in List format.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] What types of layers are available?
Look at the information next to each of your results. You’ll get a summary of what the layer or map shows, but you’ll also be shown the Type and the Contributor.
What types of layers do you have available to you?
Not all the layer types are suitable for use in QGIS. You will be able to use layers which have the type:
· Feature Layer
· Tile Layer
· Map Image Layer
You should also see the word Authoritative next to some of the layers. This indicates that ESRI have checked the data and consider it to be reliable. Even so, remember that it’s always a good idea to check who is the creator of any data, and which organisation it comes from.
[bookmark: X87bbc62a8d2324a84e556d318711e2588fc395d]Seeing full information about ESRI Living Atlas Layers
There should be in your list of results, a Tile Layer called World Ocean Base, for which the contributor is ESRI.
· Click on the title for this Tile Layer.
You’ll be taken to a full page of information about the layer. It’s worth looking at this information as it will give you a better idea of whether this is a good layer to use.
· If you want to check what the layer looks like, click the Open in Map Viewer button at top right. Zoom in and out and pan around to check the map.
· Once you are happy that this is the layer you want to use, return to the page containing the information about the layer.
· Look for the URL field, which is usually at the bottom right of the page.
· Hover over the right-hand side of the URL box and click to copy the URL.
Now you are ready to add the layer to QGIS.
[bookmark: Xd67cd8c88e11ec189a1c2869a4a6f67a493368f]Adding an ArcGIS Living Atlas layer to QGIS
Start by opening QGIS. You can add ArcGIS Living Atlas layers to existing maps, but in this case we’ll start with a blank map.
As usual, there are multiple ways to add the layer to QGIS. You can use either of the following:
[bookmark: via-the-browser-panel]Via the Browser panel
In the Browser panel, scroll down to find ArcGIS REST Servers heading. Right-click on the heading and choose New Connection....
This will open a dialog box.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
[image: ../../shared/docs/images/finding_data/LivingAtlasNewConnection_small.png]
Creating a new ArcGIS REST Server Connection to add a layer from the ESRI Living Atlas.
The new connection should appear under the heading in the Browser panel.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Double-click on the layer you want to add to your map.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
[bookmark: via-the-data-source-manager]Via the Data Source Manager
· Alternatively, go to Layer > Data Source Manager.
This will open the Data Source Manager.
· Find the ArcGIS REST Server tab on the left and click on it.
· Click on New under the box at the top.
This opens the same form as the method above, so refer to the image under those instructions.
· Fill in the Name as World Ocean Base (or something which will remind you what the connection is in future).
· In the URL box paste the URL you copied from the Living Atlas web page.
· You don’t need to fill in any further information.
· Click on OK to add the server connection to QGIS.
· The name of your new connection should appear on the dropdown at the top.
· Now click on Connect to actually connect to the server.
· Drop down the small black arrow next to your new connection. This will show any layers available on the server. For the World Ocean Base there is only one available.
· Select the layer you want, then click the Add button at the bottom of the window.
You can also Close the Data Source Manager if you wish.
Be patient, some layers can take a while to load, particularly if you have a slow internet connection.
Zoom in and out and have a look at the data you have added.
[bookmark: X156b8e1b4bdd2ec2f9503d9828863f04f1c2a52]Trying out other ESRI Living Atlas layers
Once you have added a layer, you can combine it with other data from other sources to produce your own maps.
· Return to the Living Atlas browse page.
Look for another layer to add to your map. Is there a country you are particularly interested in, or a subject you’d like to see on a map?
· Use the Filters at the top of the page to select the country.
· Search for the subject you want to investigate.
Example searches could include:
· Earthquakes
· Land use or Land cover
· Hurricanes
· Traffic
· Imagery (for aerial photography)
You’ll need to look for layers which don’t say Subscriber or Premium, and which are one of the following types:
· Feature Layer
· Tile Layer
· Map Image Layer
In addition, some layers which look as if they will be OK, may not work. This can be because a server somewhere isn’t working and there isn’t much you can do about it, unfortunately.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Find a layer and add it to your map in QGIS
Find a layer showing something you are interested in and add it to the same map as the World Ocean Base.
Zoom in to an area you are interested in, and export the map using the instructions below.
[bookmark: exporting-your-map]Exporting your map
It is possible to set up a layout and export that, but I’m not expecting you to spend extra time on this exercise.
Instead, so you have something I can give you feedback on if you wish:
· Make sure your map looks as you want it to in the map window in QGIS.
· Go to Project > Import/Export > Export Map to Image.
· In the form which appears, click on Map Canvas Extent.
· Untick Append georeference information
· The other settings will be fine for now, so click on Save.
· Give your export a name and choose where to save it.
[image: ../../shared/docs/images/finding_data/SaveMapAsImage_small.png]
Saving a map as an image directly from map view.
QGIS will export a .png image which you can open in a photo editor, or include in another document.
[bookmark: X5dabf7b7f077be5d55eaafd116593421c5f9e34][bookmark: _Toc160015451]Using spatial data in GIS: Coordinate systems, projections and transformations
Last Modified: 17 Jan 24, 09:17:30
The background to using spatial data in GIS, coordinate systems and projections will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: X00d6ca6aaa32d79876a86d0aa1c2bdc2512cae1][bookmark: _Toc160015452]Learning outcomes for using spatial data in GIS
When you have completed this section of the workbook you should be able to
· describe the main types of data used in GIS
· find out essential information about the data and apply that to your use of the data in GIS
· set the correct coordinate reference system (CRS) for your project and for each layer in your map
[bookmark: data-to-download-and-prepare][bookmark: _Toc160015453]Data to download and prepare
Being able to find, download and prepare your own data is an essential part of using GIS. For the exercises in this chapter, you will need to download several datasets. While these should not take too long to download and prepare, don’t leave it until the last minute. Websites can become unavailable either permanently or temporarily, or computers can crash.
If there are problems with a website, then try again later. If the problems persist please get in touch with me (c.e.gordon@leeds.ac.uk) and I will try to contact the site or find an alternative source of data.
[bookmark: data-required]Data required
Download and prepare the following data. If you can do this before the start of the class you will be able to get started on the exercises as soon as they have been introduced.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Summary of data to download
Full instructions for obtaining these datasets are in the sections below.
• CoordSystems.zip from Minerva
• European River Catchments from the web
• SRTM height data for part of Skye, off the West coast of Scotland
[bookmark: coordsystems.zip]CoordSystems.zip
CoordSystems.zip can be downloaded from Minerva. Please unzip it to your GIS folder. Instructions for using this file will be given in the exercises in this chapter.
You should end up with a folder within your GIS folder which is called CoordSystems_Q. Make sure that you put the rest of the data for this project inside this folder.
[bookmark: european-data-from-the-web]European data from the web
Inevitably the web is an extremely rich source of spatial data. A lot of government and related bodies make data publicly available online. Sometimes you have to register first even when the data is available without charge, but the European source below allows you to download many datasets without registering.
· European Environment Agency Datahub.
It’s worth having a look at the wide variety of data that is available from this hub, but for this chapter we’ll use a dataset showing Regional Seas around Europe.
[bookmark: downloading-regional-seas-dataset]Downloading Regional Seas dataset
· Go to the European Environment Agency Datahub.
· The Datahub page allows you to browse data by categories, but also has a search box - where the page says Search Datahub... type Regional Seas and press enter to search.
· The resulting list shows brief information about the datasets. Click on the link for Regional Seas around Europe.
The next page gives you information about the data, including the publication date, and links to view and download the data.
· Under the Datasets heading, click on the link to Direct Download.
This takes you to a downloads page with a choice of formats. For these exercises we’ll use the SHP, or shapefile, option to give you experience with this common format. The information on the page shows that the download will be 160 MB.
· Click on the ellipsis (three dots…) to the right of the SHP heading and select Download.
· Wait for the file to download. It will probably be a zip file called SHP.zip. Move it to your folder for this chapter. You could also rename it as something like regional-seas-europe.zip so that you can remember what it contains later.
· Unzip the downloaded file to your CoordSystems_Q folder.
You’ll have another folder called SHP and that contains a list of files which all start Regional_seas_around_Europe_LAEA_ with some numbers, and then a variety of file extensions.
Make sure that you keep all these files together or the data won’t load into GIS.
The actual shapefile is the one with the .shp extension, but it needs the other files to be read in GIS.
[image: images/svg/info-black-24dp.png] Shapefile format
Shapefiles are a form of vector data storage. We’ll mainly use GeoPackages for data that we create, but if you download data it is often delivered in shapefile format as that will work in most GIS software.
There are limitations to the format, which is why we’re mainly using geopackages, but the main one to remember is that a single shapefile actually consists of multiple files on disk with extensions such as .shp, .dbf, .prj, .sbn etc. If you’re dealing with shapefiles make sure that you keep all those files together or you won’t be able to open the data in GIS.
[bookmark: srtm-data-via-earth-explorer]SRTM data via Earth Explorer
SRTM stands for Shuttle Radar Topography Mission and is data collected from the space shuttle Endeavour. You can find out more detailed information on the USGS webpages.
If you are working in the UK then you will have more detailed height data available to you via Digimap and Open Government sources, but SRTM data is possibly the best height data easily available for many countries, e.g. Turkey. One limitation is that it is not available above 60 degrees north and below 60 degrees south - so it doesn’t cover most of the Shetland Islands to the north, for example.
[bookmark: obtaining-srtm-data]Obtaining SRTM data
You could download the original data but we’ll be using the postprocessed data (this has data voids filled, and accuracy improved in some areas). This is available from the Earth Explorer website.
· Navigate to Earth Explorer.
· If this is your first visit click on Register to set a username and password. Please use your University email address to register. (IMPORTANT: don’t use your University password, but don’t forget to make a note of the username and password that you do set up! You’ll need to use them again in future.) Apologies, this is a horrible registration form, but once you’ve completed it, the data is very useful.
· If you have already registered click on Log in and enter your username and password.
· Once you have the viewer open use the map to navigate to the area that you require data for - in this case look for Skye off the north-west coast of Scotland. The image below shows the general area, but zoom in closer than this so that the island of Skye fills the whole of the map area.
[image: ../../shared/docs/images/crs/SRTMSkye_small.png]
Selecting data in Earth Explorer - the area to enter to search for data for Skye.
· On the Address / Place tab click on Use Map to select the area. You can change the area by moving the markers if necessary. The image above shows the map with Skye selected.
· Now click on the Data Sets button to move to the next tab.
· Go to Digital Elevation > SRTM - this should give you four choices. Click on the i buttons to see more information about the products. It’s worth having a look at what other data is available to you through this interface too. There is a lot there.
· For this exercise select SRTM 1 Arc-Second Global by putting a tick in the box next to it.
[image: ../../shared/docs/images/crs/SRTMDataSets_small.png]
Selecting data in Earth Explorer - Digital Elevation data choices. Select SRTM 1 Arc-Second Global - outlined in red.
· Click on the Results button - you may need to scroll down to see it.
Now Earth Explorer should give you a list of your selected data covering your chosen area, but you’ll need to explore a bit further to see exactly which tiles to download.
· The image below shows the results of a search for SRTM 3 for Skye. To see the coverage for a tile of data click on the “footprint” icon under it.
[image: ../../shared/docs/images/crs/SRTMResults_small.png]
The SRTM results screen - showing the footprint of the SRTM tile to download for the Isle of Skye.
· To download a file, click on the fifth icon next to the tile in the list (a green arrow) - it has a tool tip which says Download Options if you hover over it.
· From the choices that appear, click on the Download button next to the GeoTIFF option and then wait for the download to complete. You may need to accept/allow popups for this webpage for this to happen.
· If you want multiple tiles you’ll need to click on each one separately.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Download SRTM tile
Download one tile of SRTM data covering the western part of the Isle of Skye and save it to use in the exercises in this chapter.
If you need to do multiple searches then click on Clear Search Criteria above the map. This doesn’t always work, if it doesn’t you have to close the browser completely and start again from scratch.
[bookmark: X475b541034ffab9ea759263728443befb4b0290][bookmark: _Toc160015454]Using coordinate systems: Setting up your project
For this exercise you will be using the data that you downloaded above and exploring what you need to do when your layers have different projections to each other - a situation that is very likely to happen. This exercise should show the importance of understanding coordinate systems and how they work in GIS.
· You should already have a folder called CoordSystems_Q under your gis folder from when you unzipped the Minerva download. If you haven’t, create that now and move the unzipped miniscale data to that location.
· Check that you have copied all the data for these exercises into that folder and check that it is all unzipped.
[bookmark: adding-layers-to-a-blank-map]Adding layers to a blank map
We’ll start by looking at what happens if you add data to a map project without thinking about coordinate systems first. You’ll be adding these data layers in a different order to three different projects.
[bookmark: first-time]First time
Start by adding the layers in the following order:
· Open a blank map in QGIS and browse to your CoordSystems_Q folder in the Browser panel.
· From there find the miniscale folder and add miniscale_mono_r19.tif to the map by dragging and dropping it into the Layers panel.
· Next find the Regional Seas around Europe layer - Regional_seas_around_Europe_LAEA_20221003.shp in the browser and add that to the Layers panel. You may not see anything change on your map, don’t worry about that at this stage.
· If a Select Transformation... window opens, just click on OK for now.
· Finally find the srtm layer n57_w007_1arc_v3.tif and add that to the Layers panel. Again, you may not see any changes to your map.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• When you zoom to the Regional Seas layer you may see a large grey shape - zoom way out and investigate that further. What is it?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
[bookmark: second-time]Second time
Let’s try adding the layers to a blank map in a different order:
· Click on the New Project button at the top left of the QGIS window, or Ctrl-N on your keyboard. If asked, Discard the current project.
· Go to the Browser panel again and this time add the Regional Seas around Europe shapefile (.shp) first.
· Next add the srtm layer n57_w007_1arc_v3.tif.
· Finally this time add the miniscale layer miniscale_mono_r19.tif.
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
[bookmark: third-time]Third time
There are three layers, so let’s try again and see what happens this time:
· Click on the New Project button at the top left of the QGIS window, or Ctrl-N on your keyboard. If asked, Discard the current project.
· Go to the Browser panel again and this time add the srtm layer n57_w007_1arc_v3.tif first.
· Next add the miniscale layer miniscale_mono_r19.tif
· Finally this time, add the Regional Seas around Europe shapefile (.shp).
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Look at the layers on your map
You should be able to see the first layer that you added but where are the other two layers? Zoom to layer on each of them in turn and see what they look like, and how they appear in relation to the other layers.
• Can you see all three layers at once?
• When you zoom to the Regional Seas layer you may see a large grey shape - zoom way out and investigate that further. What is it?
• Use the cursor to hover over the bottom left-hand corner of the miniscale layer - what coordinates show at the bottom of the map?
• Have a look at the bottom right of the map window. Use the mouse to look at the tooltips and find the button that shows the CRS. Make a note of what it says at the moment.
[bookmark: what-have-you-observed]What have you observed?
You should see that each time the result is different. In particular the miniscale map doesn’t appear in the same geographic location as the other two maps.
You should also notice that when the European River Catchments layer is added first the CRS button at the bottom right of the window shows a different code.
· When the miniscale is added first the code will either be EPSG:4326 or No projection, depending on how the default is set on your copy of QGIS.
· When the Regional Seas around Europe layer is added first the code will be EPSG:3035.
· When the SRTM layer is added first the code will be EPSG:4326.
This is because the map is set to the coordinate system of the first layer to be added, or, if the layer does not have a coordinate system defined, to the default which is usually either EPSG:4326 or No Projection.
If you’ve noted the coordinates of the bottom right of the miniscale layer each time, you should notice that they are low numbers close to 0,0. Because the miniscale has no projection set, QGIS is placing it with the lower-left corner at 0,0 and this will vary depending on the “origin” of the current project CRS.
[bookmark: on-the-fly-projection]On-the-fly projection
The different results that you have observed are because if you have already set a project CRS either by adding a layer or through the properties, QGIS then tries to project subsequent layers “on-the-fly”. Whilst this is very useful, the result is not always successful and the layers are not all visible together or, if they are, may not line up exactly on top of each other.
Even if all the layers line up, if the coordinate systems are not all set to the same crs then you’ll have trouble editing data, measuring distance and area, or running analysis tools.
The important lessons here are:
· Make sure that you know the coordinate systems of your data
· Make sure that you know what coordinate system you want your map to appear in
· Make sure that all the coordinate systems match.
We’ll spend the rest of the time in this chapter looking at how you can do the above.
[bookmark: working-with-coordinate-systems][bookmark: _Toc160015455]Working with coordinate systems
When setting up a new project you’ll need to start by checking and setting the coordinate reference system (CRS) for your project and for each of your layers. There are also other layer properties that you’ll need to check, for example, is your data layer raster or vector?
[bookmark: deciding-on-the-correct-crs]Deciding on the correct CRS
The first step is to think about what CRS you need to set for your project. It can depend on what area you are working in, for example if you are working in the UK then it will usually be the British National Grid, if you are in Spain then it will probably be a version of UTM. If you are creating a map of a whole continent or the World, then the use of the map will affect which CRS you choose.
In this case we’ll create a map of the Isle of Skye in the UK, so we’ll use British National Grid.
Let’s find out more about that CRS.
· Go to the epsg.io website. You can use this site to find out more about coordinate systems for different areas of the World.
· Use the search box to look for Britain.
· The first result should be OSGB 1936 / British National Grid - United Kingdom Ordnance Survey which is the most common/likely for the area you’ve searched for - click on that link
The page for this gives more information about the CRS.
· One very useful feature is the map showing the area covered by that projection. Remember from the lecture that different projections or coordinate reference systems work best for different areas and this map, showing the extent of the one you have chosen, should help.
· Make a note of the EPSG code at the top of the page - EPSG:27700. This helps when finding the correct projection in your GIS.
· Have a look at the Attributes further down the page, in particular the Unit, but also the area of use.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Looking up EPSG:4326
EPSG:4326 is a default CRS in QGIS. Click to search epsg.io again, but this time search for 4326. There only appears to be one result for this, so click on the entry in the list to go to that page and have a look at the details for that.
• What is the name of the CRS?
• What is the area covered?
• What are the units?
[bookmark: setting-up-a-new-project-from-scratch]Setting up a new project from scratch
Now that you know the CRS you want your project to be set to, let’s go ahead and set up a new project.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Checking and setting the CRS of your project in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· If QGIS isn’t already open, open it now.
· If QGIS is already open, click on the New Project button at the top left of the QGIS window, or go to Project > New or use Ctrl-N on your keyboard. Discard the current project if there is one.
· Look at the bottom right of the QGIS window. There will probably be an EPSG code there and that will usually be EPSG:4326 by default. You’ve found out a bit more about that CRS above and should know now that it is called WGS 84 - you’ll come across this frequently.
[image: ../../shared/docs/images/crs/CrsButton2_small.png]
The current CRS button showing that the initial project CRS is set to WGS 84.
You may find that your CRS isn’t set by default, in that case the button will look as follows and say No Projection if you hover over it.
[image: ../../shared/docs/images/crs/CrsButton1_small.png]
The CRS button showing that there is no CRS set.
· Whichever version your QGIS is showing, click on the button now. This is the quickest way to get to the CRS window of the Project Properties.
· If No CRS is ticked, untick it now.
· In the Filter box type the EPSG number for the CRS you selected for this project - British National Grid - 27700. You could type British National Grid instead, but the code is often the quickest and most reliable way to find the right CRS.
· In the list that appears under Predefined Coordinate Reference Systems click on OSGB 1936 / British National Grid
Note that British National Grid is under the list of Projected Coordinate Systems. This means that it is a grid that will allow measurements in metres or similar, rather than degrees. If you want to use a map for measurements of distance or area it needs to be in a projected CRS, or projection.
[image: ../../shared/docs/images/crs/CRSProperties_small.png]
The CRS tab of the Project Properties showing the project CRS being set to British National Grid, EPSG:2700
· To set the CRS and close the properties, click on OK
· Have a look at the Current CRS button again, that should now have changed to say EPSG:27700.
[image: ../../shared/docs/images/crs/CrsButton3_small.png]
The Current CRS button now shows that the project CRS is set to British National Grid.
At this point Save your map
· Project > Save or Ctrl-S.
· Browse to the project folder and give the project file a name such as CoordSystems. QGIS will automatically give it a .qgz extension.
· Save
Once you’ve saved your file you should be able to see the Project Home folder in the Browser panel and use that to browse to your files.
If you can’t, right-click on Project Home > Set Project Home..., browse to the folder where you saved your qgz file and Select Folder.
[bookmark: checking-the-layer-properties]Checking the layer properties
Now that the project CRS is set, we can start looking at the properties of the data layers.
You are going to be creating a map of an area of Britain with the spatial reference of British National Grid so need to check whether all the layers are set to that.
You will need to know whether your data is raster or vector. This is a basic classification of all the data you will be using in GIS. The basics of raster and vector formats will be covered in the lecture for this week so if you need a reminder you can look back at the presentation or recording. Below I give you some more practical tips for working out in QGIS whether your data is raster or vector.
If you are still unsure there are lots of helpful articles and videos on the web. Try the following or search for GIS raster and vector:
· Ordnance Survey Raster and vector data
· Spatial Vision Raster and vector data in GIS
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Checking the layer CRS in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips. 
To find the properties for each layer do the following then make a note of the details. If you’re not sure, just have a go. It doesn’t matter if you are wrong!
· In the Browser panel right-click on the Regional_seas_around_Europe_LAEA_20221003.shp file and select Layer properties...
· Check that you are on the Metadata tab and look for and make a note of the following details:
· Is the data raster or vector?
· In the properties panel look for the “Provider”. For a raster layer that will be gdal, for a vector layer it will be ogr.
· Look at the file extension - .shp is always vector. In this workbook, .gpkg will always be vector. (It is possible to store raster data in a geopackage, but I don’t cover it in this workbook.)
· Vector layers will also have Geometry which can be one of point, line (or linestring), polygon, multipoint, multiline or multipolygon.
· Look at the file extension - any of the following extensions are always raster - .tiff, .tif, .jpg, .asc, .png.
· For raster data, what is the data type and GDAL driver
· For vector data, what is the Storage?
· What is the CRS? Is it Geographic or Projected?
Repeat for the other two layers, the Miniscale mono and the SRTM (if you have more than one tile of SRTM data just use one of them, it doesn’t matter which). If there is no text next to CRS just write down Unknown.
Notice that you should come up with a different CRS for each layer. This is a common problem when working with spatial data from multiple sources and is an important reason why you should check your data!
Your notes should show something like the following:
	Layer
	Vector / raster
	CRS
	Projected / geographic
	Data type
	Storage or Driver

	Regional Seas around Europe
	Vector
	EPSG:3035 - ETRS89-extended / LAEA Europe
	Projected
	
	ESRI Shapefile

	Miniscale Mono
	Raster
	Unknown
	
	Byte - Eight bit unsigned integer
	GeoTIFF

	SRTM tile
	Raster
	EPSG:4326 - WGS 84
	Geographic
	Int 16 - Sixteen bit signed integer
	GeoTIFF


Now that we have this information, we can start to add our data to the project.
[bookmark: X2671386944b6696aaa249fba3948b2c07f3962b]Setting the CRS of a layer where it is not already set
· Add the Miniscale layer to your map. This should be the first layer added to your project which already has the CRS set to epsg:27700.
When you add the miniscale layer to your map you should find that it doesn’t cause any obvious problem, but it does have a small globe with a question mark next to it in the Layers panel.
[image: ../../shared/docs/images/crs/NoProjection_small.png]
The miniscale layer in the Layers panel showing the symbol which tells you that this layer has no CRS set.
When you checked the layer properties for the miniscale layer you should have found that the CRS is not set.
At this stage you need to do some detective work to find out what the CRS for the layer should be. That usually involves looking at any documentation that came with the data, or going to the website from which you downloaded it.
In this case the miniscale layer is Ordnance Survey data downloaded from Digimap and I can tell you that it should be set to British National Grid EPSG:27700, which in this case is the same as the project.
[image: images/svg/warning-black-24dp.png] Warning
Note that you can’t just set the CRS for the miniscale layer to whatever you want at this stage, you have to set it to the original CRS or the one that should have been set. You can change the CRS later if you need to.
[bookmark: Xfddeec77b07503ad803143fe0b157b46386a8cd]Temporarily assigning the existing CRS to a layer
It is possible to remove the question mark icon by temporarily assigning the correct CRS to a layer. This isn’t suitable if you are going to be using the layer for further analysis or measurement, but can help if you are only using it as a background map.
· Click on the question mark and globe icon to the right of the miniscale layer in the Layers panel. This will open the CRS window.
· At the top it should explain the the layer “appears to have no projection specification”.
· In the Filter box, type 27700, the EPSG code for British National Grid.
· From the Predefined Coording Reference Systems box select the line which says OSGB36 / British National Grid - EPSG:27700.
· Click on OK to apply the temporary fix.
You should notice that the question mark and globe icon disappears from next to the layer in the Layers panel.
[image: ../../shared/docs/images/crs/TempCRS_small.png]
Temporarily applying the CRS for the miniscale layer.
Alternatively:
· Go to the layer properties by right-clicking on the layer in the layers panel and going to Properties then to the Source tab.
· Under Assigned Coordinate Reference System you can see that it says invalid projection. To set the CRS temporarily drop this down and select the correct projection - British National Grid. You can also click on the three dots button at the end of the line and select the CRS that way.
· Click on OK to apply it temporarily.
The above looks as if it works fine, but it is only a temporary solution. If you add the miniscale to a blank map it will need to have the CRS set again, the assigned CRS isn’t part of the data.
[bookmark: Xa2358e57aac24bbf181091aa20790fe861041e3]Permanently assigning the existing CRS to a layer
To set the CRS of the raster data permanently, you need to assign the projection. It is good practice to get into the habit of using this method rather than temporarily assigning the CRS.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Assigning a projection in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To assign the CRS to the original projection do the following:
· On the menu bar click on Raster > Projections > Assign projection.
· For the Input layer select the miniscale_mono_r19 layer
· Under Desired CRS select British National Grid or click on the button at the end of the line and select it that way.
· Click on Run
· Once the tool has run click on Close and the no projection symbol should disappear from the Layers panel.
You don’t need to enter an output name because this tool assigns the CRS to the existing file.
[image: ../../shared/docs/images/crs/AssignProjection_small.png]
Filling in the form to assign a projection to a layer.
If you add the miniscale layer to a new blank map now you should find that it has kept the British National Grid CRS.
[image: images/svg/info-black-24dp.png] Sometimes an unknown CRS doesn’t matter
To confuse things slightly, sometimes it doesn’t matter if a layer doesn’t have a CRS, or if the CRS is different to that of your project.
Think of the use you’ll be making of the layer. If it is simply a background layer and is in effect a “picture” that just sits behind your other data, but which isn’t used for analysis, then you simply need to check that you’ve set the project CRS correctly and leave QGIS to use “on-the-fly” projection.
If you have added an XYZ tile layer, don’t try to change the CRS. It won’t work and can cause problems with other layers on your map. Again, these layers are there as background layers and can’t usually be used for analysis anyway.
[bookmark: transformations]Transformations
Let’s see what happens with a vector layer with a different projection.
· Add the Regional Seas around Europe layer to the same map.
You should find that a new window opens which looks something like the image below.
[image: ../../shared/docs/images/crs/Transformations1_small.png]
The Transformations selection window for the European River Catchments layer.
This indicates that the layer has a different CRS to the project CRS. QGIS is trying to project the layer into the project CRS on-the-fly but needs to know which mathematical method, or transformation, to use to do so, so it is asking you which transformation you prefer for your map.
It’s usually OK to select the suggested transformation.
· Click on OK now to accept the suggested transformation.
You may see a yellow band at the top of the map warning you that QGIS “Used a ballpark transform from IGNF:ETRS89LAEA to EPSG:27700”.
[image: ../../shared/docs/images/crs/BallparkWarning_small.png]
The warning about using a ballpark transform. Don’t worry about this, it’s a warning not an error!
You’ll get used to seeing these notices (with a variety of CRS mentioned). They are warnings, not errors, you are fine to ignore them! They actually mean that there should be a more accurate transformation available. Usually for your needs, the default that is used is fine.
It’s important to note that once again this “on-the-fly” transformation is only a temporary solution. This means that the map looks fine, but if you want to do any measurements or analysis you may well run into problems. We’ll look at more permanent ways to reproject and transform data in the next couple of sections.
[bookmark: reprojecting-a-vector-layer]Reprojecting a vector layer
The process of changing the CRS of a layer to a different CRS is called reprojection. Reprojection works slightly differently depending on whether a layer is vector or raster.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Reprojecting a feature class in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
We’ll start with the Regional Seas Around Europe layer, which is a vector layer.
The current CRS is EPSG:3035 - ETRS89-extended / LAEA Europe and, for the purposes of this project, we need to convert this to British National Grid permanently.
[bookmark: X5bbd29372ac750a25ee6bc0b277351e911fedab]Reprojecting a layer by Exporting to a new layer
As with so many tasks in GIS there are two ways to do this. The simplest is to Export the layer to a new layer.
· Right-click on the layer in the Layers panel
· Export > Save features as...
· As this is a vector layer we’ll save it to a geopackage, so select that under Format
· Browse to the project folder to save the geopackage and give it a name, e.g. CoordSystems
· Then give the new layer a name, e.g. ERC_BNG to indicate that it is in British National Grid (note not spaces, and the only symbol allowed is an underscore).
· Next to CRS either dropdown and select the Project CRS if it is British National Grid, or click on the ellipsis (three dots) button at the end of the line to select that.
· Check that Add saved file to map is ticked
· Then click on OK
[image: ../../shared/docs/images/crs/SaveVectorLayerAs_small.png]
Changing the CRS of a vector layer by exporting to a new feature class.
You can now remove the original layer from your map to keep the map tidy.
If you add the new layer to a blank map it will still be projected to British National Grid, showing that the change is permanent.
[bookmark: reproject-layer-tool]Reproject layer tool
The alternative way of reprojecting the vector layer is as follows:
· On the menu bar go to Vector > Data Management Tools > Reproject Layer
· Fill in the Input Layer and the Target CRS and click on the three dots button next to Reprojected to save to a new file.
· Run and then Close to see the reprojected layer.
[image: ../../shared/docs/images/crs/ReprojectLayer_small.png]
Using the tool to reproject a vector layer.
You might not notice much difference in the data on the map either way, but if you look at the layer properties source tag of the new layer you should be able to see that the CRS has been changed.
If you add the new layer to a blank map it will still be projected to British National Grid, showing that the change is permanent.
However, I found that with this data, the first method (exporting) worked well, but the second gave a very strange result. This shows the benefit of having more than one option available to you!
[image: ../../shared/docs/images/crs/ProjectionProblem_small.png]
Strange end result of reprojecting vector data.
In this case, the tool has taken notice of where the edges of the target coordinate system are and has cut the data. Unfortunately, because the data is polygons, where they have been cut, QGIS is displaying them with the shortest edge. Hence, the strange lines across the middle!
If this happens, try the other method of reprojecting data by exporting. If neither methods work, you may have to investigate clipping your data to the smaller extent.
[bookmark: reprojecting-a-raster-layer]Reprojecting a raster layer
The previous section shows how to reproject vector data, now let’s reproject raster data using the SRTM data that you downloaded as an example.
Once again there are two ways to reproject a raster. It is possible to right-click on the layer in the Layers panel and Export > Save as... a new file, but usually the more reliable method for raster data is to use the Warp tool.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Reprojecting a raster layer in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by adding the SRTM layer to your map. Accept the transformation if you are given a choice.
· In the menu bar go to Raster > Projections > Warp (Reproject)
· The Input Layer is the SRTM layer n57_w007_1arc_v3 - you can select it in the dropdown if it is in your map, or browse for it using the three dots button at the end of the line
· The Source CRS is optional, but feel free to set it to EPSG:4326. The result tends to be more reliable if you can set this.
· The Target CRS is the CRS you are reprojecting to - if you have the CRS for your project set select Project CRS: EPSG:27700 using the dropdown, or if you need to, browse using the ellipsis (three dots) button at the end of the line.
· Go down to Reprojected and click on the three dots button at the end of the line. Choose Save to file...
· Browse to where you want to save the output file. I often create a folder called output in the project folder and use that to save all the raster files that I generate.
· Give the output file a name that reminds you what it is, e.g. SRTM_n57_w007_BNG to show what data it is, where it covers, and what the CRS is. The Save as type should be set to TIF files (*.tif)
· Save then Run the tool
[image: ../../shared/docs/images/crs/WarpReproject_small.png]
Filling in the Warp tool to reproject a raster file to British National Grid.
The new layer should be added to your map and to the Layers panel. If it isn’t, drag it there from the Browser now.
If you look at the Layer properties of the new layer now (right-click on the layer in the Layers panel and select Properties then look at the Information tab) you should see that the CRS is set to EPSG:27700 - OSGB 1936 / British National Grid - Projected.
You can now remove the original layer from your map to keep the map tidy.
Once again, if you add this layer to a blank map the CRS of the layer should already be saved as British National Grid and you shouldn’t need to set it again.
[bookmark: Xb8428a0ab8409986e61e6f87def9e3d6893ce6f][bookmark: _Toc160015456]Creating a new map in British National Grid
Hopefully, if you look at the properties for each of the projected layers now they will all be in British National Grid.
Try opening a new blank map - you should be getting used to this by now! Then add all three of the newly projected layers to the map. It shouldn’t matter which order you add them.
Do all of them appear in the correct location in relation to each other? Remember that you can change the order in the Layers panel if one layer is blocking the others.
QGIS sets the project CRS to that of the layer which is added first, so has that been correctly set to EPSG:27700?
[bookmark: X1900788fc0939f42c942e5b546f6d4f306e89d5][bookmark: _Toc160015457]Summary of defining projections and projecting data
This summary of the main points of this section of the workbook should help you to remember what you need to do each time that you obtain a new dataset or start a new map. Read it through, and then remember where to find it so that you can refer back to it. If you don’t follow these steps, then you can give yourself a major headache when trying to load data for a project.
In addition to the text summary there is a step-by-step diagram at the end of this section which you can use as a quick reference each time you have data to load into GIS.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Summary of defining projections and projecting data in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
The next chapter of this workbook gives you another exercise to practice projecting and transforming your data as this will be an important area to understand before you move onto further analysis. The chapter is optional, but if you are not completely sure about what you have just been doing it will be worth working through it.
[bookmark: X011b5ea5c62edf56749ed2d044eb6af1d7009ad]What do you want to set as the CRS of your map?
Start by deciding what CRS to use for your map. Remember that this depends on the area you are working in and the use of your map. Go to the epsg.io website for more information on a particular CRS or to find out what CRS is best for a particular area.
[bookmark: check-the-current-crs-of-your-data]Check the current CRS of your data
Once you know which CRS you want to use for your map have a look at your data.
Always start by checking the current CRS of your data. You won’t be able to do much without this information. Suggestions for finding this information include:
1. Check the file / layer properties or the metadata using the Browser
1. If that doesn’t help, e.g. if there is no CRS set, look at any documentation that came with the data (sometimes there is a text or pdf file in the folder with the data).
1. If that still doesn’t help, check with whoever or where ever you got the data from, e.g. the web page if you downloaded the data from the web.
1. If you still haven’t found the answer you may need to make an educated guess based on what you do know about the data then experiment…
[bookmark: projecting-your-data-on-the-fly]Projecting your data on-the-fly
It is possible to project your data on-the-fly to the CRS of your project, but if you are using your data for further analysis you must project it to a new layer using the appropriate tools shown below.
[bookmark: define-the-projection]Define the projection
If no CRS has been set you first need to set it to it’s original CRS which you should have worked out in the previous section. You cannot change the coordinate system by setting it. You need to set the correct CRS first then use the vector or raster reprojection tools if you need to change it.
[bookmark: reproject-the-layer-and-transform-it]Reproject the layer and transform it
If / when your data is not in the CRS that you want to use for your map then you need to Reproject the layer. Remember that you use a different tool depending on whether you are reprojecting vector data or reprojecting raster data.
If you haven’t already set the transformation for your project you may be asked to do so at this stage.
[bookmark: projection-all-correct]Projection all correct
If your data is projected and is in the same projection as your map then there is no problem and you can just use it as it is.
[bookmark: Xb4e029f21d2fbfa698e7d0abd26bf78e28b52b5]Quick reference diagram for defining projections and projecting data
This is the above information in diagram form.
[image: ../../shared/docs/images/crs/CoordinatesActionSummary.png]
Summary showing the decision process and actions necessary to prepare data for GIS.
[bookmark: Xc016c87b8108322ac3adf996af880d09ee7e6f4][bookmark: _Toc160015458]Recommended reading: Coordinate Reference Systems
Many of the books on the reading list[footnoteRef:6] include basic information about coordinate reference systems and projections. Specific suggestions include the following: [6:  The reading list is available in Minerva and also from the University Library by searching for SOEE2650 on the reading list page.] 

For background information try the following chapter:
· Chapter 4, Georeferencing in Longley, P.A. et al. (2015), pp. 77-98 covers latitude and longitude (from p.86), projections and coordinate systems (from p.88) and gps (from p.94).
· For some general information about the how and why of coordinate systems look at I Hate Coordinate Systems!. This site gives some brief ideas for what to do if you are having problems with coordinate systems for your data.
· The QGIS User Guide includes a section on Working with Projections that should help you with QGIS in particular.
· If you want to find out more about coordinate systems and projections in general then the definitive guide is the USGS Professional Paper 1395 by John P. Snyder (1987) called Map Projections: A working manual. This is downloadable as a pdf.
· It is possible to add custom projections to QGIS and you can see how to do this on Anita Graser’s web page Beautiful Global Projections - adding custom projections to QGIS.
[bookmark: Xf0a6927f08cf9ec92692859a9c2eca87fc81819][bookmark: _Toc160015459]Coordinate systems: practice in projecting data
Last Modified: 17 Jan 24, 09:18:07
[bookmark: introduction-1][bookmark: _Toc160015460]Introduction
This is an optional exercise. It is designed to give you more practice in working with coordinate systems and projections, a skill you will need for future assessments as well as the exercises in this workbook. This chapter will not be covered in the practical sessions and you do not have to do it, but if you want to work through it and need help with the exercises you can work on it in any of the classes or email me at any time. I would suggest that if you feel you are getting behind, you leave this chapter for now and come back to it later if you need to.
Often the most challenging part of a GIS project is finding the data that you need and adding it to a map so that it all fits together. In the first assessment you will need to put together several different data sets and then do further analysis. If the data sets don’t all have the correct coordinate system before you do the further analysis, then you will struggle to carry it out successfully.
[bookmark: what-do-you-need-to-do][bookmark: _Toc160015461]What do you need to do?
This exercise is designed to give you practice in projecting data by adding the included data sets to a map.
You should aim to project / reproject all layers to British National Grid so that they all appear in the same position on the map. Once you have processed all the layers provided you should open a new map and add your layers to that. The final map should have the CRS set to British National Grid.
Refer to the instructions in the previous chapter. Remember that there is a summary and diagram at the end of the chapter.
Be aware that even if the layers appear to be on top of each other you still need to check their projection - don’t just rely on QGIS applying on-the-fly projection. That causes problems if you are carrying out further analysis on your data.
[bookmark: data-provided][bookmark: _Toc160015462]Data provided
The data for this exercise is available as ProjectionsUK.zip in Minerva. Download the zip file and unzip it to your GIS folder.
Files within each folder give more details of where the data was obtained from.
· Copernicus grassland layer for the area surrounding the Bristol Channel
· Corine land cover layer for the area surrounding the Bristol Channel
· getmapping_rgb_25cm - two tiles of aerial photography for the north of Weston-super-Mare
· OS_OpenMap_Local_Raster - two tiles of raster mapping for the north of Weston-super-Mare
· OS_OpenMap_Local_Vector - vector layers for the tidal boundary, tidal water and foreshore of the Bristol Channel
· Sentinel - real-colour data from the European Sentinel satellite
· SPOT - data from the SPOT Earth Observation Satellite
[bookmark: target-projection][bookmark: _Toc160015463]Target projection
You should end up with a map and layers ALL projected to:
EPSG:27700 British National Grid
Work through each layer in turn checking the current crs and assigning or reprojecting as necesary.
[bookmark: checking-the-final-result][bookmark: _Toc160015464]Checking the final result
Add all your British National Grid layers to a new blank map.
All the layers should now lie on top of each other. In addition check that the project CRS is set to EPSG:27700 British National Grid.
[bookmark: conclusion][bookmark: _Toc160015465]Conclusion
If you’ve worked through all the layers and everything appears to have worked, then congratulations. If you were working on a project or assessment, you would be ready to move on to the analysis now.
[bookmark: collecting-point-data-with-gps][bookmark: _Toc160015466]Collecting point data with GPS
Last Modified: 07 Feb 24, 14:50:47
The background to creating point data with gps will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-2][bookmark: _Toc160015467]Learning outcomes
When you have completed this section of the workbook you should be able to
· Explain what a GeoPackage consists of and why it is used to store GIS data
· Collect your own spatial data for use in GIS
· Symbolise data on a map so that it displays clearly and informatively to your audience
[bookmark: introduction-2][bookmark: _Toc160015468]Introduction
The previous chapter should have given you some idea of the variety of data that is available for you to use, but there is nothing to replace going out and collecting your own data and it is very likely that you will be using GPS when you’re doing fieldwork at some point.
When you are collecting your own data you may well find yourself using a GPS receiver, or collecting GPS data on a mobile device. If you do, you are likely to need to know how to add data from gpx files to QGIS. This section covers the things you need to be aware of when collecting data, and how to import the data into QGIS for use on your maps.
If you are new to GPS and would like to find out more about the background and technology there is a beginners guide at:
· Garmin
[bookmark: Xee1288fc63b08e71d1ae071b55b10fdbc1fdf66][bookmark: _Toc160015469]Considerations when collecting data with GPS
[bookmark: setting-up-the-gps]Setting up the GPS
It is possible to collect data via GPS with a dedicated GPS receiver, or by using an app on a smartphone.
Given the possible variety, I can’t give instructions for downloading data. You’ll need to look at the instructions for your own device.
There are however, a few things you should check before you start collecting data.
· Check the coordinate reference system (CRS) or projection. If you are using GPS as a supplement to a paper map (which you should be…), set the CRS to the same as the map. In the UK that is usually British National Grid or OSGB 1936/OSGB36. For other countries, look at the maps you are using. This will then allow you to check location on the GPS against location on the map.
· GPS units usually store data as WGS 1984 (EPSG:4326), and this will be the CRS of the data you download. If you are using an app on a smartphone, check the CRS of the output.
[bookmark: data-accuracy]Data accuracy
The general advice is to turn on your GPS well in advance of starting to work, and leave it on for the whole of the working day. This gives it a chance to find and track the maximum number of satellites. Even under ideal conditions, when your receiver has found several satellites, due to the nature of the system, accuracy still won’t be 100%. Your device should allow you to see the current level of accuracy, usually a measurement in metres. Be aware of this when using the readings and keep a note of it.
It is particularly worth noting that GPS can give an illusion of extreme accuracy. The readings tend to show figures with lots of decimal places, which could lead you to assume that a reading is accurate to 1 m or less. This is extremely unlikely to be the case!
For this reason, it is still important to know how to locate yourself accurately on a paper map without the use of GPS, and most navigation experts will say that with practice you can be far more reliable and accurate than a GPS unit. Not least, you should have the intelligence to recognise when the point you are standing at is at the top of a cliff, not off it!
[bookmark: elevation]Elevation
Don’t use elevation measurements from your GPS. For various reasons, obtaining accurate height readings with GPS is much more difficult than obtaining accurate horizontal readings. The Ordnance Survey web site has an explanation of how best to do this, but it involves specific equipment and readings taken over at least 24 hours.
[bookmark: data-to-download][bookmark: _Toc160015470]Data to download
· Download the file CreateData.zip from this weeks folder in Minerva.
· Save the file to your disk and unzip it.
The zip file should contain the following items
· A GeoPackage called StudyArea.gpkg.
· A folder called getmapping_rgb_25cm which contains an aerial photograph of the University. You’ll need this for the chapter on creating data.
· Waypoints_26-FEB-14.gpx - waypoints which I collected back in 2014 and luckily still have. This is the file downloaded from the gps unit I collected the data with. If you are able to collect your own data you won’t need to use this.
· Waypoints_type_26-FEB-14_map.pdf - a map showing the location and type of all the waypoints that I collected. This is not a GIS-enabled file and will not open correctly in QGIS.
[bookmark: starting-a-new-project-in-qgis][bookmark: _Toc160015471]Starting a new project in QGIS
You can just open QGIS and start adding data, but it will help you later if you take more care at this stage.
· Open QGIS
· Go to Project > Save and navigate to the folder in which you would like to save your project. This could be a folder called gis with a subfolder called ChancellorsCourt - note that there should not be any spaces in the folder name.
· Give your project a name, e.g. ChanCourt - short and no spaces.
· Save
Having done that you should have a file in your folder called ChanCourt.qgz.
· Go to Project > Properties in the menu in QGIS and click on the General heading on the left
· The Project file should already be filled in
· Set Project home to the folder in which you saved the qgz file
· Set the Project title to something like Chancellors Court, University of Leeds - basically a description of what your map is going to show.
· Check that Save paths is set to relative
· Click OK
[image: ../../shared/docs/images/gps/ProjectProperties_small.png]
The general tab of the Project Properties showing the settings you should fill in.
Save paths is probably the most important project setting as it can save you from having data go missing if you move your project to another computer. By setting this to relative, as long as you move the whole folder, your data and your map will stay linked.
[bookmark: Xfe4646a63e8d4f76ca5373e7a7239f1b5da9b7d][bookmark: _Toc160015472]Using the Browser to find information about a layer
Now that you have the Project home set it is possible to use that heading in the Browser to find everything associated with this project (assuming all your files are in that folder).
· Go to the Browser (if it isn’t already open go to View > Panels and put a tick next to Browser).
· Click on the little arrow next to Project Home to see the contents of the folder. You should see all the files that you unzipped earlier.
[image: ../../shared/docs/images/gps/Browser_small.png]
The Browser panel showing the files and folders for this project listed under Project Home.
One of the benefits of the browser is being able to have a look at the details of your data before you add it to a map.
· click on the little arrow next to Waypoints_26-FEB-14.gpx
You should see that the file includes several layers. For this exercise the only one we want is waypoints
[image: ../../shared/docs/images/gps/GPXcontents_small.png]
The layers within the gpx file as seen in version 3.16 of QGIS.
· Right-click on the waypoints layer and go to Layer Properties
· Use the three tabs at the top of the layer properties - Metadata[footnoteRef:7], Preview and Attributes - to have a look at your file. [7:  Metadata can be described as “data about data”. A commonly quoted example is a library catalogue, which holds data about books.] 

[image: ../../shared/docs/images/gps/LayerProperties_small.png]
The layer properties showing metadata about the layer you right-clicked on.
The Metadata tab tells you quite a lot, but the Preview tab can confirm that your data looks correct, and the Attributes tab will let you see the table of data that you have.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Make a note of the CRS
One particularly important piece of information is the CRS, or Coordinate Reference System. You’ll need to know this later.
Make a note of the text next to the CRS subheading in the Metadata then close the Layer Properties.
[bookmark: adding-a-gpx-layer-to-a-map][bookmark: _Toc160015473]Adding a gpx layer to a map
[image: images/svg/videocam-black-24dp.png] Adding a gpx layer to a map in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Drag and drop the waypoints layer from the Browser to the Layers panel.
You should now have a map showing small circles for each of the waypoints which looks something like the image below. (Your colours may be different.)
[image: ../../shared/docs/images/gps/WaypointsAdded.png]
The map once you have added the Waypoints. Your colours may be different to these.
[bookmark: exporting-gpx-layer-to-a-geopackage]Exporting gpx layer to a GeoPackage
As the layer is stored at the moment this is not a proper GIS layer, it is still the gpx file. If you are going to use these points for further analysis or measurements you need to export them to a GIS format, such as a layer in a GeoPackage.
[image: images/svg/info-black-24dp.png] GeoPackage format
A GeoPackage is a form of database designed to store spatial data. It has been relatively recently developed but it’s use as a GIS format has spread very quickly. QGIS encourages the use of GeoPackages and it is increasingly possible to use them in other GIS software.
You will store vector data in a GeoPackage as multiple layers.
If you want more information about the format there is a lot on the GeoPackage website.
To export the waypoints to a GeoPackage layer:
· In the Layers panel right-click on the waypoints layer
· Export > Save Features As...
· Fill in the panel that opens as follows:
· Format = GeoPackage
· Click on the ... button at the end of the File name box, navigate to the folder in which you want to store your GeoPackage - preferably the same folder as your .qgz file, then give your GeoPackage a name, e.g. University.gpkg. The location tends to be a good idea here.
· Save
· In the Layer name box give your layer a name such as Waypoints - it needs to be a name that will tell you what data this layer contains.
· Check that the CRS field is the same as the CRS you made a note of earlier - in this case that should be EPSG:4326 - WGS 84
· Check the bottom of the form to make sure that Add saved file to map is ticked.
· Click OK to create the GeoPackage and add the new layer to your map.
[image: ../../shared/docs/images/gps/SaveVectorLayerAs_small.png]
Filling in the form to save your waypoints as a vector layer in a GeoPackage.
Your map won’t look much different, though the dots may have changed colour.
The new GeoPackage should have appeared in the Browser in the folder you saved it to. Have a look at that now and drop down the arrow next to the .gpkg file to check that the Waypoints layer is there.
[bookmark: refresh-the-browser]Refresh the browser
If you can’t see the new GeoPackage in the browser, or it doesn’t appear to have any contents, you may just need to refresh the Browser.
· Select the Project Home heading
· In the row of buttons at the top of the browser click on the second button from the left - the tool tip should show you that this is the Refresh button.
[image: images/svg/info-black-24dp.png] Components of a GeoPackage
If you have a look at the same .gpkg file in your file explorer outside of QGIS you’ll probably see three files with the same name but slightly different extensions - .gpkg, .gpkg-shm and .gpkg-wal. The last two are temporary files which appear when the GeoPackage is open in QGIS. Once you close QGIS you’ll only see the .gpkg file.
The GeoPackage itself is a single file and without appropriate software, such as QGIS, you can’t open it and see the contents.
[image: ../../shared/docs/images/gps/GeopackageExplorer_small.png]
The components of a GeoPackage viewed in a file explorer when the file is open in QGIS.
To keep the Layers panel tidy right click on the original waypoints layer and Remove layer... but don’t delete the .gpx file or it’s contents from the Browser - you may need them again later.
[bookmark: adding-a-background-map-to-your-data][bookmark: _Toc160015474]Adding a background map to your data
In the section on XYZ Tile maps in QGIS you added some useful background maps to QGIS. Now is a good time to use one of them.
I suggested you added the Thunderforest Atlas layer to QGIS. You could also use the default OpenStreetMap layer.
· Find either of those under the XYZ Tiles heading in your Browser panel and double-click on it to add it to your map.
· The new layer will probably be added at the top of the Layers panel list - move it down so you can see your other layers above it.
[image: images/svg/warning-black-24dp.png] Warning: do not try to reproject XYZ layers
Please note that you should not try to reproject, crop or otherwise edit the XYZ layers. These are being loaded over the web (like streaming) and you are not able to alter them. You will only be using them as background maps, not for analysis, so not being able to reproject them is not a problem. QGIS will use on-the-fly transformation to display them correctly.
We have found that some people who have tried to reproject these layers have then had problems with the CRS of the other layers in their project.
[bookmark: adding-extra-data-to-feature-classes][bookmark: _Toc160015475]Adding extra data to feature classes
The layer that you have saved to a GeoPackage is known in GIS terms as a feature class. This contains your features and data for each one which are called attributes.
[image: images/svg/videocam-black-24dp.png] Working with attribute tables in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Layers panel right-click on your waypoints layer and select Open Attribute Table.
The attribute table is the GIS equivalent of a spreadsheet and contains features and their attributes.
[image: ../../shared/docs/images/gps/AttributeTable_anno.png]
The attribute table annotated with some of the terminology.
Amongst many other attributes there should be one for name which should include the label or name of each waypoint as stored by the GPS unit. In this case the name field holds a number which matches the numbers of the points on the Waypoints_type_26-FEB-14_map.pdf file which you downloaded from Minerva.
· Open the file Waypoints_type_26-FEB-14_map.pdf from the downloaded data and have a look at the information there
Labels on the map show the name field followed by a description of the type of feature, e.g. Rock, Sign post, Planter.
Somehow we need to get that extra information in to the attribute table and unfortunately that has to be done manually!
· Have another look at the waypoints attribute table. There is a field there called desc for description. This seems to be a sensible field in which to put the new information.
To start adding attributes to a table you need to start editing the feature class.
· On the attribute table window click on the Toggle Editing Mode button at top left (see the annotated picture of the attribute table above, and remember that tool tips are visible if you hover over buttons). If you’re not sure whether a layer is editable have a look at the Layers panel - any layer toggled for editing will have a little pencil symbol on the left.
· Click in the space under desc for the point with the name 001 - the word NULL should be selected
· Look at the pdf map and find point 001 (it’s at the top left of Chancellors Court) - what is the description of it?
· If you have trouble finding it try selecting the feature in the attribute table by clicking on the number in the grey space on the left. The point will then be highlighted on your map in QGIS
· The description for point 001 should be Sign post so type that in to the attribute table.
· Click on the Save edits button on the attribute table toolbar to write your edits to the feature class in the GeoPackage.
Continue doing this for some more of the points. Don’t worry if you can’t find some of them on the map - just leave those blank (NULL).
[image: images/svg/create-black-24dp.png] You don’t need to add information for all the points
Try to do a minimum of about 20 of the points. There are rather a lot there and you don’t need to do all of them on this occasion! You just need to do enough to be able to understand what you’re doing.
[image: ../../shared/docs/images/gps/AttributeTableDesc.png]
The attribute table in edit mode with the desc fields filled in. Note some are still NULL.
· Once you’ve input the descriptions (and saved your edits) click on the Toggle Editing Mode button again to stop editing
· then close the attribute table by clicking on the cross in the top right.
[bookmark: sorting-the-attribute-table]Sorting the attribute table
Sometimes the table doesn’t open in the order you expect it to. Before you start entering data check that the numbers in the name field run from 001 upwards. If they don’t you can Sort the table correctly by doing the following:
· Right-click on the column heading in the attribute table and select Sort...
· This opens the Configure Attribute Table Sort Order dialog
· Put a tick next to Defined sort order in attribute table
· The name field should already be added to the box on the left, if it isn’t delete anything that is in that box, then go to Fields and Values in the central box and double-click on name
· Check that Sort ascending is ticked Then click on OK
[image: ../../shared/docs/images/gps/ConfigureAttributeTableSortOrder_small.png]
Configuring the sort order of the waypoints table - setting the sort field to name.
[bookmark: styling-the-point-layer][bookmark: _Toc160015476]Styling the point layer
Now that you have the description in your attribute table you can style your point layer, initially as a single symbol but then with different symbols for different types of feature.
[bookmark: styling-a-layer-as-a-single-symbol]Styling a layer as a single symbol
The default styling is for single symbols.
[image: images/svg/videocam-black-24dp.png] Styling a layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the waypoints layer in the Layers panel and click on the Open the Layer Styling panel button - at the top of the Layers panel on the left or use the F7 keyboard short cut.
· The layer styling panel should open on the right of the map window and gives you choices for the way your layer looks.
[image: ../../shared/docs/images/gps/Symbols_small.png]
The Layer Styling panel showing single symbols.
In this view you can click on any of the symbols in the gallery and the symbols on your map will change to match them. Try this now by picking any symbol from the gallery.
The section at the top allows you to change the size, opacity and colour of the symbols. Again, try changing the choices there and see what they do. You get more choices if you click on the Simple marker symbol layer.
[bookmark: styling-a-layer-as-categories]Styling a layer as categories
So far you have a single coloured symbol representing every point. Your map would be much more informative if each type of feature had it’s own symbol.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Styling a layer as categories in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· At the top of the Layer Styling panel click on the dropdown that says Single symbol and change it to Categorized
· Now drop down the list next to Value and select the field that you want to categorize your symbols on - in this case desc
· Lower down the panel click on the button that says Classify
Your descriptions should appear as a list and the symbols on your map should change to a variety of random colours.
[image: ../../shared/docs/images/gps/SymbolsCategories_small.png]
The Layer Styling on the right is set to Categorized and the desc field has been added as the Value. The different types of item have been added to the list by clicking on Classify. Note the different colours on the map.
Note that the attributes that you left as NULL in the attribute table have all been styled as a symbol listed as all other.... It would be good to get rid of that as it isn’t adding any useful information to the map.
· In the Layer Styling panel untick the box on the left of the all other... category. Alternatively you can click on this and then on the Delete button at the bottom of the panel to get rid of the symbol completely.
The NULL symbols should all disappear from the map.
Note that the Layers panel on the left now acts as a key to your waypoints layer.
[bookmark: changing-to-svg-markers]Changing to svg markers
You can change the symbols by double-clicking on each symbol in turn and selecting different ones from the Gallery.
At the moment all your symbols are Simple markers. It is easy to change them to SVG markers and have a wider range of symbols to choose from.
[image: images/svg/videocam-black-24dp.png] Styling points with svg markers in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Double click on the first symbol in your list in the Layer Styling panel (in my example it is Bike shelter)
· In the box at the top click where it says Simple marker
· Below that change the Symbol layer type to SVG marker
SVG stands for Scaleable Vector Graphics and is basically what it says. In the context of QGIS it gives you a much greater range of pictorial symbols with which to style your map.
· Have a look at the SVG Image gallery at the bottom of the panel and select an appropriate symbol.
· You can use the settings above the change the size, colour, rotation etc.
· The symbols should appear on your map automatically, but if they don’t click on Apply
· When you’ve finished click on the back arrow at the top of the panel to get back to the list.
[image: ../../shared/docs/images/gps/SVGMarkers_small.png]
Choosing SVG markers to style your points.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Choose symbols for your points
Continue in the same way to select appropriate symbols for the rest of the categories of point.
[image: ../../shared/docs/images/gps/SymbolsOnMap_small.png]
Symbols on the map - yours will probably look different as you’ll have made different choices.
Once you’ve finished setting the symbols for the waypoints, save your map and close it.
[bookmark: Xa52c8124b4812e3091b3a8ed6798525c6492540][bookmark: _Toc160015477]Changing the coordinate system (CRS) of data
The GPS data that you have collected is in the WGS 84 geographic coordinate system. Remember that you checked this earlier. QGIS sets the project CRS to that of the first layer that you add to the map. So, in this case the map CRS is also WGS 84.
Often you will need to use data in a local projected coordinate system. The obvious example is if you are using Ordnance Survey maps from Digimap in the same project. This is the example we will use now, but the same situation can arise if you are, for example, creating a map of Spain or Eire[footnoteRef:8]. [8:  If you want to find out more about coordinate systems and projections have a look at Heywood (2011) pp. 44-51 for a general introduction.] 

[image: images/svg/videocam-black-24dp.png] Checking and setting the crs of your project in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
We’ll set up a map project in British National Grid and add the gps data to that.
· If QGIS is not already open, open it from the start menu, but don’t open a map. If you already have a map open click on the New Project button, or use the keyboard shortcut Ctrl+N to open a new blank map.
· Use the browser panel to look at the contents of the StudyArea.gpkg GeoPackage that you will have downloaded from Minerva and drag the ChancellorsCourtBNG layer to the Layers panel. It should appear in your map area. Remember that the first layer that you add to a map automatically sets the coordinate system.
· You may get a window like the one below asking about Transforms, just click OK on this for now. This is to do with ways of “transforming” data from one CRS to another.
[image: ../../shared/docs/images/gps/TransformSelection_small.png]
The Transform selection window. Just click OK for now.
You should find that you have a map with a polygon covering Chancellors Court. If you look at the bottom right of the map window you should be able to see the text EPSG:27700. This is the code for British National Grid and confirms that your map is in the correct CRS.
[image: ../../shared/docs/images/gps/LocationBNG_small.png]
The Chancellors Court polygon on your map and the EPSG code - 27700.
· Save your map to the same folder as the previous map. Call it something like UniversityBNG.qgz - BNG = British National Grid.
· Add the Thunderforest Atlas XYZ tile layer to your map. You should already have it in the list, but may need to follow the instructions in the link to add it, if it isn’t there.
· If you need to, style the ChancellorsCourtBNG polygon layer so that it has an outline but no fill. You should be able to see the base map through it. Styling a polygon layer is very similar to styling points so you should be able to use the previous instructions again.
· Zoom in to the Chancellors Court polygon using zoom to layer.
· Now add the Waypoints layer from your GeoPackage (not from the original gpx file) to the Layers panel from the Browser.
The waypoints should appear in the correct place, i.e. in Chancellors Court, even though they have a CRS of WGS 84 and the map is in British National Grid. You can check this in the layer properties if you want to.
QGIS is projecting the layer “on the fly” using a transformation. This is very convenient, and if you are just going to look at the map that is fine. But if you need to do any analysis or measure anything then you really need to get this layer projected in to British National Grid as well.
[image: images/svg/videocam-black-24dp.png] Reprojecting a feature class in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To project the layer permanently
· Right click on the Waypoints layer in the Layers panel or in the Browser
· Export > Save features as...
· Fill in the Save Vector Layer as... dialog as follows
· The Format should be GeoPackage
· Click on the three dots button next to File name and browse to your existing GeoPackage.
· Give the output a Layer name which will remind you what it contains, e.g. WaypointsBNG
· Drop down the CRS and select Project CRS: EPSG:27700 - OSGB 1936 / British National Grid.
· Finish by clicking OK
[image: ../../shared/docs/images/gps/ChangeCRS_small.png]
Filling in the Save Vector Layer as… dialog to save your waypoints as a new feature class with a projected CRS of British National Grid.
Your map probably won’t look much different but the new layer should have been added to the Layers panel. If it hasn’t drag it over from the Browser.
[image: images/svg/videocam-black-24dp.png] Checking the layer CRS in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Check the new CRS by right-clicking on the new layer and going to Properties
· Look at the Information tab.
· The CRS heading should say EPSG:27700 - OSGB 1936 / British National Grid - Projected. If it doesn’t you may have to try again and check everything carefully as you go along.
· Remove the original waypoints layer from your Layers panel and Save your map.
Now you have a map in British National Grid which shows your waypoints and which, because all layers match the map CRS, can be used for analysis.
· Make sure you have both of your maps of Chancellors Court open in QGIS - you should find that it is possible to have QGIS open twice.
· If you compare your two maps you should be able to see that the different CRS gives a very different idea of the “shape” of Chancellors Court.
[image: ../../shared/docs/images/gps/CompareCRS_small.png]
Comparing British National Grid (left) and WGS 84 (right).
This is because the projected CRS, British National Grid, is designed to be best to display maps of Britain on a cartesian grid whereas the geographic CRS, WGS 84, is designed to display maps of the whole world in latitude and longitude. This means that the mathematics behind each CRS is rather different.
[bookmark: copying-styles]Copying styles
If you want to style the point symbols on your BNG map so that they are the same as the WGS 84 map try the following short cut:
· This will be easier if you have both the original map, and the British National Grid maps open, though you can start in the first, then move into the other after you’ve copied the style.
· In the WGS 84 map right-click on the waypoints layer and select Styles > Copy Style > All style categories
· In the British National Grid map right-click on the waypoints layer and select Styles > Paste style > All style categories
Your styles should be copied across and your map is ready to go!
[bookmark: the-final-map][bookmark: _Toc160015478]The final map
Set the symbols on your map so that you are happy with them and zoom out so that a bit more of the University is visible.
Set up a basic layout and export it as an image to finish.
Alternatively just export your map as an image without creating a layout:
· When you are happy with your map go to Project > Import / Export > Export Map to Image
· In the Save Map as Image dialog set the extent by clicking on the Map Canvas Extent button
· Click on Save
[image: ../../shared/docs/images/gps/SaveMapAsImage.png]
Saving your map as an image.
In a later chapter you’ll find out how to create a full map layout with a key, scale bar, measured grid etc and print or export that properly, but for now this is fine.
[image: ../../shared/docs/images/gps/ChanCourtBNG_small.png]
The final map exported as an image. Yours will probably look different to this as you’ll have made your own decisions about symbols and colours.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Keep this project for the next chapter
In the next chapter you will be creating data in QGIS by digitising. We will use the area of Chancellors Court again, so keep this project for that.
[bookmark: X0515570ef42ed514fe5ab5e911356cd9072d24f][bookmark: _Toc160015479]Further information and suggested reading
Some of the books in the reading list[footnoteRef:9] have information GPS and its use for collecting data. Suggestions include the following: [9:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 2, Spatial data in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.65-67 cover GPS.
· Chapter 2, Collecting Field data more efficiently with GIS and GPS technologies in Tian, Bai (2016), pp. 57-90 looks in detail at how GPS can be used for collecting data and includes a few case studies.
The QGIS Documentation has a chapter on Working with GPS data which covers much more than we have been able to cover here.
· Working with GPS data for v. 3.22 of QGIS
[bookmark: creating-data-by-digitising][bookmark: _Toc160015480]Creating data by digitising
Last Modified: 17 Jan 24, 09:22:17
The background to creating data for GIS will be covered in the lecture segment this week, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-3][bookmark: _Toc160015481]Learning outcomes
When you have completed this section of the workbook you should be able to
· Set up storage for GIS data
· Use the tools in GIS to draw (digitise) your own data
· discuss the problems that can affect data for GIS
· suggest ways in which to minimize error and uncertainty in spatial data
[bookmark: introduction-3][bookmark: _Toc160015482]Introduction
Digitising or tracing data manually in GIS involves having a background map which shows the locations that you wish to digitise, and then using the editing tools to draw vector polygons, lines and points. In this set of exercises, you will produce a map of Chancellors Court in the University showing the outlines of the buildings, the paths, and the trees. You will already have a layer from the previous chapter which contains features such as sign posts, benches and rocks.
Even if you don’t actually need to digitise a whole map it is extremely useful to know how to set up your own feature classes and how to add features by editing. Sometimes you just need to outline your study area or add a point to show where something specific is, or as input to one of the tools provided in GIS.
This is a very brief overview of the tools for digitising in QGIS as we are limited for time.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png]Vector and raster
If you feel that you are not clear about the difference between raster and vector GIS data it would be worth having a look at the video “Learn more about raster and vector map data” by the Ordnance Survey.
As you deal with more GIS data you’ll start to find it easier to spot which formats are raster and which are vector, but you need to be thinking about it already.
[bookmark: obtaining-the-data][bookmark: _Toc160015483]Obtaining the data
If you have already followed the GPS chapter and have a British National Grid version of the map of Chancellors Court then you can use that map again. This chapter will use features in the same area. You will already have downloaded CreateData.zip and unzipped that to use the data.
If you no longer have this project, or if you have not followed the GPS chapter, you can start a new project from scratch instead. You won’t have the gps points on the map when you have finished, but that doesn’t matter.
If you haven’t already downloaded CreateData.zip for the previous chapter you need to do so now.
· Download the CreateData.zip file from Minerva
· Unzip the data to a new folder within your GIS folder.
You should end up with a folder called getmapping_rgb_25cm which contains aerial imagery of the University[footnoteRef:10]. The jpg file within that folder contains the image and the other files with it, which have a similar name, contain information that will locate it correctly within GIS. [10:  This data was downloaded from Aerial Digimap.] 

You should also have a GeoPackage called StudyArea.gpkg which contains an outline for the area of Chancellors Court in the layer ChancellorsCourtBNG.
[bookmark: open-the-map-project][bookmark: _Toc160015484]Open the map project
· Start by opening either your existing Chancellors Court map or a new blank map.
· From the files you downloaded and unzipped add se2934_rgb_250_01.jpg to your map using the Browser. (You may need to look in sub folders to find the file.) Remember if you can’t find the folder or the file that you’ve just added you can refresh the Browse panel.
· If you need help to find Chancellors Court, add the ChancellorsCourtBNG feature class from the StudyArea.gpkg GeoPackage to your map and Zoom to Layer.
· If necessary turn off the waypoints, location and any background layers so they don’t get in the way.
· Save your map. Saving your map regularly is a good habit to get into. In addition, if this is a new map, once you’ve saved your map you’ll have the Project Home heading in the browser.
You should have an aerial view of Chancellors Court on your map. You will use this as a basis to digitise the buildings, paths and trees.
[image: ../../shared/docs/images/creating_data/AerialMap_small.png]
The aerial image open in QGIS showing the area of Chancellors Court.
[bookmark: X1797607b4cd358b0aa646ac39fc880837563627][bookmark: _Toc160015485]Setting up GeoPackage feature classes to store your data
The first thing you need to do is set up the storage for the data that you are about to create. You should already have a GeoPackage in your project, and if you do, you can use that to store this new data too.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating feature classes in a GeoPackage
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: X65e8a04dacac87592d1640576eeca297fc0429f]Creating a new GeoPackage and adding a feature class
[image: images/svg/warning-black-24dp.png] Warning
Your browser will show a heading titled GeoPackage. Don’t use that at this stage. Instead, you need to browse to the folder where you want to save your GeoPackage, and that should be the same folder as your map and data.
If you are going to use an existing GeoPackage, go straight to the next section - Adding a new feature class to an existing GeoPackage.
If you don’t already have a GeoPackage or want to create a new one:
· In the Browser, right-click on the folder in which you want to store the new GeoPackage or GeoPackage layer. It’s a good idea to use the Project Home folder if you have already saved your map but at least put it in the same folder as the rest of your project data.
· New > GeoPackage
QGIS will create a new GeoPackage called New GeoPackage.gpkg and add it to your folder.
· To rename the GeoPackage, right-click on it and go to Manage > Rename "New GeoPackage.gpkg...".
· Name your GeoPackage something that will remind you what it contains. In this case something like University.gpkg would be good, because it will be containing data about the University.
· Click OK.
[image: images/svg/warning-black-24dp.png] Warning
You may find that you get an error message at this stage, telling you QGIS can’t rename the GeoPackage. If you get that, don’t worry, just carry on with the New GeoPackage.gpkg. It’s not ideal, but still works and you could change the name later if you wanted to.
Alternatively, you can close QGIS, rename the GeoPackage in your computer file manager, then reopen QGIS.
You should now have an empty GeoPackage ready for you to fill with data.
[bookmark: Xbeb297237a00b6fb1ed083320d9f404440573d2]Adding a new feature class to an existing GeoPackage
Once you have a GeoPackage, or if you already have one, you need to add feature classes, or tables, to be able to store your data.
· Right-click on your GeoPackage in the Browser panel
· Select New Table
· If you get an error message saying Cannot Create New Tables:
· click OK to get rid of it,
· then right-click on the GeoPackage again and this time select Add Connection.
· You won’t see any difference at this point, but now right-click and select New Table again.
· The New Table dialog should open.
· Give your new table a name, in this case call it Paths.
· Click on Add field and give it the name Label, Type should be Text (string) (choose from the dropdown box) and Length = 250 - that’s the maximum length of text you’ll be able to type into the table for that field.
· Set the Geometry Type to LineString. This is where you’re setting your data to be either points, lines or polygons. Note that it’s important to set this correctly as it can’t be changed later.
· Under CRS select the required coordinate system - in this case British National Grid.
· Tick to Create spatial index - this makes the storage and retrieval of your data more efficient.
· Click on OK to create the new table.
[image: ../../shared/docs/images/creating_data/NewGPKGTable_small.png]
The window to create a new table in an existing GeoPackage.
If the table isn’t added to your map automatically, drag it to the Layers panel from the Browser now.
If you can’t see the new layer in the GeoPackage you may need to select the top-level folder and then click on the Refresh button at the top of the Browser.
[bookmark: setting-up-further-feature-classes]Setting up further feature classes
For this exercise you will need a polygon feature class, a point feature class and a line feature class.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Feature classes to create
Use the instructions above to create a total of three feature classes in the same GeoPackage. Note that the Geometry type is different each time and remember that you must set this correctly or you have to create the feature classes again.
• Create a Line feature class called Paths. If you followed the instructions in the section above, you’ll already have this feature class/table.
• Create a Polygon feature class called Buildings. This should have a new text field called Label with a length of 250.
• Create a Point feature class called Trees. Again, this doesn’t need any new fields.
Have a look at the new layers in your GeoPackage using the Browser. Note that the icons next to the layers show you what the Geometry type is.
[image: ../../shared/docs/images/creating_data/GeopackageLayers_small.png]
This is how your new GeoPackage layers should look in the browser. Note that the icons show the Geometry type of each layer. The GeoPackage example here also includes the waypoint layers from the GPS chapter don’t worry if you don’t have those.
[bookmark: digitising-in-qgis][bookmark: _Toc160015486]Digitising in QGIS
You should already have an aerial view as a background for your map. For these exercises you will be digitising polygons, lines and points by tracing over features on this view.
Before starting to digitise check that you have the Digitising Toolbar open.
· View > Toolbars
· Check that there is a tick next to Digitising Toolbar
The toolbar should look something like this image at the moment. The only button available is Toggle Editing.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOff.png]
The Digitising Toolbar before you start digitising.
[bookmark: digitising-polygons]Digitising polygons
The Buildings feature class has a geometry type of Polygon, so this will hold closed shapes. We’ll start by digitising polygons, but lines and points are actually very similar.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Digitising in QGIS Part 1: Starting and finishing, and creating polygon features.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by selecting the Buildings layer in the Layers panel
· Either right-click on the layer and click on Toggle Editing or click the Toggle Editing button on the Digitising toolbar.
You should have more buttons available on the Digitising toolbar now.
[image: ../../shared/docs/images/creating_data/DigitisingToolbarOn_small.png]
The Digitising Toolbar once you have toggled editing with more buttons available.
· The button that I’ve highlighted is Add Polygon Feature. Click on this so that you are ready to start tracing.
We’ll digitise the School of Earth and Environment (SEE) building by drawing around the outline on the aerial photograph. SEE is the building to the north of Chancellors Court[footnoteRef:11]. [11:  If you’ve lost Chancellors Court in your map remember that you have the ChancellorsCourtBNG layer in your map from the downloaded data. You can Zoom to Layer on that to get back to the right area.] 

· Left-click on one corner of the SEE building, then on the next. Keep left-clicking until you have outlined the building. You can zoom in and out and pan as necessary (to pan easily hold down the mouse wheel and drag the map).
· As you progress around the shape you should see it as a transparent red with a stronger outline.
[image: ../../shared/docs/images/creating_data/DigitisingInProgress_small.png]
Starting to digitise the School of Earth and Environment. Note the transparent red area outlined in stronger red, this shows where you have already digitised.
· Each click creates a vertex or node.
· If you want to delete the previous vertex that you placed, because it’s not right, just press the Delete or Backspace keys on your keyboard.
· If you’re not happy with the whole shape clicking on Esc will get rid of it completely.
· When you have placed a vertex on each corner of the building right-click to finish editing.
Depending on the settings in your installation of QGIS you should find that a Features Attributes window opens. This gives you an opportunity to add attributes to your table.
If the window doesn’t appear you can still open the attribute table for the layer (right-click on the layer in the Layers panel) and add attributes that way.
· The buildings feature class has a Label attribute. Fill that in now with the name of the building - School of Earth and Environment.
· The fid (or Feature ID) is generated automatically so don’t touch that.
· Click OK.
· To save your new feature to the GeoPackage make sure that you click on the Save Layer Edits button on the Digitising toolbar
[image: ../../shared/docs/images/creating_data/EditingFeatureAttributes_small.png]
Adding attributes to your new feature. fid is generated automatically so don’t touch that!
Your new feature should appear as a solid colour on your map.
Continue on to digitise the buildings to the east, west and south of Chancellors Court. The map below shows the names of the buildings for you to add.
[image: ../../shared/docs/images/creating_data/BuildingNames_small.png]
Buildings around Chancellors Court and their names.
· When you have finished digitising and have saved your edits click on the Toggle Editing button again to finish.
[bookmark: styling-your-layer]Styling your layer
At the moment the buildings are a solid, random colour. Let’s change the colour to something that’s more usual for showing buildings on a map.
[image: images/svg/videocam-black-24dp.png] Styling a vector layer as a single symbol in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the Layer Styling panel by selecting the buildings layer then either clicking F7 on your keyboard, or clicking on the button at the top left of the Layers panel - the tool tip is “Open the Layer Styling Panel”.
· You can select a style from the Gallery that opens - one is called “Topo Building”, or click on the bar next to Color and select your own colour.
· Check Live update is ticked at the bottom of the panel so that your styles are automatically applied to your map.
· You can also click on Simple Fill at the top and experiment with the settings there.
[bookmark: transparency]Transparency
It can be useful to make your layers transparent. As you draw your building polygons you’ll gradually be covering up the layers underneath and it can be useful to see through the top layers.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Making vector layers transparent in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 on your keyboard.
· The layer styling panel should open to the right of your map.
· Click on the Symbology tab in the icons on the left of the panel
· Make sure that the Fill is selected
· Use the Opacity slider to change the opacity or transparency of your layer. For example, slide it to about 70%
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
It is also possible to change the transparency by using the Opacity setting in the Layer Rendering section, but if you do that the features may not remain transparent when you export your map to pdf.
Set the opacity so that you can see through your building polgons to the aerial imagery below.
[image: ../../shared/docs/images/creating_data/SEEOpacity_small.png]
The SEE building with 70% opacity set.
[bookmark: data-quality]Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality issues
Stop and think about the digitising you have just done. Can you think of any potential issues with the data that you have created in this way?
What scale did you digitise at? What effect will this have on the amount of detail that you included? What recommendation would you make about viewing the data on the map?
How accurate were you when you were placing the vertices on the corners of the buildings?
How clear were the edges of the building that you were digitising? What did you do when the edges were unclear, e.g. because of overlapping trees. What about shadows?
[bookmark: editing-features]Editing features
If you want to edit a polygon, line or point to change it once you have created it you can.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Editing features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the buildings layer and click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· Left-click on one of the vertices and you will be able to move it around.
· When the vertex is in the position that you want it just left-click again.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool. Your feature should appear as transparent red again.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
[bookmark: moving-vertices-by-typing-coordinates]Moving vertices by typing coordinates
Alternatively you can type coordinates into the Vertex editor to ensure that a particular vertex is in the correct location.
This is most useful if you have surveyed a feature and know exactly where the vertices should be placed.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Click on the Vertex tool on the digitising toolbar.
· Then right-click on the feature that you want to edit. The feature’s vertices will become visible as small red circles or squares.
· The Vertex Editor should open on the left of the map window. This will show the x and y coordinates for each vertex on the selected feature.
[image: ../../shared/docs/images/creating_data/VertexEditor_small.png]
The vertex editor. It is now possible to type in new x and y coordinates for each vertex of the selected feature.
· To edit the coordinates just double-click on the coordinate that you wish to change.
· When you’ve finished editing right-click on the feature again to stop using the vertex tool.
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
[bookmark: deleting-features]Deleting features
If you want to delete a feature completely you can.
· Click Toggle Edit on the toolbar (if you aren’t already editing)
· Look for Select Features by area or single click button on the toolbars (highlighted on the image of the Attributes toolbar below)
[image: ../../shared/docs/images/creating_data/AttributesToolbar_small.png]
The Attributes toolbar with Select Features by area or single click highlighted.
· Click on the feature that you want to delete - it should become highlighted in bright yellow
· Press Delete on your keyboard
· Don’t forget to click on Save Layer Edits
· When you have done all your edits click Toggle Edit again to stop editing.
[bookmark: labelling-features]Labelling features
As you added features to your buildings feature class you also added the Label attribute. You can now use this to label the building features on your map.
This section shows you how to label polygon features. The same techniques apply to labelling lines and points.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Labelling features in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the Buildings layer in the Layers pane
· Then click on the button at top left of the Layers pane to Open the Layer Styling Panel or press F7 if it isn’t already open.
· The layer styling panel should open to the right of your map.
· Click on the Label tab on the left of the panel. At the moment it will just say No labels.
· Drop down where it says No labels and select Single labels
At this stage QGIS usually just labels your features with the first field in the feature class, which at the moment is fid. This isn’t very useful so the first thing you need to do is select the correct field.
· Next to Value drop down the choices and select the Label field.
Immediately the building names that you added should appear on your map on top of the correct buildings.
The default fonts, colours and placements are not always what you want. In fact, usually just accepting the defaults is not a good idea.
· Use the settings on the first of the tabs (Text) to change the font, font size and colour
[image: ../../shared/docs/images/creating_data/LayerStylingText_small.png]
The text panel of the Layer Styling panel. Change fonts properties here.
· Click on the Placement tab and select Horizontal from the Mode dropdown list. This should move your labels to within the polygon shapes as far as possible.
[image: ../../shared/docs/images/creating_data/LayerStylingPlacement_small.png]
The Placement panel of the Layer Styling panel. Change placement properties here.
Feel free to try out the properties in the other tabs too. There are lots of choices to help you make your labels clear and informative.
One useful one is on the Formatting tab where it is possible to set a maximum number of characters to wrap the labels onto multiple lines.
[image: ../../shared/docs/images/creating_data/LabelledBuildings_small.png]
The labelled buildings. Yours will look different as you will have made your own choices.
[bookmark: more-information-about-labelling]More information about labelling
Labelling is a big area and I’ve only shown you the basics here. If you want to find out more try some of the following suggestions.
The books in the Principles of Cartography section of the module reading list will all have sections on labelling, but try the following in particular.
· The QGIS User Guide includes a section on Setting a label which includes all the basic settings.
· Darkes and Spence (2017) has a section on Text on maps (pages 56-59) which includes information on type sizes and styles and text placement.
· Peterson (2021). Chapter 4 (p. 79 onwards) goes into more detail and is a readable guide.
[bookmark: digitising-line-features]Digitising Line features
Digitising line features is very similar to digitising polygons, except that you don’t have to finish where you started.
You should already have a Paths layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
Some of the paths on this map are curved rather than straight. The easiest way of drawing curved lines in QGIS is to click more often. On tight curves you do have to click a lot to make the line look curved. There are more advanced editing tools which would help, but this is only a quick overview so you can explore them if you want to, but this way of drawing is fine for now.
· Select the Paths layer, toggle editing and click on the Add line feature button
· Add lines for the paths across Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your paths in a similar way to how you styled the buildings - this time the gallery will have some suggested line styles and you can choose colours and line widths from the other panels.
[bookmark: data-quality-1]Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. Do you draw the edges of the paths, or just the centre line? How can you be sure of what happens underneath trees? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
[bookmark: digitising-point-features]Digitising Point features
Digitising point features is very similar to digitising polygons, except that you only have to click once for each point.
You should already have a Trees layer in your Layer panel. If you haven’t then drag it across from the GeoPackage.
· Select the Trees layer, toggle editing and click on the Add point feature button
· Add a point for each tree in Chancellors Court. You don’t need to add any labels for this layer.
· Save your edits and toggle editing off.
· Style your trees in a similar way to how you styled the buildings - this time the gallery will have some suggested point styles and you can choose colours and shapes from the other panels.
[bookmark: data-quality-2]Data quality
[image: ../../shared/docs/images/svg/help_outline-black-24dp.png] Think about data quality
Again, think about the problems that you encounter as you edit. How easy is it to decide where you should add a point to represent a tree? How easy is it to be accurate with the drawing tools? Think about the implications for future use of the map at different scales.
[bookmark: finally][bookmark: _Toc160015487]Finally
Finish digitising the buildings around Chancellors Court, the paths across it, and the trees. Check that all the layers that you have created - the points, lines and polygons, have been symbolised appropriately and are labelled where necessary.
· Turn off the Aerial image by unticking the box next to it in the Layers panel
· If you have them, turn the symbolised waypoints layer back on
· Make sure that all the features on your digitised layers are visible in the map window.
Try creating a layout which shows your map of Chancellors Court.
In a later chapter you’ll find out how to create a full map layout with a key, scale bar, measured grid etc and print or export that properly, but for now just experiment and see what you have come up with.
When you have created a map, export it to either an image or pdf.
[image: ../../shared/docs/images/creating_data/FinalMap_small.png]
The final map exported as an image. Yours will probably look different to this as you’ll have made your own decisions about symbols and colours, and about which features to include. You may also have included the features from GPS if you have done that exercise.
[bookmark: X329e688aa5c2692d8c1f419ffbe9a5c04c6ec77][bookmark: _Toc160015488]Further information and suggested reading
Many of the books in the reading list[footnoteRef:12] have a general introduction to inputting data to GIS. Suggestions include the following: [12:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 5, Data input and editing in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.135-173 covers the background to a variety of ways of inputting data to GIS and discusses data quality issues.
· Chapter 8, Data Collection in Longley, P.A. et al. (2015), pp.173 onwards. Again this chapter covers the background to a variety of ways of collecting data and inputting it to GIS. Section 8.3.2 from page 183 covers Vector Data Capture, or digitising.
The QGIS Documentation has a chapter on the techniques of Editing which covers much more than we have been able to cover here.
The information about Digitising an existing layer covers the topics in this chapter, but there is plenty more there.
· Digitising an existing layer for v. 3.22 of QGIS
There are a lot of videos on YouTube which may help you. Try searching for Digitising QGIS.
[bookmark: elevation-models-1-the-shape-of-the-land][bookmark: _Toc160015489]Elevation models 1: the shape of the land
Last Modified: 28 Feb 24, 12:21:48
The background to elevation models and terrain analysis will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-4][bookmark: _Toc160015490]Learning outcomes
When you have completed this section of the workbook you should be able to
· describe and identify raster formats of height data used in GIS and show an awareness of vector formats
· convert downloaded height data to an appropriate format to use in GIS
· use raster models to analyse surfaces
· describe appropriate applications of height data in environmental projects
[bookmark: raster-elevation-models-demdtm][bookmark: _Toc160015491]Raster elevation models: DEM/DTM
Raster elevation models are based on pixels or grids and can include various file formats, such as ascii or tiff. They have the advantages of being easy to store and manipulate and integrate easily with other raster formats. They are the best solution for continuous surfaces as they give a smoother and more natural appearance to terrains. The main disadvantage is that the grid size is set, and it isn’t possible to vary it to reflect different complexity of relief.
You will use raster elevation models for the rest of the exercises in this chapter.
[image: images/svg/videocam-black-24dp.png] Vector vs raster
If you feel that you are still not clear about the difference between raster and vector GIS data it would be worth having a look at the video “Learn more about raster and vector map data” by the Ordnance Survey.
[bookmark: data-for-the-elevation-model-exercises][bookmark: _Toc160015492]Data for the elevation model exercises
[image: images/svg/warning-black-24dp.png] Warning
Being able to find, download and prepare your own data is an essential part of using GIS. For the exercises in this chapter, you will need to download several datasets. While these should not take too long to download and prepare, don’t leave it until the last minute. Websites can become unavailable either permanently or temporarily, or computers can crash.
If there are problems with a website then try again later. If the problems persist please get in touch with me (c.e.gordon@leeds.ac.uk) and I will try to contact the site or find an alternative source of data.
[bookmark: data-required-1]Data required
Download the following U.K. data from the web.
Create a new folder for this project with no spaces or unusual characters in the name and unzip all the downloaded data to that folder as you download it.
[bookmark: data-to-download-from-digimap]Data to download from Digimap
In Digimap OS Download select data by drawing a box around the Lake District - the image below shows the approximate area. It doesn’t matter if you select a larger area (not too much larger!) but try not to select a smaller area.
[image: images/elevation/DownloadLakes.png]
The area for which to download data for the Lake District exercises. Use OS Download to obtain this data.
Download the following layers:
· From the Backdrop mapping section download 1:50 000 Raster in tiff format
· From the Land and Height Data section download OS Terrain 50 DTM in ASC format. Note: Please ensure that you download the correct layer - the Terrain 5 data is far too detailed for this size of area and you’ll end up with a very large amount of data to process and store.
[bookmark: database-of-british-and-irish-hills]Database of British and Irish Hills
Start by having a look at the Database of British and Irish Hills home page. Check how the data has been collected, and what information is included in the database.
Download a zip file containing the Excel 2007+ file for British Hills from the Downloads page and unzip it to your project folder.
[bookmark: national-park-boundaries]National Park Boundaries
Go to the Natural England GIS web page.
· On that page enter National Parks in the box that says Dataset name/leave blank
· From the list of results click on National Parks (England)
· You’ll get a page which shows what the dataset looks like and which also has a Download link on the left-hand side of the map (hover over the black bar and you’ll get tips which tell you what each button shows). Click on that and select to download GeoPackage format.
· It’s also a good idea to look for licence information - in this case you’ll find that by clicking on the More info button on the black bar on the left. There is a link to View license details at the bottom of the information panel.
[bookmark: summary-of-data-required]Summary of data required
· Height data will be a DTM file - or Digital Terrain Model (sometimes alternatively called a DEM, or Digital Elevation Model). This can be downloaded from Digimap.
· Tiff file for background mapping. You’ll also download this from Digimap.
· An Excel file containing points and data for hill summits in the UK from the Database of British and Irish Hills.
· GeoPackage of National Park boundaries from Natural England.
Create a new folder for this project with no spaces or unusual characters in the name and unzip all the downloaded data to that folder as you download it. Once you have done that, you are ready to start the exercises in this chapter.
[bookmark: preparing-the-dtm-data][bookmark: _Toc160015493]Preparing the DTM data
[image: images/svg/info-black-24dp.png] Which files need to be merged?
Note that you do only need to merge the DTM files by following the instructions below. The other raster files that you downloaded for this exercise (1:50 000 raster) are simply background images and will not be used for further analysis. They are basically there as a picture. If you do try to mosaic these, expect to end up with a very odd result!
With experience you will become used to the different file formats and purposes in GIS.
The DTM files that you have downloaded are raster files in ascii text format with a file extension of .asc. [footnoteRef:13] [13:  You can ignore the other files with extensions such as .xml and .gml in the same folder. Make sure you keep them with the .asc files, though. These files hold other information about the data which the GIS program uses itself.] 

Try opening one of the .asc files in a text editor [footnoteRef:14], but don’t change anything! The image below shows the NY03.asc tile from the OS Terrain 50 DTM dataset. [14:  Possible text editors include TextEdit on Mac and NotePad on Windows. If you want a better text editor for Windows then try Notepad++.] 

[image: images/elevation/TextFile_small.png]
Ascii format DTM file shown in a text editor (Notepad++). The numbers in your file will more than likely be different to the ones shown here unless you have opened the same tile of data.
Note that dtm or dem data may also be delivered as .tif or .jpg tiles amongst other possible formats. You can mosaic those in exactly the same way, but won’t be able to open them in a text editor. If you want to preview them just add them to a blank map.
The five heading rows in the ascii file give QGIS information about the data contained in the rest of the file
1. number of columns - in this case 200
1. number of rows - in this case 200
1. x coordinate of the lower left corner in the dataset CRS - in this case 300000 on the British National Grid
1. y coordinate of the lower left corner in the dataset CRS - in this case 530000 on the British National Grid
1. actual size of each cell in map units - in this case 50 metres
This is then followed by a screen full of numbers which are effectively in rows and columns, each number refers to the measurement or value at that particular grid point or cell in the file. When you view the file in GIS each of those points will be coloured according to that measurement.
[bookmark: X4ec9c472ae2ed7f7e10b58a5fcb2c5ab0f2a0b2]Checking the layer properties in the Browser
It’s a good idea to check the properties of your data in the Browser in QGIS before you start processing it. You’ll have all the information that you need then.
[image: images/svg/videocam-black-24dp.png] Checking layer properties in the Browser in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open QGIS if it isn’t already open and find the folder in which you saved your dtm layers in the Browser panel
· Right-click on one of the .asc files and click on Layer Properties to open the properties window. Depending on your version of QGIS, your layer properties window may look a bit different to the example below. You should be able to find all the same information, though, it may just be in a different place.
[image: images/elevation/LayerPropertiesMetadata_small.png]
Checking the properties of NY03.asc from the QGIS Browser panel.
From the Metadata tab make a note of the following properties:
· Coordinate Reference System (CRS)
· Units
· Width and Height
· Data type
· Pixel size
For some projects you will also find the information under Band 1 very useful as this shows statistics such as the highest and lowest values and the mean.
The Layer Properties also has a Preview tab which can be very useful for getting a quick idea of what your data looks like. Click on that now.
Note that sometimes the preview is just a black square - don’t worry if that’s the case for you! It may just be because there isn’t much contrast in the data.
[image: images/elevation/LayerPropertiesPreview_small.png]
Viewing a quick preview of the tile of data in the layer properties.
· When you’ve finished looking at the properties Close the panel.
[bookmark: X61eb394f678f50f586c0811d1bf13c10e1db512]Producing “seamless” datasets from more than one tile of data
Often data is provided as tiles, each covering a small part of the total area. That is what you have here with the Terrain 50 data. Before you can use this data for further analysis you will need to merge the tiles into one “seamless” dataset. This will make it possible to use the files as a continuous surface in maps and 3D scenes.
Note that this only applies where each tile contains data for a small part of the area. If the raster data tiles that you have all cover the same area then merging them will not work.
This will work with various formats of data, including tiff and asc.
[image: images/svg/videocam-black-24dp.png] Creating a seamless mosaic from multiple DEM tiles in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· If QGIS isn’t already open, open it now
· In the menu bar go to Raster > Miscellaneous > Merge
· Click on the three dots button at the end of the Input Layers line
· Then click on the Add File(s) button
· Navigate to where you saved the DEM tiles (probably in a folder called terrain-50-dtm or similar) and add all the .asc files in the folder. You’ll need to go into subfolders, such as nx, ny and sd to find the .asc files. These refer to the 100 km grid squares so you will probably have multiple subfolders to include files from and a lot of individual files. You can select more than one file at once by using the Ctrl key. (Have a look at the information box below to see how to simplify selecting a particular file format.)
· Once you have all the files added click OK to go back to the form
· The Output data type needs to match the data type of the input - you should have found that from the Layer Properties. For the Terrain 50 DTM it will be Float64
· Click on the three dots button at the end of the Merged field and click on Save to file...
· choose where to save the output, and give it a name which means something to you. For example, save it in a folder called output under the project folder and call it something like T50_dtm - remember no spaces and apart from the underscore, no odd characters.
· Check that Open output file after running algorithm is ticked
· Click on Run.
[image: images/svg/info-black-24dp.png] Tip: filtering by file format
By default the selection is set to All files (*). You can filter to just the format you want by dropping down the box at the bottom-right of the form that says All files (*), and select just what you want.
In this case, you can select Arc/Info ASCII Grid (*.asc *.ASC), then you’ll only see the .asc files in your folder.
[image: images/elevation/MergeForm_small.png]
Filling in the form to Merge multiple raster tiles. Note that the details for your data may be different to those shown here, in particular check the data type - this is crucial to running the tool successfully. Remember to include all your input rasters - they may be split across multiple folders.
If the tool runs successfully you should find that you have a map with a greyscale height map of the Lake District that looks something like the image below.
[image: images/elevation/MergeOutput_small.png]
The output map made by merging all the individual tiles of data. note that yours may not look identical to this one as it may cover a different area.
[bookmark: setting-the-crs-of-your-data]Setting the CRS of your data
It isn’t possible to set the CRS as part of the Merge command so once you’ve run that tool the first thing you should do is check the layer CRS.
[bookmark: assigning-the-correct-crs]Assigning the correct CRS
When I did that with the Terrain 50 dtm data I found that the layer CRS was OSGB 1936 / British National Grid - Projected. When I added the layer to a blank map the project CRS shown in the bottom right of the map was Unknown CRS.
So the Terrain 50 data is in British National Grid, but not a version that QGIS recognises.
If your data has the same problem, or doesn’t have a CRS, the way to deal with this is to assign the correct version of British National Grid using the version that starts with EPSG:27700.
Once you’ve assigned the correct CRS, if you have already added the layer to your map, you’ll also need to set the Project CRS correctly using the Project properties.
[bookmark: changing-the-crs]Changing the CRS
If you need to change the CRS of your data, for example if you have height data in EPSG:4326 WGS 1984 and want your final map to be in EPSG:27700 British National Grid, then reproject your merged layer into the new CRS.
[bookmark: displaying-height-data][bookmark: _Toc160015494]Displaying height data
In the previous section you merged multiple dtm tiles to make a single layer. You can now start using this data to create a map.
· Open QGIS if it isn’t already open
· Add your merged layer to a new blank map and check that the project CRS is set correctly
· Save your map as a .qgz file in your project folder
You should now have a map with a black and white elevation model of the Lake District. If you look at the symbology by opening the Layer Styling panel you will see that the layer is using Singleband gray styling. We can change this to make the elevation more obvious.
[image: images/svg/videocam-black-24dp.png] Styling a DTM in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Layer Styling panel drop down where it says Singleband gray and select Singleband pseudocolor. The choices in the styling panel will change.
· Drop down the Min / Max Value Settings subheading and make sure that Min / max is selected, then set Accuracy to Actual (slower)
· Interpolation should be Linear
· Then click on the down arrow next to the Color ramp. You have a small choice of colour ramps here, but to find a bigger selection click on Create new color ramp...
· In the Color ramp type select Catalog: cpt-city and click OK to get a much bigger selection.
· Have a look at the colour ramps that are available, but then click on the Topography sub heading
· Select either cd-a or sd-a then click on OK
· Your map might look a bit strange at this point, but now click on the Classify button
· It is a good idea to add the Label unit suffix to appear in the legend - in this case the height is in metres so type a space then m in the box
· You can really clean up your legend by setting Label precision to 0, but do think about the effect this might have on apparent accuracy. It’s often a good idea, but don’t just do it without thinking about your data.
[image: images/elevation/SinglebandPseudocolor_small.png]
The settings and resulting map for an elevation colour ramp.
You can try out some of the other colour ramps or settings and see what effect those have on your map.
If you were using this map for a report or similar you would want to ensure that the tidal water areas were a darker blue and it was more obvious where the edge of the land was. You could do this by altering the colour ramp, or, probably more simply, by using a vector tidal water layer over the raster height map (VectorMap District Vector in Digimap has a suitable layer).
[bookmark: hillshade]Hillshade
The DTM as it is now gives you a reasonable idea of the topography of the area when you look at it, but if you want a clearer view for including in a layer or want to give an idea of the topography on top of another map then you can create a hillshade layer.
[image: images/svg/videocam-black-24dp.png] Hillshade, slope and aspect in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that your merged DTM layer is open in a map in QGIS
· Right-click on the merged DTM and select Duplicate layer.
The layer will be duplicated and appear under the original layer in the Layers panel. The name will have _copy appended.
This is a useful technique as it means you’re not having to save any more data to disk. All you are doing is restyling the same data to show a different view of it.
· Rename the new layer to Hillshade and move it above the original merged DTM layer in the Layers panel. You’ll also need to tick the box to make sure the layer is visible.
At the moment, the two layers are identical and you won’t see any difference. To change the layer to a hillshade layer:
· With the duplicate layer selected, open the Layer styling panel.
· At the top, dropdown the box which says Singleband pseudocolor and select Hillshade.
[image: images/elevation/HillshadeOptions_small.png]
Setting a hillshade for an elevation layer in the Layer Styling panel. Note the options which allow you to change the altitude and azimuth of the sun as well as the Z factor for the height exaggeration.
Your layer should immediately change to a grey layer which looks something like the one below. The shading should make the shapes of the hills more obvious.
[image: images/elevation/HillshadeResult_small.png]
The resulting hillshade layer.
This can be a useful way of checking that your elevation layer (dtm) is correct. Sometimes a hillshade shows if there is something wrong more clearly than if you just look at the dtm. In this case the resulting layer looks absolutely fine.
Zoom in and out and pan around the hillshade layer. The resolution of this data is 50 m horizontally, which means that each pixel is 50 x 50 m, so it does start looking pixellated if you zoom in close. For this size of area that is fine - if you use data that is too detailed you will be dealing with very large datasets.
Try changing the options under Altitude and Azimuth. These change the angle and height of the light (or sun!) and can be useful in some circumstances. Generally the defaults are fine, though.
[bookmark: X9a3ece09cc35fbececbfcc2923c7b14dec1618b]Improving the look of the hillshade layer
If your hillshade looks rather blocky, try the following:
· In the Layer styling panel, go down to the Resampling section at the bottom.
· Change Zoomed in and Zoomed out from Nearest Neighbour to Bilinear or Cubic. Either method of resampling is likely to look better than the default.
This can look a bit blurred if you zoom in too far, but can also help.
[bookmark: creating-a-colour-relief-image]Creating a colour relief image
You won’t be using the hillshade layer in further analysis but can improve the look of the DTM by using it as an overlay.
[image: images/svg/videocam-black-24dp.png] Creating a colour relief image in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Move the hillshade layer to below the dtm in the Layers panel
· Select the dtm and open the Layer styling panel
· Go down to the Layer Rendering section and drop down the Blending mode box.
· You have several choices there, try some of them to see what effect they have on your map.
· When you’ve experimented leave the Blending mode as Multiply
[image: images/elevation/BlendingMode_small.png]
Setting the Blending Mode to Multiply on the DTM so that the hillshade emphasises the relief.
Blending modes “mix” the colours of the layers to produce different effects. In the case of multiply the greyscale of the hillshade emphasises the relief of the DTM very effectively. You can find more ideas for using blending modes in a blog article by HelenMakesMaps [footnoteRef:15]. The map shown in the image above is the same as the one shown next to the Layer Styling panel in the section on Displaying height data. [15:  Page accessed 10th December 2021.] 

[bookmark: adding-raster-background-data][bookmark: _Toc160015495]Adding raster background data
As well as the height data you should have downloaded a 1:50 000 raster tif layer from Digimap. This is background data. You can open it in an image viewer and would be able to see a map that looks identical to the paper maps that you can buy. We’ll use this as a background layer for the other data - it’s detailed enough to see hill names etc.
· In the Browser find the 1:50 000 raster data that you downloaded and unzipped and just drag and drop it into the Layers panel. You should have files to add from multiple folders.
· You may want to group the layers as there are rather a lot of them. You can then “fold” the group and it won’t get in the way!
· Make sure that this group is above the dtm in the Layers panel. You can make the dtm invisible now if you wish to. You’ll be using it for analysis, but won’t need to be able to see it.
· The raster layers will have the symbol next to them in the Layers panel which indicates that the CRS is not set correctly. You could reproject all of them, but as these are not going to be directly involved in analysis, but are just a background layer, and as they appear to be in the correct location, you don’t need to worry about reprojecting them this time.
· Do not attempt to merge these files. The end result would probably be rather odd and not helpful.
[bookmark: using-xyz-tiles-background-maps]Using XYZ Tiles background maps
We’ll be using the raster 1:50 000 data to provide a detailed background layer while we’re working on the maps, but when it comes to presenting the results, you’ll probably want to use a less detailed map.
You could download a more general map from Digimap, or you could if you like use one of the XYZ Tiles background maps for the end result instead of the OS data.
These are very useful backgrounds, but I found that it slowed my map down and didn’t always draw correctly. Feel free to try some of the layers out, but if your map starts slowing down too much you may just have to remove them from the Layers panel.
[image: images/svg/warning-black-24dp.png] Warning
If you do use one of these layers, please remember not to try reprojecting it to match the rest of the data in your map. This layer will only be used for display, and allowing QGIS to apply on-the-fly transformation is absolutely fine. Trying to reproject XYZ tile layers may just cause problems with the CRS of layers that you do want to use for analysis.
[bookmark: deriving-new-layers-from-height-data][bookmark: _Toc160015496]Deriving new layers from height data
Once you have a height layer in QGIS you can start to use it to derive other datasets. We’ll look at a few examples here and see how they can be used for display and analysis.
For this section let’s assume that you are setting up a study of a particular plant which prefers to grow on south facing slopes (that is, have a south-facing aspect). For safety reasons during fieldwork the study area should not be more than a 15 degree slope. We’ll use the QGIS slope and aspect tools to generate two separate raster files showing possible areas.
[bookmark: slope]Slope
The slope tool returns a raster where each pixel shows the rate of maximum change in z-value (height) from each cell.
[image: images/svg/videocam-black-24dp.png] Hillshade, slope and aspect in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· From the menu bar go to Raster > Analysis > Slope...
· The Input layer should be your DTM - double-check that you haven’t used the hillshade by mistake.
· Most of the settings can be left as the default.
· Click on the three dots button at the end of the Slope line and click on Save to file....
· Browse to the folder you want to save the output to and give it a name that will tell you what the layer shows, e.g. T50_slope (short, with no spaces and no odd characters except an underscore).
· Click on Run
[image: images/elevation/SlopeForm_small.png]
Filling in the form for the Slope tool.
The result will look rather strange, but is a raster file with each pixel having a degree measurement. As usual, zoom and pan to have a good look at the result. Have a look at the layer in the Layers panel. That will show you that the darkest colours are the flattest areas and the whitest are the highest slopes. Does that help you to make sense of it?
Try using the Identify Features tool to look at the values in this layer in more detail.
[image: images/elevation/SlopeResult_small.png]
The output of the slope tool. The black areas are the flattest, the white are the steepest.
[bookmark: reclassifying-a-raster]Reclassifying a raster
The layer doesn’t show you clearly which areas have a slope of 15 degrees or less, but you can reclassify the layer to show this.
[image: images/svg/videocam-black-24dp.png] Reclassifying rasters in QGIS: by changing symbology.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select your slope layer in the Layers panel and open the Layer Styling Panel.
· Change the dropdown on the Symbology tab from Singleband gray to Singleband pseudocolor - the layer may disappear from the map at this stage
· Change the Interpolation setting to Discrete
· Click on the Classify button below to ensure some classes appear - it doesn’t matter what those are at the moment as we’ll be changing them.
· Change the Mode to Equal Interval - this then allows you to change the number of Classes to 2. We’re trying to set values for either below 15 or above 15 so that gives us two classes.
Have a look at the values for the classes that QGIS has chosen. You can change these manually.
· Under the Value <= heading double-click on the first number and change it to the value for the top of the class you want to create. In this case we’re looking for values less than or equal to 15, so enter 15.
· The second band is set to inf, or infinity. You can leave that as it is in this case.
Now that you have set up the two classes you can edit the colour patches so that areas with a slope of above 15 degrees are transparent.
· Double-click on the colour patch next to inf
· Set the Opacity slider from the bottom of the colour choices to 0
· Then use the back arrow at the top of the panel to return to the original dialog
· By double clicking on the colour patch next to 15 you can change the colour of that class if you wish and make it partly opaque / transparent.
I found that values below 15 also include flat lakes and the sea, so to get rid of those I clicked on the plus button to create another class and set the class bands as below
· <= 0.2
· 15
· inf
Then I made the <= 2.0 and inf classes transparent. This made a clearer map with this data.
[image: images/elevation/SlopeResultSymbolised.png]
The slope raster, showing the settings in the Layer Styling panel and how the layer looks on the map and in the Layers Panel. The areas of the map with a slope of 15 degrees or less are shown in brown.
[image: images/svg/create-black-24dp.png] Checking the slope layer
Zoom in to your map and check that the slope layer is correctly classified. The areas with the densest contour lines should be clear and the areas where contours are further apart should be shown in the slope raster colour.
If it doesn’t look right, can you alter the classes so that it does?
[bookmark: aspect]Aspect
The Aspect tool works in a very similar way to slope, but this time you’ll finish with a raster coloured according to the direction that the slope faces - from north, round 360 degrees back to north. Remember that you are particularly looking for south-facing slopes.
[image: images/svg/videocam-black-24dp.png] Hillshade, slope and aspect in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Raster > Analysis > Aspect...
· Fill in the Input layer, being very careful not to select the slope or hillshade rather than the dtm!
· As usual for output, browse to where you want to save the output, then give it a name which will remind you what the layer shows.
[image: images/elevation/AspectForm_small.png]
Filling in the form to generate an aspect raster from the dtm.
Again, the result will look rather strange, but have a closer look at it.
· North = zero degrees on the compass and is coloured black
· Then there is a colour gradient clockwise around the compass points, to end up with white at 360 degrees.
[image: images/elevation/AspectResult_small.png]
Part of the aspect raster covering the Lake District.
[image: images/svg/create-black-24dp.png] Reclassifying the aspect raster
Have a look at the result and have a go at styling it by reclassifying the raster so that only the slopes that face generally south are coloured. Leave all the others transparent. This is similar to how you styled the slope layer, but start by working out how many classes you’ll need.
You don’t need to be too exact, but you could assume that suitable slopes are those between 160 and 200 degrees.
If you set transparency for both the slope and aspect layers, you should be able to zoom in and see where the layers overlap, hence showing areas with the correct aspect which aren’t too steep for field work. Maybe the area around the Blencathra Field Centre looks promising.
[bookmark: adding-xy-point-data-to-a-map][bookmark: _Toc160015497]Adding xy point data to a map
For the next set of exercises it will be useful to have a layer showing the hill summits in the Lake District. In the data preparation section you should have downloaded an xlsx (Excel) file containing a list of summits of British and Irish hills. This spreadsheet file is a form of xyz file in that for each record it includes x and y location data in the form of eastings and northings of the British National Grid. This means it can be imported into QGIS and mapped.
Start by opening the unzipped .xlsx file of the Database of British and Irish Hills in a spreadsheet program such as Excel, LibreOffice or OpenOffice Calc, Google Sheets or Pages. You’ll probably need to import it.
To be able to use this data in QGIS you will need to make some minor changes.
· If you want to save processing time you can delete a lot of the columns as you’ll only need a few of them. If you do this, make sure that you keep the following:
· Number
· Name
· Metres
· Xcoord
· Ycoord
· The column headings need to be short - 8 characters or less - and to have no punctuation or spaces. If you have deleted all except the columns above this isn’t a problem, but if you still have fields such as Parent (SMC) or Section name you’ll need to rename them.
Now Save or Export the spreadsheet file in your folder (the command will depend on the app you are using). I usually make sure I give the resulting file a new name so that I can go back to the original if necessary.
[bookmark: installing-a-qgis-plugin]Installing a QGIS plugin
One of the strengths of QGIS is that it has a wide variety of plugins that you can install to carry out extra tasks. It’s worth having a look at the list of plugins available to you in the plugin manager.
[image: images/svg/videocam-black-24dp.png] Installing plugins in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar go to Plugins > Manage And Install Plugins...
· When it opens click on the Installed heading on the left to see the plugins that are already installed.
· If you click on a plugin you’ll be able to see a bit about it in the panel on the right.
[image: images/elevation/PluginsInstalled_small.png]
The plugin manager showing the core plugins that are installed when you install QGIS. Your list will probably be different to mine.
To install a new plugin:
· Click on Not installed on the left
· Type Spreadsheet into the search box at the top
· From the list that appears click on Spreadsheet Layers and have a look at the description
· This plugin will do what you want it to do so click on Install Plugin
[image: images/elevation/PluginsSpreadsheetLayers_small.png]
Installing the Spreadsheet Layers plugin.
Once it has installed you should get a message at the top telling you it has been successful, and Spreadsheet Layers should now be in the list of Installed plugins.
· You can Close the plugin manager now.
· If you can’t see the Manage Layers toolbar (see image below) make it visible by going to View > Toolbars and putting a tick in the box next to Manage Layers toolbar. It will probably open vertically to the left of your Layers and Browser panels.
· You should gain a new button in the Manage Layers toolbar - hover over it to see the tooltip which should say “Add spreadsheet layer”.
[image: images/elevation/ManageLayersToolbarSpreadsheet_small.png]
The Manage Layers toolbar showing the new button for Add spreadsheet layer.
[bookmark: X90f473806197d5ea17c95e3892b847806adc086]Converting a spreadsheet to a feature class
Before you can use the data from a spreadsheet file (e.g. csv or excel) in QGIS you need to import it then save it as a feature class.
If you add the file to QGIS as it is, you won’t be able to view it on a map. Though you can see the grid references, these currently don’t mean anything to QGIS. To be able to view the data on a map you need to convert the table to a feature class. As part of this process you’ll be telling QGIS where to find the grid reference of each point so that it can place it on the map.
· If your Lake District map isn’t already open in QGIS, open it now.
· Tidy up your layers by removing the slope and aspect layers that you created in the previous section. We won’t be using those again.
[image: images/svg/videocam-black-24dp.png] Importing points from csv or spreadsheet to QGIS with the Spreadsheet Layers plugin
This video clip can be found in the module area of Minerva or in the full list of video clips.
To convert the spreadsheet so that you can use it in QGIS:
· Click on the Add spreadsheet layer button to open the dialog. Start filling it in by browsing for your spreadsheet file using the button to the right of File Name.
· Check that Sheet is set to the spreadsheet which holds the hill data - in this case hills, but in different versions of the spreadsheet it might be something like DoBIH_v17_5.
· Type a new name for your output layer next to Layer name, e.g. Hills. It needs to be something which will tell you what the layer shows so that you can remember later.
· Make sure that there is a tick in the box next to Geometry and select the x and y fields as appropriate - in this case x = Xcoord and y = Ycoord.
· Set the Reference system to the correct CRS. This time it will be the same as the current project - EPSG:27700 - OSGB36 / British National Grid.
· Check the data types in the preview pane. You shouldn’t need to change any of these this time.
· Check that the table previewed below the form looks correct - the data should look the same as it did in the spreadsheet you are importing. Particularly check the column headings. If they appear as anything like “field01”, “field02” etc, then tick the boxk for Header at first line, just under the layer name further up the dialog. If the column headings appear as “Number”, “Name”, “Metres” etc, then you’re fine - don’t tick the box! This appears to vary for no apparent reason.
· Then click OK.
[image: images/elevation/CreateLayerFromSpreadsheet_small.png]
Creating a layer from a spreadsheet.
Lots of points should appear on your map. If you Zoom to layer you should be able to see that these cover the whole of the UK, plus a few outliers to the north.
So far these points will have been saved as a virtual format file with an extension of .vrt, not in a proper GIS format so we’ll need to export the data to a geopackage.
[image: images/svg/info-black-24dp.png] Checking the file format
You can check the format either by going to the layer properties, or by hovering your cursor over the layer in the Layers panel. You should be able to see the .vrt extension at the end of the file name.
We are only interested in summits within the Lake District National Park, so it makes sense to limit our analysis accordingly as this will save time and storage. To save time and effort, it is possible to do this in the same operation as exporting the points to a GIS format.
[bookmark: selecting-data-in-the-attribute-table]Selecting data in the attribute table
We’ll need to start by selecting the points that we wish to keep, but we need another layer to be able to select the correct area for our analysis.
· You should have downloaded a GeoPackage containing the boundaries of National Parks in England from the Natural England web page.
· Add the National_Parks__England___Natural_England layer to your map from the GeoPackage, and zoom to layer.
This layer contains polygons for all UK National Parks so it will be a good idea to extract the Lake District National Park, which is the area we want to look at, and remove the rest from the map. It will save confusion later.
· Start by clearing any previous selections just in case - on the tool bar Deselect Features from all Layers
· Right-click on the layer containing the National Parks in the Layers panel and open the Attribute Table
· In the attribute table click on the little grey box on the left-hand side of the row for the LAKE DISTRICT to select it
· The Lake District National Park polygon should be picked out in the attribute table and, if you move the attribute table out of the way, also on the map.
· Close the attribute table - the polygon on the map should stay selected
[image: images/elevation/SelectingLakeDistrict_small.png]
Selecting the Lake District polygon in the attribute table - note how it is highlighted on the map too.
[bookmark: X70cdc5dbdc38b761dee0615cb65574daa701504]Saving a selection to a new feature class
Now that you have the Lake District selected you can export it to a new feature class.
· Right-click on the layer that contains the selected features - the National parks layer in this case
· Export > Save selected features as...
· Set the Format to GeoPackage
· Next to File name, click on the ellipsis button to browse to where you want to save your data then give the new geopackage a name, such as LakeDistrict for the area you are working in.
· Next to Layer name give your new layer a name that will tell you what that data is
· Check the CRS is British National Grid
· Check that Save only selected features is ticked
· Check that Add saved file to map is ticked
· Then click OK
[image: images/elevation/SaveVectorLayerAs_small.png]
Saving the selected features to a new feature class in a geopackage.
You should get a new feature class added to your map and Layers panel which only contains the polygon for the Lake District National Park. You can remove the original National Parks layer from the Layers panel now.
· Zoom to layer on the Lake District National Park
· Style the layer so that the national park has a visible outline, but no fill.
[bookmark: select-by-location]Select by location
Now you are set up to be able to restrict the summit points to only those within the Lake District National Park.
To restrict the points you need to use Select by Location as you did in the introductory chapter.
[image: images/svg/videocam-black-24dp.png] Select by Location in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start by making sure you’ve cleared any previous selections - on the tool bar Deselect Features from all Layers
· Either click on Select by Location on the toolbar, or go to Vector > Research Tools > Select by Location.
· Drop down Select features from and select your Hill summits features
· For Where the features check that intersect is ticked
· By comparing to the features from should be the feature class containing the Lake District National Park.
· Set Modify current selection by to creating new selection
· Click on Run then Close when it’s finished.
[image: images/elevation/SelectByLocationSummits_small.png]
Using Select by Location to select summits within the Lake District National Park.
The tool should run and select just those points within the feature that you used as input. If you look at your map you should be able to see that the points within the Lake District National Park are highlighted (in yellow usually) and those outwith are not.
[image: images/elevation/SelectByLocationSummitsSelected_small.png]
Summits within the National Park are yellow, showing that they are selected. Summits outside of the National Park are the default layer colour, showing that they aren’t selected.
We now need to turn these selected features into a feature class, as at the moment it is only a temporary selection.
· Right-click on your hill summits layer in the Layers panel
· Export > Save selected features as...
· Save your features as a new layer within the geopackage that you created when saving the National Park outline.
· Remove the summits layer that covers the whole of the UK - keeping your Layers panel tidy will save confusion later.
[bookmark: the-lake-district-map-so-far][bookmark: _Toc160015498]The Lake District map so far
At this stage you should have a map open in QGIS showing the outline of the Lake District and within that the points showing the summits. You may also have a background layer.
[image: images/elevation/InterimMap01_small.png]
The map showing an outline of the Lake District National Park and all the hill summits within it. Your colours will probably be different to the ones shown here.
You should be realising by now that a lot of work in GIS is preparation of the data rather than actual analysis. This is something you need to remember when you are doing your own projects in the future!
[image: images/svg/create-black-24dp.png] Save your map
Save your map at this stage. You’ll need it and the data that you have prepared for the exercises in the next chapter.
[bookmark: Xd7371094be6da814dac4b79845817c0887cbe18][bookmark: _Toc160015499]Further information and suggested reading for elevation
Many of the books in the reading list[footnoteRef:16] have general information about elevation data. Suggestions include the following: [16:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Chapter 3, Spatial data modelling in Heywood, I., Cornelius, S. and Carver, S. (2011), pp.89-95 covers the background to modelling surfaces, which includes dtm.
For technical information that refers specifically to QGIS try the following:
· The QGIS Documentation has a chapter on Working with Raster Data which should help you with some of the techniques that have been covered in this chapter.
· QGIS Tutorials and Tips - this is a series of tutorials which cover some of the techniques you’ve been using in these exercises. It’s worth browsing the list, but particularly relevant to this chapter would be Raster Mosaicing and Clipping. Not all the tutorials refer to the current version of QGIS, so do keep an eye on that.
[bookmark: elevation-models-2-analysing-terrains][bookmark: _Toc160015500]Elevation models 2: Analysing terrains
Last Modified: 17 Jan 24, 16:57:25
The background to elevation models and terrain analysis will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-5][bookmark: _Toc160015501]Learning outcomes
When you have completed this section of the workbook you should be able to 
· describe and identify raster formats of height data used in GIS and show an awareness of vector formats
· convert downloaded height data to an appropriate format to use in GIS
· use raster models to analyse surfaces
· describe appropriate applications of height data in environmental projects
[bookmark: introduction-4][bookmark: _Toc160015502]Introduction
In the previous chapter you prepared DTM height data to use for terrain analysis, looked at the properties of that data, and used it to generate some simple derived layers for slope and aspect. In this chapter we’ll go further and look in more detail at how you can use height data in analysis within GIS.
[bookmark: data-to-prepare][bookmark: _Toc160015503]Data to prepare
You should have all the data that you prepared in the previous chapter already in a map in QGIS.
· If you don’t have your map of the Lake District open in QGIS already, open it now.
[bookmark: restricting-processing-extent][bookmark: _Toc160015504]Restricting processing extent
We did a lot of data preparation in the previous chapter, but before we start running more complex analysis it would be good to do one further bit of preparation.
When doing analysis in GIS it makes sense to limit the size of the area on which those analyses will take place. If you are working with a very large dataset this can make an enormous difference to the amount of time and computer processing power that you need. For example, you may have a dataset covering the whole of the Atlantic, but actually only need to analyse data for a small area to the west of the U.K.
In some cases not limiting the processing extent can actually lead to incorrect results, for example if you are trying to work out the total area or percentage area of a particular outcome.
There are two main ways to restrict the processing area for data in QGIS.
· The first is to clip your original data to the area that you actually need to use.
· The second is to restrict the extent within the tools that you are running. Many of the tools in QGIS allow you to do this, but not all, so we’ll look at the first method here.
[image: images/svg/info-black-24dp.png] Defining extent
In GIS terms, “extent” refers to the maximum area covered by your data. It could also be called a “bounding box”. The extent of your data will always be a rectangle or square.
[bookmark: clipping-the-dtm-to-the-study-area]Clipping the DTM to the study area
To clip the DTM to the study area you need a vector polygon layer which covers the extent that you wish to analyse.
In some projects you may need to create this by setting up a new feature class and digitising the outline of your study area.
In this project you already have a vector polygon layer which will restrict the extent correctly.
[image: images/svg/help_outline-black-24dp.png] Restricting extent
Which layer in your map is a polygon layer which covers the area you will need to analyse for the Lake District?
Hopefully you realised that it is the layer which contains the outline of the Lake District National Park.
Set your Layers panel so that the following layers are visible and all the rest are invisible.
· Lake District National Park outline
· Terrain 50 merged DTM
You should be able to see that the DTM has a larger extent than the National Park. Note, you’ll probably have downloaded a slightly different area to me for the DTM, that doesn’t matter as long as you have at least the extent of the National Park.
[image: images/elevation/ExtentOfDTM_small.png]
A comparison of the extent of the DTM and National Park. The DTM covers a much larger area.
For our purposes the extent of the DTM should be the same as the National Park so let’s clip it.
[image: images/svg/videocam-black-24dp.png] Clipping a raster to a vector extent in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· On the menu bar go to Raster > Extraction > Clip raster by extent...
· The Input layer is the Terrain 50 DTM layer
· For Clipping extent click on the small black down arrow at the end of the line and select Calculate from Layer then select your Lake District National Park layer.
· Set the nodata value to output bands to -9999
· Under Clipped (extent) browse to where you want to save the output and give it a name that will help you to remember what it is. For example, I usually add _clipped to the end of the existing name.
· Click on Run then Close
[image: images/elevation/ClipRasterByExtent_small.png]
Filling in the form to clip the dtm to the same extent as the outline of the Lake District National Park.
The output should be a new DTM layer which only covers the area of the Lake District National Park. Note that it won’t be the same shape as the vector outline, rasters are always rectangular, but the extent should be the same as the extremities of the outline.
[image: images/elevation/ExtentOfClippedDTM_small.png]
The extent of the clipped DTM - the greyscale layer - compared to the original DTM which is coloured.
Tidy up your map by removing the original DTM and hillshade layers. Move the new DTM to the lowest position in the Layers panel and make it invisible. You don’t need it to be visible to use it for analysis.
If you like, you can create a hillshade layer and create a colour relief map in the same way as you did for the whole dtm. You don’t need the layer visible for analysis, but you may want to use it as a background for the display of your final data.
Make sure that the following layers are visible on your map:
· Lake District hill summits
· Lake District outline
· Background map - Raster 50k.
[bookmark: viewshed-analysis][bookmark: _Toc160015505]Viewshed analysis
Julia Bradbury [footnoteRef:17] is out and about with her copy of Wainwrights Pictorial Guide to the Lakeland Fells and has reached the top of Blencathra. She’s trying to work out how many other Lake District summits it is possible to see from the summit of Blencathra. If only she’d asked you! [17:  If you’re not sure who Julia Bradbury is, have a look at the Julia Bradbury Walks page on The Outdoor Guide. You can find several walks in the Lake District there.] 

Using viewshed analysis in a GIS, it is possible to work out which places are visible from any particular point without having to climb the hill yourself.
Let’s work out which summits are visible from Blencathra - Hallsfell Top. You’ve already loaded the height and summit data that you need to do this.
[bookmark: finding-the-observer-point]Finding the observer point
The first thing you need to do is find the point for Hallsfell Top on your map. You will need the 1:50 000 raster layer visible as your background map for this section. I suggested this background layer because it is detailed and has all the information you’ll need.
Alternatively use the labelling tools to label the summits layer so that you can see which one is which.
Back in the first chapter you used Type to locate to search a vector layer. You can do the same here to search the list of Lake District hills.
· Type af Hallsfell Top in the Type to Locate box at the bottom left of the map window.
· You should find Blencathra - Hallsfell Top from the Lake District Summits layer as the result. Double-click on it to automatically zoom and pan to it on your map.
[bookmark: running-the-viewshed-tool]Running the viewshed tool
Now that you know the location of the observer point you can run the analysis. The tool to work out which areas are visible from a particular point is called the Viewshed tool.
[image: images/svg/videocam-black-24dp.png] Viewshed analysis in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar click on Processing > Toolbox to open the toolbox. You’ll get a list of the tools available to you.
· In the Search box at the top search for viewshed. This should take you to a choice of two.
· Under GRASS > Raster, double-click on r.viewshed to open the dialog.
[image: images/elevation/ToolboxRViewshed_small.png]
Selecting the GRASS r.viewshed tool in the Processing toolbox.
[image: images/svg/warning-black-24dp.png] Warning
If you find that you can’t run the GRASS tools then it may mean that for some reason you don’t have GRASS processing enabled. I’ve found that the GDAL version of the viewshed tool doesn’t work as well as the GRASS version, so don’t use that instead.
Start by checking whether the Processing library is enabled.
Go to Plugins > Manage and install plugins.... In the list of installed plugins check that Processing and GRASS GIS provider are both ticked. Note, this is different to GRASS 7 - if you have that in your list, leave it unticked, it will just confuse you!
Now close the plugin manager and try the GRASS tools again. If they still don’t work, try closing QGIS and opening it again. So far ticking the plugins has worked for everyone. If you find it doesn’t, please get in touch with me as soon as possible.
Once you have the r.viewshed tool open:
· Fill in the form for the tool
· Set Elevation to your clipped DTM layer
· To set the Coordinate identifying the viewing position click on the three dots button at the end of the line, the dialog will disappear, giving you the chance to click on the dot for Hallsfell Top on your map. When the dialog reappears it will have the coordinates for the location that you clicked. If you are on a Mac computer, you may find this doesn’t work. It is also possible to type coordinates into the box. Hover over the location on the map to see the coordinates at the bottom of the QGIS map window.
· Set the Viewing elevation above the ground to the average height of a person, e.g. 1.75 - this will be in map units which in maps projected to British National Grid are metres.
· Note that it is also possible to set the height of the target, but that isn’t necessary in this case.
· Most other settings can be set as the defaults, but you do need to drop down Advanced Parameters and put a tick in the box next to Output format is invisible = 0, visible = 1
· It’s also a good idea to fill in the extent and cellsize. Set GRASS GIS 7 region extent by clicking on the down arrow to the right of the button next to the field and selecting Calculate from Layer and your input DTM.
· Set the GRASS GIS 7 region cellsize to the same cellsize or pixel size as your input DTM - remember you can check this in the layer properties. In this case we’re using Terrain 50 data which has a cellsize of 50, so put 50 in the box.
· Then to the right of the Intervisibility box at the bottom, click to Save to file... and browse to where you want to save the output and give it a name which will help you remember what the layer shows, e.g. vshHallsfell for viewshed from Hallsfell Top.
· Click Run, then Close when it finishes. It could take a while.
[image: images/elevation/ViewshedForm_small.png]
Filling in the viewshed tool for Hallsfell Top.
[image: images/svg/warning-black-24dp.png] Warning
In the instructions above I’ve kept it relatively simple, but you may have problems running this tool. If you do there are a couple of extra suggestions here.
Make sure that when you enter the DTM into the Elevation box, the CRS is given in the square brackets after the name. If not, you need to either assign the CRS or Warp (Reproject) the DTM before you use it in the tool. Refer back to the CRS chapter if you can’t remember how to do this.
Double-check that the Project CRS and the dtm layer CRS are the same. If they aren’t you’ll probably get an error message telling you that the viewpoint is outside of the layer extent.
Try closing QGIS and opening it again - it’s surprising how often this helps!
If these suggestions don’t help, and it isn’t a problem with where you save your files, then it may be a case of reinstalling QGIS and seeing whether a new version makes a difference.
Once the viewshed has been added to your map, zoom to layer on it, then open the Layer Styling panel and click on the Classify button. For some reason, this cleans up the number of values as you’ll probably find you have lots…
Your map should show a layer with two colours, probably different colours to those shown below (make sure it’s above the background map in your Layers panel if you can’t see it). If you look at the layers panel and think back to the Output format tick box in the parameters, you should see that there are two values
· 0 = not visible from the observer point
· 1 = visible from the observer point.
[image: images/elevation/ViewshedResult_small.png]
The result of running the viewshed tool. Note the values shown in the Layers panel.
In addition use the Identify Features tool to have a look at the differently coloured areas in this layer.
[bookmark: return-to-the-original-question]Return to the original question
If you go back the start of this section, you can see that the original question asked “how many summits is it possible to see from the summit of Blencathra?”
This is a good time to break down exactly what we are trying to do so that you can see what steps you need to carry out.
At the moment you have points in a vector file showing all the summits in the Lake District, and a raster file with two different symbols showing which areas are and are not visible from Hallsfell Top. You somehow need to put the two together and work out which of the points are in the area which is visible.
Probably the simplest way to do this, is the following:
1. Convert the raster file to vector polygons.
1. Select and delete from the vector polygons all those for areas which are not visible.
1. Use Intersection to select all the summit points which intersect with the visible areas and output them as a new layer.
You’ve already used tools which will do most of the above steps.
[bookmark: saving-output-to-temporary-files]Saving output to temporary files
You’ll see from that list that you could end up generating lots of files and taking up lots of disk space. These processing outputs are relatively small, it can be possible to generate output of several gigabytes if you are processing lots of data for a larger area.
When you are running a series of processes, you don’t necessarily need to keep the output from all of them. Some are only needed to run the next tool in the sequence. In these cases you can select [Save to temporary file] as the output.
Remember though, that if you close your project these temporary layers will disappear. If you want to save them you can right-click and use the usual Export dialog to save them to disk.
We’ll save the output of some of the tools in that list as temporary. When you’ve finished processing the data you want to end up with the following layers, the rest don’t need to be kept:
· A vector layer showing the areas which are visible
· A second vector layer showing points for the summits which are visible
[bookmark: X42770c7663aa0d823ff88debdd672a065c8ace3]Convert the raster file to vector polygons
As you are probably starting to realise by now, there are tools in QGIS to do virtually everything you are likely want to do with your data. Usually the problem is making sure that you can find the right one.
· Start by opening the Processing toolbox, if it isn’t already open.
· Search for raster to vector
[image: images/svg/help_outline-black-24dp.png] Finding the right tool
In the list of results which tool looks as if it will do what you want it to do? i.e. convert a raster layer to vector polygons?
Once you’ve had a look at the possibilities hopefully you picked out Polygonize (raster to vector) from the GDAL > Raster conversion list.
· Double-click to open the Polygonize tool
· Fill in your raster viewshed layer (the output of the last processing task) as the Input layer
· The other settings are fine as the defaults
· Under Vectorized leave the output as [Save to temporary file] so as to save storage space - see above.
· Click on Run, then when it finishes (which could take a while) click Close
[image: images/elevation/PolygonizeForm_small.png]
Converting a raster layer to vector polygons with the Polygonize tool.
The output will probably look even less informative than the raster layer did, but this is actually more useful for our purposes.
[image: images/elevation/PolygonizeResult_small.png]
The resulting vector output from the Polygonize tool.
Have a look at the layer in the Layers panel. Because you chose to save this as a temporary file there is an extra symbol next to it in the list to show this. I always think that it looks a bit like a square spider.
[image: images/elevation/TemporaryLayer_small.png]
A temporary layer with the symbol showing that it is temporary.
[bookmark: Xfec3cb1b2d8be8c6ce197b2e3391d4dbed15304]Extracting vector features with Extract by Expression
Now we have the features in a vector feature class we can get rid of the invisible areas by deleting them.
[image: images/svg/help_outline-black-24dp.png] Which attribute shows whether an area is visible or invisible?
Open the attribute table for your new vector layer and have a look at it.
Bearing in mind the values from your raster viewshed which field holds the information about whether a feature is visible or invisible? Refer back to the classes for the raster viewshed layer if you need to.
You should find that you have a column which is made up of values of either 0 or 1. This matches the values in the original raster - remember that the value 1 indicated an area that was visible from Hallsfell Top. Make a note of the name of that column, or field.
We can use the Extract by expression tool to select the features that we want to keep and save them as a new feature class.
[image: images/svg/videocam-black-24dp.png] Extract by Expression with the toolbox in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Search for Extract by expression in the Processing Toolbox and double-click to open it.
· The Input layer should be your newly vectorized viewshed
· Click on the button at the end of the Expression field - the button has a fancy “E” on it which indicates “Expression”.
· In the form that opens use the centre panel to go to Fields and Values and double-click on the name of the field that you made a note of above (hopefully DN).
· We want this field to match the value for visible area, so click on the = button below the left-hand panel or type = into the left-hand panel after the name of the field.
· Then click on the All Unique button on the right to get all the Unique values in that field.
· The result of clicking on the All Unique button should be a choice of 1 or 0. Remember that 1 shows the areas which are visible and those are the values that you want to keep, so double-click on 1
The panel to the left should now show the expression
"DN" = 1
[image: images/elevation/ExtractByExpression_small.png]
Extracting visible areas by expression.
· Click OK to return to the Extract by Expression tool
· We want to extract the Matching features, i.e. the visible areas, but this can be a temporary layer as we don’t need to keep this so the Matching features can be left as [Save to temporary file]
· We don’t want the Non-matching, so leave that as [Skip output].
· Check that Open output file after running algorithm is selected
· Click on Run and wait for it to finish, then click on Close.
[image: images/elevation/ExtractByExpressionForm_small.png]
Filling in the form to extract the visible areas from the Hallsfell Top vectorized geopackage layer.
The new layer should be added to your map. You should find that only the visible areas now have a polygon to cover them.
[image: images/elevation/OnlyVisible_small.png]
Now only the visible areas have a polygon in the feature class and showing on the map.
[bookmark: fix-geometries]Fix geometries
When putting together these exercises I found that the process above left me with a polygon feature class which created an invalid geometry error when I used it in other tools.
That is easily fixed by running the Fix Geometries tool.
You’ve filled in lots of these tool forms now, so I’m going to start giving less detailed instructions as you should be getting the general idea.
· In the toolbox search for Fix Geometries
· You should find the tool under the Vector geometry heading.
· Double-click to open the tool and fill in the Input layer
· The output layer is under Fixed Geometries. This is one of the layers we want to save to disk so give it a name and browse to the location you want to save it. You should be able to save this to a preexisting geopackage if you want to, but use a new one if you’d rather.
Run the tool, and when the new layer appears on your map, remove the two temporary layers from the layers panel. You can also remove the original raster viewshed layer.
[bookmark: intersection]Intersection
Finally we can create a feature class which only contains those summits which intersect with the visible areas.
You’ve done this before using Select by Location but it is also possible to use the Intersection tool, and we’ll try that here.
· In the toolbox search for Intersection - you should find it under Vector Overlay
· The input will be your Lake District summits layer
· The Overlay layer will be the fixed viewshed polygon layer
· The output is the Intersection box and you can save it to an existing geopackage. Note it is important to keep track of which summit this is the results for as you’ll be doing it for more summits.
[image: images/elevation/IntersectionForm_small.png]
Filling in the form to intersect the summits with the viewshed.
Run the tool then close it and have a look at the output.
Hopefully you can see that the new feature class only contains some of the summit points, but those are the ones that are within the area that is visible from the summit of Hallsfell Top on Blencathra.
[bookmark: so-how-many-summits-are-visible]So how many summits are visible?
The simplest way to get the total is to make use of the Layers panel.
· Right-click on the new summits layer in the Layers panel
· Select Show Feature Count
The number of features in the feature class should appear in brackets after the layer name in the Layers panel.
Note that your result may not be the same as mine. In fact, I ran this process several times when writing these exercises and came up with a slightly different result each time. As long as it is close to this number, so somewhere around 339, then that is fine.
[image: images/elevation/NumberOfSummits_small.png]
Viewing the number of features in a layer in the Layers panel. This shows that 339 Lake District summits are visible from the summit of Hallsfell Top.
[bookmark: X790eb0b22d6c2f1cfa3bf69a6714861b82f5918][bookmark: _Toc160015506]Batch processing and iterating over a layer
This section is optional. If you are short of time you don’t need to work through it now. You could come back to it later, or even miss it out completely.
If you don’t want to work through it now, continue straight on to the next section, Labelling the viewpoints.
You could find batch processing or iterating over a layer useful for the second assessment, but can complete it successfully without.
You’ve successfully worked out how many summits are visible from the top of a single location, but what if you needed to work out the total for another set of locations?
You could go through the full process multiple times, but it would be better if there was some way you could use the GIS to repeat the process.
In a future chapter we’ll be looking at models. These are a way of using a graphical user interface to build a python script to do repetitive processes. If you are good with python scripting you can also do this directly, but that doesn’t come under the scope of this module.
[bookmark: batch-processing]Batch processing
In this section we’ll have a look at how you can use tools with batch processes when you are trying to answer the same question multiple times.
[image: images/svg/create-black-24dp.png] Batch processing viewsheds
The task is to work out from which of the following summits is it possible to see the most other summits?
Helvellyn
Catbells
Great Gable
Blencathra - Hallsfell Top
You’ve already worked out the total for Hallsfell Top so don’t need to do that one again.
The tools that you need to run for each location are:
1. The viewshed tool
1. Polygonize (raster to vector)
1. Extract by expression
1. Fix geometries
1. Intersection
Use the links in the list above to refer back to the previous sections for detailed instructions for each tool.
Note that if you look at the top of the Processing Toolbox and clear any previous searches, the Recently used section will show the tools that you have used most recently.
[image: images/svg/warning-black-24dp.png] Warning
Unfortunately, the batch processing mode doesn’t usually let you save output as a temporary layer, so you will end up with lots of output files. Remove any you no longer need from the Layers panel to keep it tidy as you go along, otherwise it can become very confusing.
[bookmark: X39120e3caad50a4a03bb84b94439dcee2231df7]Using the viewshed tool in batch processing
[image: images/svg/videocam-black-24dp.png] Batch Processing in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Start with the viewshed tool.
· Once you’ve opened the tool go to the bottom left and click on Run as Batch Process
A different form will open. It will be worth enlarging the dialog horizontally as this contains the same boxes, but across the page rather than down.
· You are going to be running this tool three times, so click on the plus button twice to add two more rows (there is already one blank row there)
· in the first row under Elevation (actually with the number 2 next to it) dropdown the box and select your clipped DTM layer.
· Now click on Autofill... above that and select Fill down. All the fields below should be filled in with the same choice.
· In the first row of the Coordinate identifying the viewing position... click on the three dots button to be taken to your map so that you can click on the point for Helvellyn. Repeat this for Catbells and Great Gable, remembering you can use the Type to Locate box to find them. Remember also, if you can’t click on the map, you can still type in the coordinates.
· The Viewing elevation above the ground column can be filled in using the Autofill > Fill down again, if it isn’t already correct
· One field that is missing from the form is the one for Output form is invisible = 0, visible =1. You can find this by clicking on the cog wheel button to the left of the Batch Processing menu bar. Then set this to Yes for all rows.
· Finally fill in the details of your output in the Intervisibility column if you want to save it.
· Put a tick in the Load Layers on Completion box at the bottom left
· Now click on Run.
[image: images/elevation/BatchProcessingPartForm_small.png]
Filling in the Batch Processing dialog to generate a viewshed for three observer points.
If you don’t Close the dialog until you have checked the output you can go back to the form by clicking on the Parameters tab and make any changes without having to fill in the whole form again. Just move the form out of the way to have a look at the layers on your map.
Check the new layers, and if you’re happy with them Close the batch processing form.
I’ve only suggested you run this for three extra datasets here to give you an idea of how batch processing works without it taking you too long. The real economy of scale will start to show if you are processing a lot more points.
[image: images/svg/create-black-24dp.png] Continuing with batch processing
Continue with the list of tools that need to be run. Use each in batch processing mode and see how you get on.
Investigate some of the options under Autofill and see whether any of those help you to streamline the process.
For example, if you need to add a different input file for each line of the batch processing you can Select Files... or Add all files from a directory.
[bookmark: iterating-over-a-layer]Iterating over a layer
Instead of batch processing, it can be possible to iterate over the features in a vector feature class. This is useful if you have, for example, a series of features as locations, and wish to create a separate output feature class for each.
As an example, add the full National Parks layer back onto your map from the original download. The layer should have a name like National_Parks__England____Natural_England.
We’ll use iteration to create a 10 km buffer for each of the ten National Parks, with each buffer being saved in a separate geopackage layer.
· Go to Vector > Geoprocessing tools... > Buffer to open the Buffer tool.
· Set the Input layer as the National Parks layer.
· On the right of the Input layer dropdown, click on the button with two green arrows in a circle. If you hover over it, you should see a tooltip saying Iterate over this layer, creating a separate output for every feature in the layer.
· Fill in the Distance as 10000 metres.
· Leave the Buffered field as [Create temporary layer] - we won’t need these layers again.
· Make sure Open output file after running algorithm is selected.
· Click Run.
[image: images/elevation/IterateBuffer_small.png]
Filling in the form to iterate through features, producing a separate buffer output for each one.
The log should tell you which iteration the tool is executing. There should be ten for the National Parks layer. Once it has iterated through each feature, it will add the new layers to your map.
· You can then Close the tool.
Your layers panel should contain ten temporary layers called “Buffered”. Each one will show a buffer for an individual National Park on your map.
If you had chosen to save these to file, you would have ten separate files in your folder.
This exercise has shown how to use iteration. In this case, you don’t need these layers for any further display or analysis, so remove them from your map.
[bookmark: labelling-the-viewpoints][bookmark: _Toc160015507]Labelling the viewpoints
You selected particular hills as viewpoints from which to generate your viewsheds. For the final map it would be helpful to be able to display those hills and label them so that your audience can see where they are in the Lake District.
[bookmark: selecting-the-viewpoints-to-label]Selecting the viewpoints to label
The first step is to create a new feature class containing just the viewpoints / hills that you want to label.
You can use Select by expression to select multiple points and then export the selection as a new feature class.
[image: images/elevation/SelectionToolbarAnno.png]
The selection toolbar.
· Select the Lake District Hills layer in the Layers panel.
· From the selection toolbar click on Select features by expression.
· In the dialog, use the expression form to construct the following expression in the left-hand box.
· In order to select the correct hill names, start by double clicking on Name in the Fields and Values then type IN and open brackets.
· Now search for the first hill name in the Values box on the right and double-click on the correct entry to add it to the statement on the left. By doing this you are ensuring that you are using the correct form of the name and the query is less likely to fail.
· Continue like this for each of the hills, adding a comma between each name, then finishing by closing the brackets.
"Name" IN ('Helvellyn`,'Blencathra - Hallsfell Top', 'Catbells', 'Great Gable')
[image: images/elevation/SelectByExpressionMultiple_small.png]
Selecting multiple features in a single statement.
· Once you have the statement in the left-hand window click on the Select Features button.
If you look at your map now the symbols for the four hills should be selected in bright yellow.
· Close the Select by Expression window.
· Now right-click on the Lake District Hills layer in the Layers panel and Export > Save Selected Features as...
· Save the layer as a new feature class in your geopackage and make sure it is added to your map.
· Style the points as you wish with the intructions below, using the tools in the Layer Styling panel.
[bookmark: labelling-points]Labelling points
[image: images/svg/videocam-black-24dp.png] Labelling features in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by having a look at the attribute table of your new feature class. You want to label your map with the names of the hills.
[image: images/svg/help_outline-black-24dp.png] Which field do you need to use to label your map?
Make a note of the name of the field which contains the information you want to use to label your map.
[image: images/elevation/LabelAttributeTable_small.png]
The attribute table showing the Name field which can be used to label the features on the map.
· Once you’ve made a note of the field, close the attribute table.
· Make sure that you’ve selected the new feature class in the Layers panel.
· Open the layer styling panel in the usual way (F7 on your keyboard, or using the button at the top of the Layers panel).
· Click on the Label tab on the left of the panel. Initially it will say No labels.
· Drop down where it says No labels and select Single labels.
At this stage QGIS usually just labels your features with the first field in the feature class, which isn’t usually the right one. Never just accept the defaults without checking!
· Now you need to select the correct field. Next to Value, drop down the choices and select the field that you made a note of above - it should be called Name.
Immediately the names should appear on your map next to the symbols.
[image: images/elevation/DefaultLabels_small.png]
The default labels once the correct field has been set, also showing the default settings.
The default fonts, colours and placements are not always what you want. Use the settings on the panel to change how your labels look and how they are placed around your points.
· The tab to the left of the row of tabs, Text, allows you to change the font, style, size and colour of the text.
· If your labels are too long and you want to wrap them onto two or more lines, go to the Formatting tab.
· Next to Wrap lines to enter a number, such as 20. This is the number of characters QGIS will allow one one line before wrapping the next word onto the line below.
· Click on the Placement tab to change how your labels are placed relative to the point symbols.
[image: images/elevation/LabelPlacement_small.png]
The label placement options.
· Try changing the Mode - what effect does that have on your labels?
· Try changing the Distance - does that help readability?
There are other tabs and options too, try them out with care and see what you can do with your labels. Don’t be too fancy. The aim is to make the data on your map clear to someone looking at it.
· The Halo tab can allow you to add a halo around the text. Use this effect with subtlety. It can become too overwhelming.
· Sometimes using a Background can be helpful.
[bookmark: the-final-viewshed-map-layout][bookmark: _Toc160015508]The final viewshed map layout
The final step of any analysis is to display your results. Try creating a layout which shows how many Lake District summits are visible from the four viewpoints. You’ve generated a lot of data for these exercises and if you try to put it all on a single map it would be rather a mess. You’ll find out more about adding multiple maps to a layout in the next chapter but just experiment for now. Don’t forget to include copyright information for both the data that you downloaded from Digimap, for the Database of British and Irish Hills (check their website for their requirements) and for any other data layers that you have used.
When you have created a layout, export it to either an image or pdf.
[image: images/elevation/ExampleLayout2_small.png]
Possible final layout for a map of the Lake District showing the viewpoints and the number of hills visible from them.
[bookmark: X81bdc3e45a3abf87cdccbffbfe2e05cd9c41d99][bookmark: _Toc160015509]Further information and suggested reading
The suggested reading at the end of the previous chapter is still relevant for this chapter.
In addition try the following technical information:
· The QGIS Documentation has a chapter on Working with Raster Data which should help you with some of the techniques that have been covered in this chapter.
· QGIS Tutorials and Tips tutorial on Batch Processing using Processing Framework
· For viewsheds have a look at Viewsheds and visibility analysis in QGIS.
[bookmark: layout-and-presentation][bookmark: _Toc160015510]Layout and presentation
Last Modified: 08 Jan 24, 17:13:47
The background to layout and presentation will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-6][bookmark: _Toc160015511]Learning outcomes
When you have completed this section of the workbook you should be able to
· Layout your maps in such a way that they effectively communicate the content and purpose of your work to a user
· Select relevant map elements to include in a layout and set their properties to match the requirements of your map
· print or export your map layout to show your work to it’s best advantage
[bookmark: introduction-to-layout-and-presentation][bookmark: _Toc160015512]Introduction to layout and presentation
Once you’ve put in all the hard work to produce a map of your field area or project, it is worth making the extra effort to ensure that you lay it out clearly and print or export it in a professional fashion. Make sure that you allow the time to do this. Care and patience can make the difference between a scruffy, unimpressive map that loses you marks, and a clear, professional map that gives a good first impression and causes your audience to take your work seriously.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Don’t underestimate the time that the final details can take and don’t leave this part of the preparation until the last hour before a deadline!
You won’t need to use all the elements and features outlined here for every map. Equally this is not an exhaustive list of possible elements. You should already have some idea of what elements are useful, and should be able to make a decision for each case based on your existing knowledge of maps. If you think that you need to add something that is not listed here, e.g. a report based on a table, then use the extra information available at the end of the chapter and search on-line to find out how to add it.
This chapter isn’t necessarily for working through in order. Make sure that you are aware of the contents and of what QGIS is able to do, and then make your own decisions about what you need to include based on the principles that will be covered in class.
Note that the examples in the images use a general map which isn’t the same as the one you will be working on. The techniques and the buttons in QGIS are still the same, though.
[bookmark: the-data-for-this-chapter][bookmark: _Toc160015513]The data for this chapter
You should use a map that you have been creating in previous chapters as instructed below [footnoteRef:18]. Try out all the techniques listed below and then decide which you need to include on this layout before you export it. [18:  If you no longer have a copy of the map that you have been instructed to use it doesn’t really matter. Either use a different map that you have created, or download the map from the week 1 class and use that instead. It isn’t the map itself that is important for these exercises, but having a layout with data on it so that you can try things out.] 

· Level 1 geologists use the Cononish map from the previous chapter.
· Level 2 and above geologists. You should be working on your own maps.
· Level 2 environment students use the Lake District map.
· Level 1 geophysicists continue working with the Llanbedr map.
[bookmark: creating-and-saving-layouts][bookmark: _Toc160015514]Creating and saving layouts
In QGIS a print layout allows you to control the format and scale at which you print and export your map, and to lay out additional elements to complete the final product.
[bookmark: creating-a-print-layout]Creating a print layout
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Creating a print layout in QGIS and adding a map view.
This video clip can be found in the module area of Minerva or in the full list of video clips.
To create a new print layout
· Open your map project in QGIS if it isn’t already open
· Add a print layout by going to Project > New Print Layout...
· You’ll be asked to Enter a unique print layout title - call it something that will tell you what this layout is intended for. For example, enter A3 for printing. You can leave this blank if you wish.
· Click OK
QGIS will open your new blank layout in a new window. It should look something like the image below - though your toolbars may be in different places.
[image: ../../shared/docs/images/layout/NewPrintLayout_anno.png]
Your new print layout showing a blank page.
In this view you will see your map laid out as it will be when it is finally printed or exported. You’ll see the page outlined on screen and, once you have started adding elements you will see the content as it will look on the page.
[bookmark: opening-existing-print-layouts]Opening existing print layouts
Once you have created a print layout you can close it and open it again without losing it.
· Close the window containing the print layout (Layout > Close)
· To reopen it go to Project > Layouts and select your layout from the list - there is only one there at the moment so click on that.
[bookmark: saving-layouts]Saving layouts
A layout is saved as part of the project so whenever you click on Save in your project it will save the layout too.
For now:
· Click on the Save button in the layout window.
· Or Layout > Save Project
[bookmark: adding-a-map-to-a-layout][bookmark: _Toc160015515]Adding a map to a layout
At the moment all you have is a blank page. To add a map to a layout:
· Click on the Add Map button on the Toolbox
· Or Add Item > Add Map
· Then use the mouse cursor to drag a box across the page. It doesn’t matter about the size at the moment you can change it later.
You should now be able to see a section of the map from your main project window. The Item Properties on the right will now give options for the map. You’ll explore these in more detail later.
[bookmark: size-and-scale-of-pages-and-maps][bookmark: _Toc160015516]Size and scale of pages and maps
The size of the page and of the map “window” will affect the scale and extent of the map. These are all linked so if you change one remember to check that your map is either still at the correct scale, or still covers the correct area.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Setting the size and scale of a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: page-size-and-orientation]Page size and orientation
The page that you see in the layout window shows how the page will look when you export or print your map. Remember to check the paper size and set it correctly before you spend time arranging your layout.
To change the paper size and orientation:
· Right-click somewhere on the “page” and go to Page Properties
The page properties should open in the Item Properties on the right.
· The Size setting allows you to choose from a wide range of standard sizes, e.g. A4, A3 etc.
· The Orientation setting allows you to choose between portrait and landscape orientation.
· You can also set the page measurements manually by changing the Width and Height in the boxes below.
· The page in the main view should change automatically when you change a setting.
[image: ../../shared/docs/images/layout/PaperProperties_small.png]
The page properties set to an A3 Portrait page.
[image: ../../shared/docs/images/svg/create-black-24dp.png] Changing paper size and orientation
Change your page size and orientation to A3 Landscape. This will give you more space to experiment with adding other elements to your page.
Once you have changed the paper size you may find that you can no longer see the whole page in the layout view. To zoom in or out use the buttons on the toolbar at the top. In particular use the Zoom full button.
[bookmark: setting-up-a-multi-page-layout]Setting up a multi-page layout
It is possible to create layouts with multiple pages in QGIS.
· On the menu bar go to Layout > Add pages...
· In the box which opens select the number of pages to create and whereabouts you want them to be added.
· Set the size and orientation of your new page(s)
· Then click on OK to add them to your layout.
[image: ../../shared/docs/images/layout/InsertPages_small.png]
Inserting two new pages at the end of the layout.
If you decide you don’t need any of the pages you can delete them:
· Right-click on the page you wish to delete and select Remove page.
[bookmark: resizing-the-map-in-a-layout]Resizing the map in a layout
When you first set up a layout the size of the map may not be the size that you want it to be eventually. Changing the size of the frame is easy, but can take a little experimentation. You will also need to look at this in conjunction with the instructions on changing paper size in the previous section.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Resizing the map frame in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Make sure that the map frame is selected in the layout by clicking on it.
· When the map frame is selected you should be able to see that there are small boxes at the corners and on each side.
[image: ../../shared/docs/images/layout/ResizeMapFrame_small.png]
Using the handles on each corner and side of a map to resize a map frame in a layout.
· Use the boxes as “handles” to resize the map frame by dragging them
· Keep an eye on the scale in the map Item Properties. If you need to make a map at a particular scale you may need to keep putting this back to the correct scale each time you resize the map.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
This process can take patience to get the map frame the correct size for the scale and area. There don’t appear to be any short cuts so just stick with it and keep repeating the process!
[bookmark: moving-the-map-within-a-map-frame]Moving the map within a map frame
If you need to move the map itself within the frame, e.g. so that you see a different part of it:
· Click on the Move Item Content button on the Toolbox
· You’ll be able to use the mouse cursor to move the map around within the frame.
· You’ll also be able to zoom in and out on the map.
· Remember to click back onto the Select/Move Item button to be able to select items again. It’s frustrating when you forget and find that you can’t move any elements around!
[bookmark: X8730cf8a6524b9d98d116c53860c742dcde1420]Controlling the map with the Item Properties
If the map is selected on the layout you will see its properties in the Item Properties panel on the right. You can use these to control various settings for the map. The ones you need to know now are:
· The most obvious is Scale. Use this box to type the scale that you want your map to print at.
· Extents is useful if you don’t need to worry about the scale but do need to show a map covering a particular area. You can type the east, south, west and north coordinates and the map frame will change accordingly.
· The Frame setting allows you to put an outline around the outside of your map. This can make the map look more professional.
[bookmark: adding-items-to-a-layout][bookmark: _Toc160015517]Adding items to a layout
The information below includes details on adding many different items to a layout. Not all these will be appropriate to every layout, but it is up to you to decide which items to use depending on the purpose and audience of your map and any guidelines specified for assessments or reports. Some of the references on the reading list, particularly Darkes and Spence (2017), should help you with this.
Remember that the QGIS Documentation will provide you with plenty of extra information on how to add items to a layout.
Most items are added to a layout in a similar way to each other using the buttons on the Toolbox. In most cases you’ll then be able to use the Item Properties to make changes to the item.
[bookmark: selecting-items-on-a-layout]Selecting items on a layout
There are a couple of ways of selecting items on a layout.
· Click the Select/Move Item button on the Toolbox then click on the item you wish to select
· Alternatively, use the Items panel. As you add more items to your map they will be added to this panel. All you need to do then is click on them in this list to select them on the map.
You can also use the items panel to lock items in place and make them invisible.
[image: ../../shared/docs/images/layout/ItemsPanel_small.png]
The Items panel showing that Map 1 is select and locked, while the attribute table frame is invisible.
Once an item is selected it will have the little “handles” visible for resizing.
[bookmark: a-legend-or-key]A legend or key
You will have added various data to your map, and it is necessary for you to explain to anyone looking at your map what those layers and symbols show. To do this you’ll need to add a legend or key. Note that this can be a relatively complex procedure and there are a lot of instructions in this section. It’s worth having a quick look at the whole section to get an overview before you start trying to add a legend.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a key or legend to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
Start by using the default options to create a legend. Once you have the basic legend it is possible to make alterations later.
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Save your map and take a backup copy of your project folder before you start doing this.
While it is usually fine, if you have a lot of big layers on your map QGIS can crash when you first add a key and you don’t want to lose the work you’ve already done.
There are ways to get around this problem with the legend crashing QGIS.
To add a legend / key:
· Click on the Add Legend button on the Toolbox
· Click on your layout in roughly the location that you want your legend to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a legend which includes all the items from all the layers on your map. This is likely to be rather a lot! The first thing to do is to remove any that you don’t need.
As usual, while the legend is selected, the Item Properties will show the specific properties for this element.
· In the Item Properties start by checking that the legend is referring to the correct map on your layout - use the dropdown box next to Map to select the correct one if you have more than one.
· You can give your legend / key a title if you wish, but note that this isn’t always necessary.
· Then move down to the Legend Items heading
· If you don’t want all your layers to appear then untick Auto update - you can always click on the Update All button later if you change symbols etc on your map.
· Now you can select layers and then click on the red minus button under the list to remove them.
· To only show elements which appear on your map tick next to Only show items inside linked map - this can be a great help to remove surplus symbols.
[image: ../../shared/docs/images/layout/LegendPropertiesLayers_small.png]
Setting the legend properties to control the layers and symbols on the key.
Once you have just the layers that you want on your key you can then use the rest of the properties to set fonts, backgrounds etc.
· It is possible to drag and drop the layers in the Items list and rearrange them.
· The Columns section allows you to split your legend into two or more columns.
· The Symbol section will let you change the size of symbol, or patch, on the legend - sometimes it is useful to be able to enlarge the “patch”.
· To change layer names in the legend without changing them on your map you can select the item in the list and click on the pencil icon below.
· Alternatively, you can change the names in the Layers panel in map view then click on the Refresh button in layout view to refresh the map and all associated items.
[bookmark: Xb4dd1fe69017047c9fc2336b4c4c212b8bc11a4]Changing the order of items within a categorized layer
If you have a layer styled by categories, the initial legend entries will usually be in alphabetical order starting from the top.
If you are creating a legend for a layer for which the order is important, for example, a geology bedrock layer where the younger rocks should be at the top and the older at the bottom, you will probably need to rearrange the legend entries.
There are two ways of doing this.
[bookmark: in-the-layer-styling-panel]In the Layer Styling panel:
· Open the Layer styling panel and check the correct layer is selected.
· In the categories list drag and drop each entry to change the order.
This also changes the order in which categories are drawn on the map, so you may also need to check that your map still appears correct.
[bookmark: in-the-layout-legend-options]In the Layout legend options
· Select the legend and untick Auto update under Legend Items, if it isn’t already unticked.
· Select one of the categories you want to move and use the blue up and down arrows below the list to move it up or down.
This method only changes the order in the legend and doesn’t affect the order in which your categories are drawn on the map.
[bookmark: changing-the-size-of-the-legend-patch]Changing the size of the legend patch
Sometimes the patches are too small to see clearly. This can be a particular problem for continuous colour ramps, but vector patches can be resized the same way.
To change the size of a legend patch:
· With Auto-update off…
· In the legend properties double-click on the layer to change or click on Edit selected item properties below the list of items.
· In this dialog you can also change the text next to the legend item.
· Use the Width and Height settings to make the patch larger - it should update automatically as you type numbers.
[image: ../../shared/docs/images/layout/LegendPatchSize_small.png]
Changing the size of a legend patch in the item properties.
[bookmark: Xb3c868005a093a7c1870c18dd4ba93878965cee]Creating a legend for a continuous raster
Version 3.20 and above of QGIS will automatically create a continuous patch. So if you are using version 3.20 or above you don’t need to worry about the rest of this section.
[image: ../../shared/docs/images/layout/ContinuousAuto_small.png]
A legend for a continuous raster which was produced automatically by version 3.20 of QGIS.
Unfortunately, the tools in version 3.16 and below of QGIS don’t make it easy to create a patch for a continuous raster. The quantities will appear as separate boxes. There are ways around this.
[image: ../../shared/docs/images/layout/ContinuousNo_small.png]
A legend for a continuous raster which isn’t showing a continuous scale.
If you look at the article by EcoDiv entitled Legend for continuous raster in QGIS composer you’ll find a way to generate a continuous legend patch [footnoteRef:19]. [19:  Page last visited: 30th March 2022.] 

[image: ../../shared/docs/images/layout/ContinuousYes_small.png]
A continuous legend scale produced using the method at the web page above.
[bookmark: manually-editing-the-legend]Manually editing the legend
There is a limit to what you can do with the automatic functions and properties but do as much as you can as that will save some time. It’s particularly important to play around with the spacing settings as there isn’t a way to change that manually.
Once you have finalised as much as possible on your legend using the item properties, the instructions below show how to manually add and edit elements manually.
Alternatively, it is possible to export the map as pdf or svg format then edit the legend in a vector graphics editing program such as Inkscape, CorelDraw or Adobe Illustrator.
[image: images/svg/videocam-black-24dp.png] Manually editing a legend in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: Xd1232d237f58a95775396f3e1e6ed744756f3c2]Adding or editing items not created automatically
As an example, this could be a way to add a patch for a combined colour on the layout which isn’t actually part of a layer so doesn’t appear in the legend.
To do this, you add the shape you want using the menu items listed below, “draw” it on the layout, then style it using the item properties.
· To add a rectangle or circle go to Add Item > Add shape > Add Rectangle or Add Ellipse.
· To add a marker symbol, e.g. for a point, go to Add Item > Add marker, then choose a marker from the properties as you would for marker symbols in Layer styling.
· To add a line go to Add Item > Add Note Item > Add polyline. Click each node to draw the line, then left-click to finish.
[bookmark: X36a130f0d776eee9a0e38cb15ca9dc267a6190c]Matching a colour on the map using the color picker
Legend items need to accurately reflect the colour of the equivalent feature on the map, so it’s important to be able to set this. QGIS provides a colour picker feature which is ideal.
· Make sure that the item you want to colour is selected on the layout.
· In Item properties click on the button next to Style. The Symbol Settings dialog should appear. This works in the same way as the Symbol Settings when you’re styling map features.
· click on the colour you need to change.
· Choose the Color picker tab (as usual, hover over the buttons to see the tips).
[image: ../../shared/docs/images/layout/ColorPickerTab_small.png]
The color picker tab.
· Click on the Sample color button to get the color picker cursor, then hover the cursor over the correct colour on the map.
· To select the colour, press the spacebar on your keyboard.
The colour should be applied automatically to your element.
[bookmark: covering-unwanted-text-or-elements]Covering unwanted text or elements
This is an example of lateral thinking, but the easiest way to get rid of unwanted text or elements that can’t be removed using the legend properties, is the following:
· Go to Add Item > Add Shape > Add Rectangle and draw a rectangle over the text or elements you want to remove.
· Set the fill of the rectangle to the same colour as the background (using the color picker as above if necessary).
· Set the stroke style to No pen.
You can then add any new elements on top of the “invisible” rectangle.
[bookmark: adding-new-or-extra-text]Adding new or extra text
Adding new or extra text is really just a case of adding a label in the usual way.
· Add Item > Add Label
· Change the font, font size, colour, etc, to match any other text on the legend.
[bookmark: preventing-the-legend-from-crashing-qgis]Preventing the legend from crashing QGIS
If you have a problem with QGIS crashing when you add a legend, try the following. It is probably crashing because you have a lot of layers on your map and, because Auto update is selected, it is struggling to add all the details.
· Open a new, empty project in QGIS
· Create a new blank layout as you did above.
· Add a legend to the layout. It won’t have any content, but that’s fine.
· Untick the box in the legend properties that says auto-update
· It’s a good idea to add a title and a frame to the legend so that you can find it again!
· Save the layout as a template (Save as template button on the toolbar)
· Close the blank project and reopen your real project
· Create a new layout use the template that you saved by doing the following:
· Project > Layout Manager
· Under New from Template select Specific from the dropdown
· then click on the three dots button next to the blank field
· Select the template that you just created and Open
· Click on the Create... button and you’ll be asked for a name for your layout
Once you have the layout open add a map frame. You’ll then need to associate the map frame with the legend by selecting the legend and setting the Map to the correct map.
Now use the + (plus) button below the Legend Items to add the layers that you do want to be included. Ticking Only show items inside linked map will also help.
This is a fiddle and not ideal, but if it stops your QGIS project from crashing hopefully it is worth it!
[bookmark: scale-bar-and-scale-text]Scale bar and scale text
Some indication of scale should always be added to both printed and screen maps. A scale bar is a useful convention for both. Scale text (e.g. 1:50,000 or 1 cm = 1 km) is only relevant for printed maps, not for maps on screen where someone can zoom to any scale. If you add scale text you must also ensure that you print or export the map at the correct scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a scale bar and scale text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: to-add-a-scale-bar]To add a scale bar
· Double-check first that you have the correct map selected on your layout. Particularly important if you are including multiple maps at different scales.
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale bar (you can always move it later)
· Select OK on the New Item Properties box that pops up
The scale bar should appear on your layout. You can now go to the Item Properties to change various parameters.
· The Map dropdown is where you check that the scale bar is set for the correct map
· Use the Style dropdown to select how you want the scale bar to appear - try a few of these and see what effect they have
· The Scalebar units should be set to something appropriate for your map
· You can use the settings under Segments to change the length and intervals of your scale bar. Try these out and see what happens.
[image: ../../shared/docs/images/layout/ScaleBarProperties_small.png]
The most important settings for the scale bar.
There are a lot more settings so just explore these and see what they do. In particular you may want to change the Font under the Display settings. You can always remove the scale bar and start again!
[bookmark: to-add-scale-text]To add scale text
· Click on Add Scale Bar on the Toolbox
· Click on the layout in roughly the position you want the scale text (you can always move it later)
· Select OK on the New Item Properties box that pops up
A scale bar should appear on your layout. You can now go to the Item Properties to change this to numbers.
· The Map dropdown is where you check that the scale text is set for the correct map
· Use the Style dropdown to select Numeric
The text should appear and automatically match the scale of your map. There are far fewer options for this - mainly just the Font settings.
[bookmark: text-or-labels]Text or labels
Text is an essential part of any map layout. Maps need an informative title to show the audience what the map is about. You should include your name (or for an assessment your student ID) as creator of the map. Copyright statements are essential if you have used data from other sources and you may also want to include acknowledgements and further explanations of your maps and data.
There are two main ways to add text, static text and dynamic text. The instructions for static text are shown below. Dynamic is more complex and won’t be covered here. If you are interested in using it you can look at the tutorial on Creating a Dynamic Print Layout in the QGIS Training Manual.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding text to a map layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: static-text]Static text
Static text is text that you type into the box on the Item Properties. This stays the same once you have added it. Most of the text that you add to your layout will be of this type. For example, a title or subtitles to individual maps, your name or ID as the creator of the map, copyright text etc.
[bookmark: to-add-static-text]To add static text:
· Click on the Add Label button on the Toolbox
· Click on your layout in roughly the location that you want your text to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
· A new label item should appear on your layout. By default the text will be “Lorem Ipsum” (placeholder text).
· Type your text in the box on the Item Properties panel
· The options on the panel will also allow you to change the font, font size and colour, the alignment, and add a frame.
[image: ../../shared/docs/images/layout/TextProperties_small.png]
Item Properties for text. Note the large box to type your text and the options in the Appearance section below.
[bookmark: copyright-acknowledgements]Copyright acknowledgements
Copyright is important. Remember that most data providers ask you to sign up to conditions that include an obligation to add a copyright acknowledgement to your map. Check what that copyright statement is and make sure that you add it.
For example, when you signed up to use the Digimap collections you agreed to add copyright acknowledgements whenever you created a map with the data. These acknowledgements do change from time to time so it’s worth knowing how to check what they are for yourself.
· To find the Digimap copyright acknowledgements go to the Digimap Help (Help at the top of the main Digimap page)
· Look for a link to Copyright and Licensing and click on it.
· Individual licences are in a list on the left, click on the one for the data you are using. There is more general information in the main body of the page.
· Then look for the information under In return, you must: - that gives you the acknowledgement text.
For example, from April 2019, when you use Ordnance Survey data obtained from Digimap you are expected to add the following text to your map.
© Crown copyright and database rights year. Ordnance Survey (AC0000851941).
Where year is replaced by the current year.
Remember that you do have to acknowledge each different dataset that you use and will have signed up to that when your registered.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Adding the copyright symbol to your text
• To add the © symbol (on Windows), you can copy the symbol from this document and paste it into the box in the text properties panel.
• Alternatively, put the number lock on the keypad, hold down the Alt key, type 0 1 6 9 then let go of the Alt key.
• If you are on a Windows laptop and don’t have a number pad, put the text [%char(169)%] in the text box.
• If you are on Mac, either copy and paste, or use the shortcut Option + G.
If you are not using U.K. Ordnance Survey data this is not the correct copyright acknowledgement to use. For example, if you are using data for Spain or the United States, or indeed UK data that you haven’t downloaded from Digimap. You’ll need to find the correct copyright acknowledgement for yourself. You can often find this sort of information on files that come with the data or on the webpage you downloaded it from.
Digimap also give advice on citing Digimap data as opposed to the copyright acknowledgement.
GIS Lounge have an article about How to Cite GIS Materials which includes the software as well as the data and the maps.
[bookmark: a-measured-grid]A measured grid
Measured grids add labelled grid lines to a map. If you are using Ordnance Survey or other UK data projected in British National Grid then you can easily add National Grid lines and numbers to your map. The O.S. Raster tiff files already have grid lines marked, but adding a measured grid allows you to include coordinates around the edge of your map - making it possible to read grid references.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding a measured grid to a map in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Click on the map to which you want to add grid lines.
· In the Item Properties scroll down until you reach the Grids heading and click on the little arrow next to it.
· Click on the + (plus) button below the Grids heading to add a Grid to the list below.
· Select the Grid in the list and click on Modify Grid...
The Item Properties will change to show the properties for the grid.
· Under Interval set the X and Y boxes to the interval that you want between the lines. This depends on the scale of your map and you can experiment to see what looks best and would be most useful. For now try 1000 - this is in map units which for British National Grid will be metres.
· The lines are often too bold, so click on the Line style dropdown and select a paler shade of grey. You could also make the lines thinner.
[image: ../../shared/docs/images/layout/MapGridProperties1_small.png]
The top of the Map Grid Properties showing the interval and the paler line style.
· Scroll down and tick next to Draw Coordinates - this adds the numbers.
· I usually change the Left and Right coordinates from Horizontal to Vertical so that they follow the edge of the frame.
· Alter the Font as you wish - don’t make the coordinates large. They need to be visible, but not intrusive.
· Change the Coordinate precision to 0
[image: ../../shared/docs/images/layout/MapGridProperties2_small.png]
The Draw Coordinates part of the Map Grid properties showing the Vertical setting for Left and Right and Coordinate Precision set to 0.
Note that the grid that QGIS adds is fully numeric, you may be more used to seeing grid letters for 100 km grid squares, e.g. the University grid reference is similar to SE 2934 3444, the University grid coordinates are similar to 42934 43444. It is the latter that will appear on a measured grid generated by QGIS.
[image: ../../shared/docs/images/layout/MapGrid_small.png]
A map with a measured grid that shows British National Grid coordinates on a 1000 m grid.
[bookmark: north-arrows]North arrows
Before adding a north arrow to your layout stop and think about how you need to indicate north on your map. If you look at the technical information on an Ordnance Survey Landranger (1:50 000) map you’ll see a diagram showing Grid north, True north and Magnetic North. The information given there shows how to plot the difference of magnetic north from grid north. Adding this to your own maps can be useful, particularly if you, or anyone else, are going to be using the map in the field.
If you are taking strike and dip measurements in the field you should have corrected your compass-clino for declination (the horizontal angular difference between true north and magnetic north) anyway. When you plot the measurements on your map it isn’t worth worrying too much about whether you are plotting against grid or true north as the difference on any grid, not just the British National Grid, is unlikely to be that big. See the image below for the different types of north and the declination.
[image: ../../shared/docs/images/layout/LONorthVersions.png]
The different types of North that you will find on a map set to a projected coordinate system, such as British National Grid.
[image: ../../shared/docs/images/svg/info-black-24dp.png] Labelling north arrows
If you add any north arrows to your layout do remember to label them in some way which shows which version of north each one is showing.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding north arrows to a layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: north-arrow-grid-north-map-north]North arrow: Grid north / Map north
If a map is in a projected coordinate system QGIS will automatically lay it out aligned with the grid. So for example, any map set to British National Grid will be aligned to grid north.
In this case it isn’t strictly necessary to add a north arrow to show grid north if you also include a measured grid on your map, but it doesn’t hurt.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation the North alignment should be set to Grid North by default - if it isn’t set that now.
[image: ../../shared/docs/images/layout/NorthArrowGrid_small.png]
The Item Properties for a north arrow showing Grid North.
If you check this against your measured grid lines you should find that it matches exactly.
[bookmark: north-arrow-true-north]North arrow: True north
True north is the direction from the area of your map to the North Pole. In the east/west centre of a grid, such as that set for the British National Grid, it may well be the same as grid north, e.g. in Leeds the difference is extremely slight. As you go further east or west towards the edges of an area covered by a grid the difference becomes more noticeable, e.g. at Lands End in Cornwall, or in Norfolk.
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north
You should see the rotation in the box above change to a slightly different number.
If you check this north arrow against your measured grid lines you may well find that the north arrow is slightly tilted.
[bookmark: X6f9b2667148bbd9552bb406dbd706b8691a7e54]North arrow: Magnetic north calculated by declination
Magnetic north is the direction from the area of your map to the magnetic north pole. This is the number that is given on the corner of Ordnance Survey maps and the one geologists need for setting their compass-clinos in the field, so it is worth making a note of this on your map too.
[bookmark: finding-the-magnetic-declination]Finding the magnetic declination
First you need to find the magnetic declination.
· Go to the World Magnetic Model 2020 Calculator on the BGS Geomagnetism Group web pages
· Use the map to navigate to your location and click to drop a point.
· A small results box will appear. The number you want is the Magnetic declination, which is in in the D column and MF row. There is a key to the results below the map and you are looking for degrees east.
· Make a note of the declination, including any minus sign.
[bookmark: to-set-magnetic-north-on-a-layout]To set magnetic north on a layout
· Click on the Add North Arrow button on the Toolbox
· Click on your layout in roughly the location that you want your north arrow to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a default north arrow to your layout and open the Item Properties.
· Under Picture check that SVG image is selected
· In the box below scroll down to svg > arrows to select a different north arrow. Note that it’s usually a good idea to keep these simple.
· Change the colours and stroke width under SVG Parameters if required
· Under Image Rotation set the North alignment to True north as declination is the angle from True north to Magnetic north.
· In the Offset field enter the angle that you obtained from the BGS website.
[image: ../../shared/docs/images/layout/MagNorthImageRotation_small.png]
Setting the image rotation for a magnetic north arrow. The declination from the website is -0.35 degrees.
Don’t forget to add text to your map showing the date of the reading. It changes with time.
For more about how the magnetic north pole is moving see the BGS blog.
[bookmark: multiple-maps-on-one-page]Multiple maps on one page
It can be very useful to be able to place more than one map or map view on a single page, either so that you can show a different area, or a different zoom level for the same area. You can also use this to set up an automatic extent indicator which marks your study area on a map of a country.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding multiple maps to one layout in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: different-areas-of-the-same-map]Different areas of the same map
You can add multiple maps to your layout using the Add Map command in the same way you added a single map earlier.
If you add them directly both maps will show the same data and styling. You can then change the scale and extent on each one individually using the Item Properties and the Move Item Content button.
[bookmark: maps-showing-different-content]Maps showing different content
If you want to add further maps to your layout but have them showing different content you can do that too.
· Select the initial map frame on the layout
· Make sure that it shows the content that you want it to show and it is all styled correctly
· In the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
Now go back in to the map view and set up the map and layers so that they are as you want them for the second map.
· Back in layout view add a new map frame as before. This should reflect the map that you have open in the map view now.
· Once you are happy with this view in the Item Properties go to the Layers subheading and tick on Lock layers
· Once you’ve done that you’ll have the option to tick Lock styles for layers too. This stops your styles from changing if you change them in the main map.
As both of your maps are locked you will have to remember to unlock them if you need to make any changes to the styles or combinations of layers.
[image: ../../shared/docs/images/layout/MultipleMaps_small.png]
Two views from the same map with layers locked.
[bookmark: extent-indicator-or-locator-map]Extent indicator or locator map
For some maps, particularly large scale (detailed) maps of very small areas, it is useful to show a small scale map of the general area with the area of the main map marked, as in the figure below.
[image: ../../shared/docs/images/layout/ExtentIndicator_small.png]
A map of a small area with an extent indicator or locator map to give context.
To do this you need to obtain small scale data and add it to your map. You really only need a general map, even just an outline of a whole country.
[bookmark: natural-earth-data-1]Natural Earth data
It is possible to do this using data from Natural Earth. Download the Countries data from Medium scale data, 1:50m > Cultural > Admin 0 - Countries - click on the Download countries button to download a zip file containing a shapefile.
[bookmark: quick-world-map]Quick World map
There is also a little trick hidden in QGIS which makes adding a World map with country outlines really easy.
· In your QGIS project click in the Coordinate box at the bottom of your map then delete the existing contents.
· Type world (all lower-case) and press enter.
A map of the world with country outlines should appear on your map and in your Layers panel. When you zoom to layer the result might be a bit odd if you have a projection such as British National Grid set for your map, but try it out and see whether the area you need looks right.
You can style the map as usual, e.g. if you just want outlines.
[image: images/svg/warning-black-24dp.png] Warning
Using a screenshot from Google Earth or Google Maps (or similar) with a marker on it doesn’t look professional and should be avoided. Not least it is surprisingly easy to end up with the marker in the wrong place.
[bookmark: Xf95eca208bb58b49df915ab7da31b1bb7bec392]Adding the extent indicator to your layout
Note that the extent indicator does not need to be large, but should be a small map which doesn’t take up too much space on the layout.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Adding an extent indicator to a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your main map and lock the layers on the layout.
· Add the Countries outline to your map and turn off the other layers
· Symbolise the countries as a thin black outline and zoom in to the country containing your study area
· Add a new map to your layout and resize it as appropriate so that it shows the country as a small map.
· Make sure that the small map is selected then go to the Item Properties panel
· Scroll down to the Overviews section and click on the little arrow next to it to open it out
· Click on the + (plus) button then select the new Overview title that appears
· Check that Draw "Overview 1" overview (or whatever your new Overview is called) is ticked.
The properties to change how the overview looks are below.
· Under Map frame select your main map - the one of the smaller area.
[image: ../../shared/docs/images/layout/OverviewsProperties_small.png]
The Overview properties in the Item Properties for the small map.
· Set the Frame style as you wish. If you can’t see the frame on the indicator map because it is too small
· I found that setting the Simple fill Stroke style to Solid Line in the Symbol Settings
· then giving it a thicker Stroke width and setting the Join style to Round gave the effect of a dot on the map.
[image: ../../shared/docs/images/layout/OverviewDot_small.png]
Using the Symbol Settings to make the overview frame look like a dot.
You should now have a map with a marker showing the location covered by your main map. If you move the main map the “frame” on the smaller map will automatically update to reflect the new location.
[bookmark: inserting-photographs-and-images]Inserting photographs and images
You may want to include photographs and diagrams on your map layouts. Geological cross-sections will come under this category too.
[image: images/svg/videocam-black-24dp.png] Inserting photographs and images in a layout in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: to-add-a-raster-image]To add a raster image
This includes photographs or any image in a format such as jpg, png, tiff, gif.
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a Raster Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
[bookmark: to-add-an-svg-image]To add an SVG image
SVG stands for Scaleable Vector Graphics. It is the native editing format for the vector graphics program Inkscape. If you have used Inkscape to draw your diagrams you can import them as follows:
· Click on the Add Picture button on the Toolbox
· Click on your layout in roughly the location that you want your image to appear. You can move and resize it later. You can also “drag” the box to the correct size as you add it.
· If the New Item Properties dialog appears click OK
QGIS will add a blank picture place holder to your layout and open the Item Properties.
· In the Item Properties click to add a SVG Image
· Use the three dots button to navigate to and select your picture file then click Open
Your picture should appear on your layout. As usual you can resize it and move it on the layout and change the properties in Item Properties
[image: ../../shared/docs/images/svg/warning-black-24dp.png] Warning
Unfortunately, svg images with gradient fills don’t seem to work well in QGIS. In many cases it will be better to export your diagram from Inkscape as a png file then import that to QGIS as a raster image.
Alternatively, you can export the layout from QGIS when you have finished adding all the map elements and then open it in Inkscape and add your diagrams there. This is usually a better option and instructions will be given for exporting from QGIS later in this chapter.
[bookmark: checking-your-map][bookmark: _Toc160015518]Checking your map
Checking your map is a very important stage but one that can easily be forgotten if you are in a hurry.
In addition to the points below have a look at Darkes (2017) which gives a lot of quick tips on map layout and presentation. On pages 92 and 93 Darkes includes a section with quick wins for improving your map before publication if you have 5, 15 or 50 minutes.
[bookmark: suggestions-for-things-to-check]Suggestions for things to check
· Check that you have included everything you need to include. If this is an assignment reread the instructions and check that you haven’t forgotten to do anything.
· Check that you have left space for margins on the page. This is particularly important if you are printing your map - you don’t want to lose any of the content - but leaving some white space around the outside of your layout looks better even if you’re not printing.
· Check spelling. It’s easy to miss something obvious so if possible, print your map out, or put it on screen and stand back a bit then have a look at it. In particular check geological and geographical names and any technical terms.
· Check that your map doesn’t include anything that you don’t want to include! Did you add some experimental polygons when you were editing, then forgot to delete them? Have you added text boxes and then not removed any that you don’t need?
· Look at the article on Using a mapmaking checklist for map design on the ESRI blog. Read about what makes a map great, then click on the link to the checklist and use the questions there to evaluate your own map. Have you included everything you need to include, or do you have a good reason if something is not on your map? Have you taken care with your presentation?
[bookmark: Xbcf4e690fb753c5c295625a996eee81d2d85d13]Checking the colours of your map and layout
In the lectures on styles and labelling, and on presentation, we will have discussed the use of colour on maps. It’s a good idea to check your colours before exporting or printing your map, though you should have been thinking about them as you created and laid out the map too.
In Layout view there is a setting which allows you to simulate different forms of colour blindness.
The idea is to check that all the information on your map is accessible to all your potential audience.
[image: ../../shared/docs/images/layout/PreviewNormal_small.png]
The original, normal view of the map - no preview applied.
· In Layout view go to View > Preview then choose one of the forms of colour deficiency.
The whole layout should change to give you a preview.
[image: ../../shared/docs/images/layout/PreviewProtanopia_small.png]
A preview of the same map as it could be seen by someone with protanopia - no red.
· Check all the colours on your map are distinct. Do any look too similar? Have a look at the key as well to check the colours.
· Do all the layout elements show up clearly? If you’ve put anything on a background, is it still easy to see?
· Try different settings and check the colours carefully for each one.
· Looking at a layout in the greyscale preview setting can give you a good idea of the amount of contrast you have between your colours.
[image: ../../shared/docs/images/layout/PreviewGreyscale_small.png]
A greyscale preview of your map. Note how you can see the amount of contrast between your colours. Try to aim for good contrast to make your map clear to all your audience.
[bookmark: printing-a-copy-to-pdf-to-check]Printing a copy to pdf to check
Almost inevitably you’ll notice something not quite right with your map after you have printed it. To minimize the chances of this happening if you are printing an expensive A0 copy it is a good idea to print your map at A3 and have a close look at it. This isn’t such an issue if your map is only A3 or A4 when full size.
If you don’t have access to a printer then you’ll need to export as pdf and then zoom in and out on your screen.
· Export your layout as a pdf file following the instructions below.
· Open your pdf map file in your usual pdf reader (instructions below are for Adobe Acrobat but you should be able to find similar commands in other programs)
· File > Print
· Choose your printer and use the printer properties to set the paper size to A3 then choose to print in colour.
· In the Page Handling section set Page Scaling to Fit to Printable Area. In Acrobat this should show you a small preview of how your file will print.
· When you are happy with the settings send your file to the printer.
[bookmark: printing-and-exporting-map-layouts][bookmark: _Toc160015519]Printing and exporting map layouts
When you have finished creating your map layout in QGIS, you will often need to export it to pdf for printing. The following instructions should help to ensure that your map is the correct size and scale.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Printing or exporting a layout from QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: printing-a-map-layout-from-qgis]Printing a map layout from QGIS
The best quality output is probably obtained by printing directly from QGIS, though this isn’t always possible. If it is, print as follows:
· Start by checking that the page size and the map scale are correct.
· Go to Layout > Page Setup and check that the paper size matches the size you set in the layout properties.
· Then Layout > Print to actually print your map.
You’ll need to set up the printer as you usually would. This is system and printer specific so I can’t include fuller instructions here.
[bookmark: exporting-a-map-layout-from-qgis]Exporting a map layout from QGIS
[bookmark: exporting-to-pdf]Exporting to pdf
These instructions show you how to export the map to pdf - the format that is usually required if you are having the map professionally printed.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as PDF... or click the button on the toolbar.
· Select where you want to save your output and give it a name
· Then click on Save
· The PDF Export Options should open. The defaults are fine, so stick with those
· Click Save to export the pdf.
You should get a message saying that your layout was successfully exported.
At this stage open the pdf and make sure it looks as you expect it to.
[bookmark: X360678337821fb25546111e4fa577b9a92f126b]Important note on printing a map layout from pdf
If you are printing your final copy from pdf double-check in the pdf reader you use that the Page Scaling or Zoom is set to Actual size... or None. The actual terminology depends on which pdf application you are using.
This is important to ensure that your map is printed at the scale at which you intend it to be printed. This is particularly important if you are printing maps to be used as field slips. Major problems with measurements can be caused if your map is reduced by even a tiny amount.
[bookmark: Xb404c6ee7d018c146e48a6e99e45f7ab3cc254b]Importing a pdf map layout in to Inkscape
[image: ../../shared/docs/images/svg/info-black-24dp.png] Export pdf and import to Inkscape
It is possible to export a map layout to svg which would work in Inkscape, but at the moment the export is rather unreliable. If you want to open your map layout in Inkscape to finish it off it is better to export pdf and import that to Inkscape.
I have experimented a bit with using the output from QGIS in Inkscape for a large map, and have found that, unless you are going to actually want to edit some aspects of the actual map, Inkscape is more stable if you import the map as an image, e.g. png format, and then add other elements around it. The next section below shows how to export your map as a png image.
If you need to make changes to a single element of your map, e.g. the legend, try creating the legend on a separate, smaller layout, export that as pdf and then add that to the main layout in Inkscape.
If you are importing the pdf in to Inkscape and if your map is going to be part of a bigger presentation where scale is important, such as the Geology degree final dissertation map, be very careful to import it without changing scale, size or proportions. The Interactive Inkscape exercises[footnoteRef:20] have a section on how to import a map layout. [20:  If you are not a Geology student but would like to learn how to use Inkscape for drawing and for finishing maps please contact Clare Gordon or go to Clare’s downloads to obtain a copy of the exercises as interactive worksheets.] 

[bookmark: X7826189a9d5b9995538915d6820f08c1c2794fe]Exporting a map to import to Word and PowerPoint
You can also export the layout to include in programs such as Word or PowerPoint if you are intending it to accompany a report.
· Start by checking that the page size and the map scale are correct.
· You should also check the Export Settings under Layout (the next tab to the left of the Item Properties. Check that the Resolution is set appropriately - too high and you’ll have an enormous file, too low and the print quality won’t be good. Try 300 dpi and see how that goes.
· In a layout go to Layout > Export as image or click the button on the toolbar.
· The Image Export Options will open. This gives you another chance to check the resolution.
· It’s usually worth ticking Enable antialiasing - but if your map looks very blurred it will be worth trying again with this unticked.
· If you are likely to want to open your output in GIS again click to Generate world file
· Click Save and wait for your file to be exported. You’ll get a message when it finishes.
Be aware that it is a good idea to create your layout at the correct size in QGIS before you export it. You can resize jpg or png files in Word and PowerPoint but you’ll lose some of the quality.
[bookmark: setting-up-to-print-multiple-map-pages][bookmark: _Toc160015520]Setting up to print multiple map pages
Sometimes, once you have a map set up, you need to print it across multiple pages. The most likely example of this is for Geology students, where you set up your field slip ready for mapping, but it will need more than one page to print it at 1:10,000. Other students probably won’t need to do this, but the instructions are here anyway.
[image: images/svg/warning-black-24dp.png] Warning
Unless you need to set up a map as a series of field slips, or atlas pages, don’t follow these instructions now. It will be better to spend your time on other aspects of your map.
There are a couple of different ways you can do this and instructions are below.
· For all the options, start by setting up a layout with a map frame and any other elements you need to include, e.g. a scale bar, copyright text, date etc.
· It can be useful to have an outline of your area of interest so you can keep track of the area you need. If you don’t already have one in your map, create it as a polygon and roughly digitise the outline of your area.
[bookmark: moving-the-map-around-within-the-layout]Moving the map around within the layout
This method is probably the simplest, but it can be easy to miss bits, and if you do, it isn’t always easy to repeat the process.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages by moving the map around in the layout
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Set up your map layout, then move the map so you are looking at the north-west corner of your area of interest.
· Check the scale is correct.
· Print or export your map. If you export, you’ll be able to print further copies if you need them.
· Now carefully, using the Move item content tool, click and hold on the north-east corner of your map, and drag the map content across so that the bit you are dragging from is in the north-west corner of the layout. It’s usually a good idea to have an overlap.
· Once again, print or export your map.
· Continue doing this, dragging the map upwards from one of the southerly corners when necessary, so you have complete coverage of your study area.
[bookmark: using-the-qgis-atlas-function]Using the QGIS atlas function
This seems more complex, but if you make the effort, it is more reliable and if you need to generate maps for the same area again, it will be much simpler to do so than with the method above.
Once you have set up an atlas, QGIS will automatically export the pages based on your settings.
[image: ../../shared/docs/images/svg/videocam-black-24dp.png] Generating multiple map pages with the QGIS atlas tool
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: creating-a-grid-to-control-your-atlas]Creating a grid to control your atlas
You need to start by creating a coverage layout to control the area of each page of your atlas and the most reliable way to do this for field slips is to set up a vector grid to cover your area of interest.
To generate your vector grid:
· Search for Create Grid in the Processing toolbox and open the tool from under Vector Creation.
· Set Grid type to Rectangle (Polygon).
· If you have a layer covering the whole of your area of interest on your map, click on the three dots button at the end of the Grid Extent line and select Calculate from Layer, then select your area of interest layer.
· If you don’t have a layer covering the whole of your area of interest, select either Use map canvas extent or Draw on Canvas. If you select the latter, you’ll have a chance to draw your area on the map.
· Use the table below to select your Horizontal spacing and Vertical spacing based on the scale of your maps, and the size of your paper.
· Set the Grid CRS to the correct CRS for your map.
· Either create a temporary layer, or choose where to save your vector grid.
· Run the tool.
Note that the values in the table allow for a bit of an overlap. For landscape orientation instead of portrait, swap horizontal and vertical spacings.
This is a process which is likely to involve a bit of experimentation and changes in spacing to get the coverage you want.
	Paper size and orientation
	Scale of map
	Horizontal spacing (metres)
	Vertical spacing (metres)

	A4 landscape
	1:2,500
	600
	400

	A4 landscape
	1:5,000
	1250
	850

	A4 landscape
	1:10,000
	2700
	1800

	A4 landscape
	1:25,000
	6500
	4400

	A4 landscape
	1:50,000
	12000
	9000


[image: ../../shared/docs/images/layout/CreateGrid_small.png]
Creating a grid on which to base an atlas.
The result should be a regular grid, shown as the blue, dashed lines in the image below. (The thin, solid blue line is my area of interest.) The grid starts from the top left, so you may find you have too much space on the right and bottom of the grid. The main way to deal with this is to change the grid spacing, or use a slightly different area. If any of your grid rectangles have very little or none of your area of interest in them, as in the right-hand rectangles in the example below, you can delete them.
[image: ../../shared/docs/images/layout/VectorGrid_small.png]
The resulting vector grid shown as a blue, dashed line. The rectangles on the right contain very little of the area of interest, and I will delete them.
[bookmark: setting-up-the-atlas]Setting up the atlas
Once you are happy with your coverage layer, you can start setting up the atlas.
· Enter Layout view and check your layout is set up correctly, e.g. with titles, scale bar, copyright, etc as required.
· Go to Atlas > Atlas Settings - the settings should open to the right of your layout.
· Tick the box labelled Generate an atlas.
· Set the Coverage layer to your vector grid layer.
· For now leave the Hidden coverage layer box unticked - being able to see the coverage layer while you are setting up, helps to get the correct areas on each page.
· For now you can leave the other settings as they are. You can come back to the settings and change those later if you need to.
[image: ../../shared/docs/images/layout/AtlasSettings_small.png]
The basic settings for an Atlas. Note that there has to be a Coverage layer, which in this case is my vector grid layer.
The next options are in the map properties:
· Click on the map frame that will control your atlas.
· Click on the Item Properties tab on the right.
· Scroll down and tick the box next to Controlled by Atlas.
If you are setting up a field slip you will need your maps to be at a fixed scale, usually 1:10,000. To set that fixed scale:
· Check next to Fixed scale.
· At the top of the Map Properties, check the Scale is set correctly - in my case to 10000.000 for 1:10,000.
[image: ../../shared/docs/images/layout/ControlledByAtlas_small.png]
Controlling the Atlas as a Fixed Scale in the Map frame properties.
· Now go up to the Atlas toolbar - if it isn’t visible go to View > Toolbars > Atlas toolbar.
[image: ../../shared/docs/images/layout/AtlasToolbar_small.png]
The Atlas toolbar with the Preview Atlas button clicked.
· Click the button on the left of the toolbar - the tooltip should say Preview Atlas.
Your map frame should jump to the first atlas page for your map. As you’ve left the coverage layer visible, you should be able to check whether you have the coverage you need.
· To preview your atlas, use the arrows on the toolbar. The numbers show which page you are on.
[image: images/svg/create-black-24dp.png] Changing the coverage
If you need to change the coverage, you’ll need to regenerate the vector grid, add it to your map, and change the coverage in the Atlas settings.
Preview your atlas again, and check whether it looks right.
[bookmark: printing-or-exporting-an-atlas]Printing or exporting an atlas
Once you are happy with the coverage of your atlas pages:
· If you want to, make the coverage layer invisible by going to the Atlas settings and putting a tick next to Hidden coverage layer.
· Also in Atlas settings, you can choose whether to export multiple files, or tick next to Single file export when possible to generate a single file with multiple pages. This will work for pdf, but not most image formats.
· Double-check the scale is still correct.
· Go back to the Atlas toolbar and either click on the button to print your atlas, or choose one of the export buttons.
· If you are printing later, then choose pdf. This will also work best if you are going to make changes to your maps in Inkscape.
· If exporting, choose the folder you want to save your output(s) into, then click Select Folder.
· The defaults are usually fine, so stick with those for now, and press Save.
Depending on the number of pages you may have to wait for a bit, but once QGIS tells you it has finished, your file(s) should be available in the folder you selected.
Check the output, and make any changes to your coverage or layout as necessary.
There are other settings you can try, including using Expressions to add a page number or a different title for each page. The sources of help suggested below include more on this.
If you have a vector grid, it is also possible to create a final, less detailed map, which shows the coverage of each individual page - a map index.
[image: ../../shared/docs/images/layout/MapIndex_small.png]
A map index created from the coverage layer with the grid rectangles labelled with the map number.
[bookmark: Xadbc57e9bb2787c320e6dc7520691e8a448406c]Other sources of help for creating an atlas
There is a lot online about creating atlases in QGIS. Try any of the following:
· Training manual lesson on using the Atlas Tool - this uses a vector grid to control the pages of the atlas and this is what you are most likely to need for field slips.
· QGIS manual page for Generating an Atlas
· Klas Karlsson YouTube video on creating an atlas
[bookmark: X54cefe57099c743d12934668881516e9e44d61c][bookmark: _Toc160015521]Recommended reading: layout and presentation
The following references from the reading list[footnoteRef:21] will give you information on the principles behind producing a professional layout. [21:  Available in Minerva and via the University Library reading list page - just search for the module number.] 

· Darkes and Spence (2017) - large parts of this book are particularly relevant but it is formatted as a quick reference guide so it’s easy to get quick information about what ever you are looking for. Unfortunately, this book isn’t available online, but is worth buying if you want to buy one book for this module.
Particularly useful in the Darkes and Spence book are the pages at the end titled “Better mapping in 5, 15 and 50 minutes”.
· The article by Frye (2001) gives you quick information about communicating with maps.
[bookmark: technical-information]Technical information
· The QGIS User Guide includes a chapter on Laying out the maps which covers a lot of the techniques from this chapter plus a few other things such as generating an atlas.
· QGIS Tutorials has a tutorial on Making a map in QGIS 3.
[bookmark: further-information-and-inspiration]Further information and inspiration
· University of Delft publishes GIS OpenCourseware. Their tutorial on Cartography for map figures in academic journals and books is a clear look at how to include maps in other publications. This is well worth going through.
· For examples and ideas look at the ESRI Map Book Gallery.
· The British Geological Survey printed maps are available online via the BGS Maps Portal and it’s worth having a look at the layout of some of the more modern sheets, such as the Glossop sheet or the Bath sheet.
[bookmark: raster-analysis-1][bookmark: _Toc160015522]Raster analysis 1
Last Modified: 18 Jan 24, 17:03:45
The background to raster analysis will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-7][bookmark: _Toc160015523]Learning outcomes
When you have completed this section of the workbook you should be able to
· Define raster data and understand how to find out raster properties and apply them to analysis
· select appropriate tools to carry out geoprocessing tasks
· Convert between vector and raster data types and describe the potential limitations
[bookmark: introduction-5][bookmark: _Toc160015524]Introduction
Raster analysis is a way of taking existing raster datasets and using them to generate new locational information. Analysis can show how locations are associated with one another based on properties and spatial relationships.
Virtually all the analysis that we will be doing on raster data can also be done on vector data, but due to the differences in the data models the analysis often works in a very different way.
You have already seen examples of raster analysis in the sessions on using elevation data. This chapter will build on that and introduce you in detail to more of the tools for processing raster-based data.
The first exercise will look at the Hebden Bridge area of West Yorkshire. In 2012 Hebden Bridge and nearby towns suffered two major flooding events within a few weeks of each other. Cloud-bursts on the moors above them caused heavy run-off. Sediment quickly blocked drains and shops and houses were flooded [footnoteRef:22]. [22:  The story Mytholmroyd and Hebden Bridge hit by flooding on the BBC news pages shows videos and images of the flooding.] 

In this chapter and the next two you will investigate the catchment area of the River Hebden / Hebden Water, combining dtm data with rainfall data and then data on the population of the catchment.
[bookmark: data-for-the-raster-analysis-exercises][bookmark: _Toc160015525]Data for the raster analysis exercises
[image: images/svg/warning-black-24dp.png] Warning
Being able to find, download and prepare your own data is an essential part of using GIS. For the exercises in this chapter you will need to download several datasets. While these should not take too long to download and prepare, don’t leave it until the last minute. Websites can become unavailable either permanently or temporarily, or computers can crash.
If there are problems with a website then try again later. If the problems persist please get in touch with me (c.e.gordon@leeds.ac.uk) and I will try to contact the site or find an alternative source of data.
[bookmark: data-required-2]Data required
Download the following data - full instructions are below:
· From Digimap
· Background mapping
· Vector Map District Raster
· Height data - OS Terrain 5 DTM - ASC (ascii text) format. Note that this is the more detailed version of the data that you used in the previous exercises.
· From Minerva
· Rainfall data for 2016. This is in the RainfallData.zip file.
[bookmark: data-from-digimap]Data from Digimap
Download the data listed above from Digimap for the following minimum area around Hebden Bridge.
It doesn’t matter if you download for a bigger area, though as usual, don’t make it too much bigger or your data will take up too much disk space and processing time.
[image: images/raster/HebdenBridgeDigimap_small.png]
The minimum area for which to download data from Digimap for the Hebden Bridge exercises.
[bookmark: preparing-the-data]Preparing the data
· Add the background mapping (VectorMap District Raster) to a new map in QGIS. It’s a good idea to group the data, as there are a lot of tiles! As this is only background data, not used for analysis, it doesn’t matter if the projection of the data isn’t set, as long as it appears in the correct location! Don’t try to merge the tiles of this data - it won’t work.
· Check that the project coordinate system is British National Grid.
· Merge the asc tiles for the Terrain 5 DTM layer using the instructions from the elevation model exercises. Remember to add .asc files from any folder within your download or you won’t have the full area that you need. You need a single merged tif file for the dtm for the whole area. Remember that you may need to assign the CRS of the new layer to British National Grid.
· Don’t delete the original .asc files yet - you will also need these during the exercises. 
· Duplicate the DTM and create a hillshade layer based on the merged dtm and make it the top layer in the Layers panel. Set the blending mode to Multiply so the lower layers show through.
Make sure you have saved your map for use in the exercises that follow.
[bookmark: what-is-raster-data][bookmark: _Toc160015526]What is raster data?
You should already have discovered that raster files show data in a grid. Each cell in that grid gives one value. Information in the raster file tells GIS the location of each grid cell, allowing QGIS to display the data in the correct location and to run processing tasks on multiple files.
[image: images/raster/RasterStructureNos_small.png]
An example of raster structure. Note cells containing one value each.
For most of these exercises we’ll be using a raster format called tiff or GeoTiff which has a file extension of .tif [footnoteRef:23]. [23:  If you want to find out more about the GeoTiff format try the article GeoTIFF - a standard image file format for GIS applications.] 

[bookmark: raster-properties][bookmark: _Toc160015527]Raster properties
You have already been adding raster datasets to maps and using geoprocessing tools to analyse them, but now let’s have a closer look at them.
[image: images/svg/videocam-black-24dp.png] Checking layer properties in the Browser in QGIS.
This video clip can be found in the module area of Minerva or in the full list of video clips.
[bookmark: X152af861347a1ff09991a768fb50de1d816d5cf]Finding layer properties in the Browser panel
If you haven’t yet added data to a map you can check the properties using the Browser panel. This also allows you to have a look at a preview of how the data will look on a map.
You will have used the Layer properties window from the Browser panel already, in the elevation models chapter. You should also have checked this information about the original dtm files before you merged the Terrain 5 dtm tiles.
If you haven’t already made a note of the properties of this data, do so now.
[image: images/svg/create-black-24dp.png] Make a note of the following information about the original dtm files
CRS:
Units:
Width and Height:
Data type:
GDAL Driver:
Dimensions:
Pixel Size:
[bookmark: X3bbab6477e571569de7ee7e46a2b647b2153efd]Finding layer properties in the Layers panel
Once you have added data to your map you can check the layer properties via the Layers panel.
[image: images/svg/videocam-black-24dp.png] Checking layer properties in the Layers panel
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Right-click on the merged Terrain 5 dtm layer in your Layers panel
· Select Properties...
· Click on Information on the left-hand side.
[image: images/raster/LayerPropertiesRaster_small.png]
The layer properties opened from the Layers panel, showing the Information tab.
[image: images/svg/create-black-24dp.png] Comparing layer properties
Have a look at the properties for one of the tiles of VectorMapDistrict Raster (background mapping) and make a note of the following.
CRS:
Units:
Width and Height:
Data type:
GDAL Driver:
Dimensions:
Pixel size:
There is a lot of useful information here, but what does it all mean?
· You have already looked at the CRS and should know about that. Note that this data uses the EPSG:27700 code, whereas the original Terrain 5 DTM data doesn’t. This is significant and we’ll have to make adjustments to the Terrain 5 DTM later!
· Width and height show how many pixels there are in the x and y dimensions - this is also shown by the Dimensions. If you have downloaded this data as clipped, then each tile may be a different size. That doesn’t matter for this background mapping.
· The GDAL Driver shows you the type of file format.
· Dimensions show you the pixels in the x and y dimensions, but also how many bands of colour or information the file holds. For a DTM file it is usually only 1, but colour images, including some background layers but not this one, often have three bands, one each for red, green and blue.
· Pixel size shows the size of each pixel in the Unit shown.
Between them the Width and height, Unit and Pixel size will give you a good idea of the area of your data.
[image: images/svg/help_outline-black-24dp.png] What is the area of your background map tile?
Given the pixel size and the width and height of your background map tile, what is the coverage of the file in square metres?
You’ll need to do something like the following:
(width * pixel size) * (height * pixel size) = area in square units.
This will vary depending on the exact area you downloaded, so your answer may well be different to your neighbours.
[bookmark: data-type]Data type
The Data type shows how the data is stored and knowing this can be essential when you start using your data for analysis.
· Floating point is data with a decimal point, e.g. 12.45.
· Integer rasters store whole numbers, e.g. 12.
· Unsigned integers will represent only non-negative values
· Signed integers will represent negative and positive values
It is possible to convert from one to the other, but data can easily be lost. When converting from floating point to integer types the numbers after the decimal points are merely truncated rather than rounded.
Floating point rasters tend to be used for continuous data. Values can change gradually over an area, such as a rainfall raster.
Integer rasters are more likely to be useful for categorised data. For example, a land-cover raster could contain values such as 1 for forest, 2 for farmland, 3 for scrub, etc.
· In QGIS make sure that you have the VectorMap District raster tiles and merged DTM layers on your map and both ticked. If you have a hillshade layer on your map, untick that to make it invisible.
· Using the Identify Features tool, click somewhere on your map in an area which has both the background and dtm layer.
· Select to Identify All if you need to. If you have the Identify Results window set to Top down mode you won’t need to.
You should be presented with the Identify Results window showing both of the visible layers.
[image: images/raster/ComparingRasters_small.png]
Using the Identify Features tool to compare the background and dtm raster layers on a map.
Can you see the difference between the pixel values in Band 1 in the two layers? They will be different numbers anyway, but the floating point layer (the DTM) should have a value with decimal points, the integer (the VectorMap District background map) will only have rounded values and these will match particular colour values in the key in the Layers panel.
Click in a few more places to compare further, trying to click on different colours in the VectorMap District layer.
[bookmark: raster-statistics]Raster statistics
Each raster should have a section called Statistics in its properties.
· Return to the layer properties for the merged DTM layer from the Layers panel.
You should find in the Information tab that there is a section under Information from provider which contains statistics for Band 1. You may need to scroll down to see it. Have a look at the information that is available to you there.
[image: images/raster/Statistics_small.png]
Raster statistics for Band 1. This include the maximum, minimum and mean values for the layer.
You should be able to see the maximum and minimum values, which in this case show the highest and lowest heights above sea-level, but also the mean and standard deviation.
[bookmark: Xd766be2a546c5ed2f1d875998381b22ae4da446][bookmark: _Toc160015528]Creating an interpolated surface from point data
For the next section we’ll create a new raster layer from a vector dataset which contains rainfall data.
You should have downloaded from Minerva a csv file (comma-separated values) containing 5 km gridded rainfall data for the U.K. for 2016 by month [footnoteRef:24]. [24:  Data downloaded from http://www.metoffice.gov.uk/climatechange/science/monitoring/ukcp09/download/index.html and edited to show only data for 2016. May 2019.] 

Open the file in a spreadsheet app such as LibreOffice Calc, Office365 Desktop Excel (not web), Google Sheets or Pages, and have a look at the data. This covers the whole of the UK and the first two columns give you locations in British National Grid eastings and northings.
You will want to use the total rainfall for 2016 rather than the monthly figures you have at the moment. You could calculate this in the spreadsheet program, but this time we will do the calculation in the attribute table within QGIS later.
· Add this point data to your map of the Hebden Bridge area in the same way that you added the hills data to the Lake District map.
· As this data is csv format, rather than xlsx, you will need to drop down the box next to the File name: field which says Spreadsheet files, and select All files (*;*.*) instead so you can see the file.
· When using the Spreadsheet Layers plugin to import the spreadsheet, check that the data type for the monthly figures is set to Real, which is a number format, not String, which is a text format.
[image: images/raster/CreateLayerFromSpreadsheet_small.png]
Checking that monthly totals are set to Real, not Text.
You should end up with a grid of points at 5000 metre intervals covering the whole UK - zoom to layer to check. If you don’t, check that you have added the file correctly. In particular check that you have chosen the correct columns to use for the x and y data.
[image: images/raster/GriddedRainfallData_small.png]
5 km gridded rainfall data for 2016 covering the U.K.
[bookmark: Xc973933a52305e91ea85eb200f54334369f73a1]Creating a new feature class with a subset of the data
For the analyses in these exercises you only need the rainfall data covering the same area as your dtm. You can restrict the data to that area at the same time as exporting it to a geopackage. This will save storage space and processing time.
[image: images/svg/videocam-black-24dp.png] Exporting a subset of a feature class
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Right-click on the Rainfall layer in the Layers panel
· Select Export > Save features as...
· Fill in the form as you have before, creating a new geopackage called Hebden Bridge
· This time put a tick in the box next to Extent and make sure you can see the boxes underneath.
· click on Calculate from layer and select your merged DTM layer - the North, South, East and West boxes should automatically fill.
[image: images/raster/SaveVectorAsExtent_small.png]
Saving just the rainfall points within the extent of the DTM layer.
· When you click OK to run the tool the output should be just those points which are within the extent of the merged DTM Layer.
· Remove the original Rainfall layer from your Layers panel to save time when the map redraws.
[image: images/raster/RestrictedRainfallPoints_small.png]
5 km gridded rainfall data for 2016 covering only the area selected in the Export tool - the area of your merged DTM.
[bookmark: X379a8708cba860388ba8ff0b055bfdc1b234178]Creating a new field with the Field Calculator
If you look at the attribute table for your rainfall layer you’ll see that you have monthly rainfall totals for each location.
For the analysis you will need to calculate the total rainfall for each location for 2016 rather than using the monthly totals.
Luckily you can do this in the attribute table within QGIS.
[image: images/svg/videocam-black-24dp.png] Using the field calculator in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Open the attribute table for the rainfall layer if you don’t already have it open.
· Click on the Open Field Calculator button at the top of the attribute table (the one that looks like an abacus), or use the keyboard shortcut Ctrl+I
[image: images/raster/AttributeTableToolbar_small.png]
The attribute table toolbar with the Open Field Calculator button highlighted.
The field calculator allows you to enter expressions to either update an existing field or create a new field. In this case we need to sum the existing fields.
· Check that Create a new field is already ticked
· Don’t tick Create virtual field.
· Below that give your field a new name such as TotalRainfall
· Set the Output field type to Decimal number (real) - if you look at your existing data it consists of decimal numbers
· Now set up the Expression
· The result will include unlimited decimal places, which is a bit silly in this case, so to limit it to two decimal places you can search for “round” in the Search box above the centre box - it will be under the Math list. Double-click on it to add it to the expression box then clear your search.
· In the centre box look for the Fields and Values section and drop it down to see a list of the fields in your feature class.
· Double-click on Jan to add it to the box on the left
· Then click on the + under the left-hand box
· Repeat this with each month field right up to December
· put a comma - , then the number of decimal places that you want - in this case 2
· Then close the brackets
Your expression should look as follows:
round("Jan" + "Feb" + "Mar" + "Apr" + "May" + "Jun" +
"July" + "Aug" + "Sep" + "Oct" + "Nov" + "Dec", 2)
The form will show a preview at bottom left - check that this looks as you would expect it to.
· Once you are happy with your expression click on OK
[image: images/raster/FieldCalculator_small.png]
Entering the expression to total the monthly rainfall totals for each location into the field calculator to create a new field.
Calculating the new field will have put the feature class into Editing mode, so save the edits and click on the “Pencil” icon to stop editing before you go any further.
· Check that the results look correct. The new field should appear at the right-hand end of the attribute table.
· Close the attribute table.
[bookmark: interpolating-your-data][bookmark: _Toc160015529]Interpolating your data
This feature class shows the total rainfall at each particular point. What do you do if you want to know the rainfall at any point between those points, or over an area? GIS gives you the tools to interpolate point data to a continuous raster surface and calculate z values, or totals, for the spaces between the points. Inevitably the accuracy of the surface will increase if you have more data points in a particular area, but it still works if your points are widely spaced.
[image: images/svg/help_outline-black-24dp.png] What are the potential issues with interpolation?
Think about the potential issues. How reliable do you think the results are likely to be? How can this be affected by the original data?
There are several methods of interpolation available in the QGIS toolbox. The instructions below use Spline (RST) but you can also try IDW.
[image: images/svg/videocam-black-24dp.png] Interpolating surfaces from point data
This video clip can be found in the module area of Minerva or in the full list of video clips.
ESRI, who make the ArcGIS software that we’re not using, have an article entitled Interpolating Surfaces in ArcGIS Spatial Analyst. Whilst that refers to their software not to QGIS, the principles are the same. Have a look at the article and their discussion of IDW and Spline amongst others.
The analysis tools in QGIS can all be accessed from the Processing Toolbox.
· Open the toolbox by going to Processing > Toolbox in the menu bar
The Processing Toolbox should open to the right of your map.
[image: images/raster/ProcessingToolbox_small.png]
The Processing Toolbox when you first open it, showing the main tools and tool providers.
There is a choice of tool providers in the toolbox. Depending on your settings you should see a series of QGIS logos denoting native QGIS tools, but there may also be GDAL, GRASS and SAGA. You should be able to use GDAL and GRASS.
[image: images/svg/create-black-24dp.png] If GRASS isn’t available…
If GRASS isn’t available, go to the Plugin Manager and check that GRASS GIS provider and Processing are both ticked. (GRASS 7 is something different. Don’t tick that, as it can be confusing!)
SAGA may well be greyed out or missing completely, but you won’t need to use it in this workbook.
For more information about the processing framework in QGIS see the page in the QGIS User Guide
To use the tools:
· Start by searching for Spline in the box at the top of the toolbox
· Several options should appear. Double-click on the one under the GRASS heading called v.surf.rst
· Fill in the resulting dialog as follows:
· The Input points layer is your rainfall points layer.
· The Name of the attributes column... is the one containing the total rainfall for each location.
· Drop down the section for Advanced Parameters.
· Under GRASS GIS 7 region cellsize type the value 5 - this means that your pixels will be 5 x 5 m, which will match your elevation raster.
· Go down the form to the Interpolated RST field, click on the three dots button at the end and then on Save to file...
· browse to the folder in which you want to save your output, then give your RST interpolated layer a name. Leave the tick under that box in place to load the layer into your map when the tool has run.
· Set the rest of the boxes below, which probably say [Save to temporary file], to [Skip output] so no extra data is produced.
· Now click on Run.
[image: images/raster/RSTInterpolationForm_small.png]
The form for RST interpolation.
[image: images/svg/info-black-24dp.png] Error messages whilst running GRASS tools
Error or warning messages are shown in red in the output while the tools are running. Warnings can usually be ignored.
For example, you’ll probably see one which says WARNING: Concurrent mapset locking is not supported on Windows. That’s a system warning, and not one which appears to make any difference to the end result.
If the tool doesn’t produce any output, have a good look at the ERRORs and see if you can work out what you need to change. Some of the error messages aren’t very helpful!
If the tool does produce output, have a look at it and check that it does what you expect it to.
The tool should run (it may take a while) and add a new layer to your map. If it isn’t added automatically drag it there from the Browser.
[image: images/svg/warning-black-24dp.png] Warning
If the tool doesn’t run but says that GRASS is not available make sure that you have ticked GRASS GIS provider and Processing in the Plugin manager.
The tool will have interpolated the surface from your data points. You should end up with something similar, but probably not identical to, the picture below.
[image: images/raster/RSTInterpolationOutput_small.png]
The output of the GRASS v.surf.rst tool.
[image: images/svg/help_outline-black-24dp.png] Looking at your data
If you look at the Layers panel you’ll be able to see the low and high measurements for the surface that you’ve just generated. Have a look at the attribute table of the points too. Do the measurements on the surface make sense in terms of the high and low of your original data?
If you look at the ESRI article on interpolation does that help you to understand why the surface may or may not vary from your original data?
[bookmark: X9a294c8efef7a169de68fcf656497bee7521158]Change the symbology of the raster surface
QGIS has probably used a default black to white colour ramp to display the rainfall surface, or it might have used a default colour ramp, but it should be possible to find a style which will be more informative for this raster layer.
You have already seen how to style a raster elevation surface. Styling this rainfall layer works in exactly the same way, so have a go at that now. If you browse through the choices of colours available you should be able to find a suitable one for precipitation.
You may also find that some parts of the raster on your map appear to be missing - it should cover a full rectangle. If this is the case, make sure you click on Classify under the colour table in the Layer styling panel.
[bookmark: raster-transparency]Raster transparency
In addition make the rainfall surface transparent as follows:
· In the Layer styling panel click on the Transparency tab on the left
· Use the Global Opacity slider to change the layer so that the data below shows through.
[image: images/raster/RasterTransparency_small.png]
Setting transparency in the Layer styling panel for a raster layer.
Play with the slider until you are happy that your layer is suitably transparent so that the background layers show through but the raster surface is still clear.
Alternatively or in addition, you can try blending modes to show your interpolated layer against the background.
Sometimes a combination of the Multiply blending mode and transparency works best.
[image: images/svg/create-black-24dp.png] Trying out other forms of interpolation
The article linked above should give you an idea of which form of interpolation is best for your data, but it’s worth experimenting.
Search for IDW in the processing toolbox and try out the tool listed under the QGIS Interpolation heading.
Compare the resulting surface with the RST surface. What differences and similarities do you notice?
[image: images/raster/InterpolationExample_small.png]
The interpolated and styled rainfall surface shown with the hillshade layer and the original point data. Don’t worry if yours looks a bit different to this - you’ll probably have made some different choices when styling your data.
[bookmark: watershed-delineation][bookmark: _Toc160015530]Watershed delineation
This section will give you more experience of running geoprocessing tools and also of keeping track of new layers.
Try to understand what each layer that you produce shows so that you can give it a name which makes sense if you come back to your project, and so that you can keep track of what you are doing. It isn’t always easy, so do ask if you find you are getting confused!
We’ll be generating an outline for the watershed for the Hebden Water.
A watershed, or catchment, shows the area over which any rain that falls will drain into a particular watercourse. Once we have the outline we can combine it with the rainfall layer to see how much rainfall fell in the catchment during 2016.
Catchment boundaries are often used for environmental analyses. Generating your own watersheds from a DTM is not difficult but can be complex. As with many things in GIS there is more than one way to do it. I’ve chosen a simpler way here, which is sufficient for what we will be doing with it, but it does mean that you don’t have as much control over the final output. If you want to be able to specify a watershed based on a particular stream or outflow then you can follow the more complex workflow shown in this video on Stream and catchment delineation in QGIS 3.
Once you have delineated a watershed, or basin, you can use the boundary with other tools to limit the processing area of other datasets.
[bookmark: preparing-your-map]Preparing your map
You should already have a merged DTM layer from Digimap Terrain 5 DTM data in your map and will be using that to generate the watersheds. Make sure that you have it at the bottom of the list of layers in the Layers panel - you don’t need to be able to see it all the time. You can make it invisible if you want to.
You will also have the rainfall layers that you imported and interpolated. Make those invisible for now, you won’t need to use those until later.
In addition you should have a background map made up of Digimap Ordnance Survey VectorMap District data. Make sure this is visible and above the dtm layer so that you can see it. You will need this for checking locations.
· Save your map now you have it set up!
[bookmark: getting-a-rough-idea-of-the-output]Getting a rough idea of the output
Before you start to run the tool it would be a good idea to get a rough idea of what sort of area the final watershed should cover.
Start by having a look at the Hebden Water and its tributaries.
You can search for a particular coordinate in the Type to Locate box, as well as for features.
· Click in the Type to Locate box at the bottom left of the map, or use the keyboard shortcut Ctrl+K
· Type the following to be taken to the outflow of the Hebden Water
go 399078 427154
Your map should pan so that point is in the centre of your map, and a small (rather inconspicuous) dot should flash.
If you don’t catch it the first time, you can always click back in the box and double-click again.
The Hebden Water is the river which goes up to the north-east from this point which is in Hebden Bridge.
Pan and zoom so that you can follow the river up and get a rough idea of the sort of area that its watershed is likely to cover. Being able to see the hillshade will probably help as you should be able to get a bit of an idea of where the highest hills around the river are.
This will help you to evaluate your results when it comes to running the watershed tool in QGIS.
[bookmark: running-the-watershed-tool]Running the watershed tool
You have run plenty of tools by now and should be getting used to them. Of course, sometimes you open one you’ve never used before and have no idea what anything does! There can be a lot of trial and error and searching online involved in working out which tool is best for your purposes.
So let’s have a look at how you can approach experimenting with a new tool.
[image: images/svg/videocam-black-24dp.png] The r.watershed tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· You’ve been asked to generate a watershed, so in the Processing Toolbox search for watershed and open the r.watershed tool from the GRASS > Raster toolbox.
The form may open with the help visible on the right-hand side, but this is nothing if not minimal. I usually just close it!
· Set your merged DTM as the Elevation at the top of the form
· I’m guessing that a lot of the other fields won’t mean much to you, but most of them are marked as [optional] so let’s ignore them for now.
· Try just clicking on Run and see what happens!
In my case doing this resulted in a lot of red errors in the Log panel and no output. It may have caused QGIS to crash on your computer - though it can be worth waiting for a short while even if it looks as if a tool is Not responding. Sometimes they resolve themselves.
[image: images/raster/LogErrorsWatershed_small.png]
ERRORs in the r.watershed log. They are displayed as red text.
It’s always worth having a look through the log to see whether you can solve any of the errors, but often they still don’t make sense.
The next step would often be to search the web for help - either in the QGIS manual or maybe someone will have put up a tutorial on how to use this tool.
In this case, I’ll walk you through how you actually need to fill in this form.
· Return to the Parameters tab, or reopen the r.watershed tool if you need to.
· Set your merged DTM as the Elevation at the top of the form
· Go down to the box which says Minimum size of exterior watershed basin [optional].
It turns out that the minimum size of the exterior watershed basin is key to the output. This is the smallest watershed basin that you will generate and working out what number you need to put in here is a bit of trial and error based on the expected ball-park extent of the watershed. The number is the area of the basin in pixels, which in this case are 5 x 5 metres.
· Start by setting the Minimum size of exterior watershed basin to 5000 (three zeros)
· Continue down the form and put a tick next to Enable Single Flow Direction (D8) flow
· Change all the output files to [Skip output] except Half-basins - you can leave this as [Save to temporary file]
· Click on Run then wait for the tool to run. Again, it could take a while, and if QGIS says Not responding, just wait and don’t try and click on anything!
· Don’t close the tool but move it out of the way so that you can see your map.
You should have a new layer called Half-basins and with the temporary layer symbol (a small, square spider-type icon) next to it in the Layers panel. If you can’t see it on your map move it upwards in your Layers panel so it is above any other layers.
[image: images/raster/HalfBasins5000_small.png]
The output for the Half-basins layer when minimum size is set to 5000.
This all looks rather alarming! Yours may be in shades of grey rather than coloured like the example above, but it’s still the same data. If you want to see the coloured version, open the Layer styling panel, select Paletted/Unique values and click Classify.
In effect this is lots of small half-watershed basins for each small stream on the map. If you think back to your exploration of the Hebden Water and the estimated size of its watershed, obviously 5000 is not the minimum area to go with!
· Remove the Half-basins layer from your map then go back to the parameters in the r.watershed tool
· Change the Minimum size of exterior watershed basin to 50000 (four zeros) and Run the tool again.
Is the output any better? Does it look anything like the area that you would expect yet? Probably not!
[image: images/raster/HalfBasins50000_small.png]
The output for the Half-basins layer when minimum size is set to 50000.
· Remove the Half-basins layer from your map again then go back to the parameters in the r.watershed tool
· Change the Minimum size of exterior watershed basin to 500000 (five zeros) and Run the tool again.
Is the output any better? Does it look anything like the area that you would expect yet?
[image: images/raster/HalfBasins500000_small.png]
The output for the Half-basins layer when minimum size is set to 500000.
Given that these are half-basins, this is looking much better. The half-basins are much larger. If you go to the coordinates of the outflow of the Hebden Water again (GR 399078 427154) you’ll see several (probaby six) basins meeting at this point, and two of those are the ones that we want.
· You can Close the r.watershed tool now.
Remember the output is a temporary file. If you want to stop working now you’ll need to Export it to a permanent format. Otherwise, temporary is fine as this isn’t our final output.
[bookmark: vectorize-the-half-basins]Vectorize the half-basins
The icon next to the Half-basins layer in the Layers panel shows that this is a raster layer.
For the next few steps, we’ll need to use a vector version of this layer.
· From the toolbox select the Polygonize (Raster to Vector) tool
· The input is the raster half-basins layer.
· The output can be left as a temporary file as it won’t be our final data. (Note, though, I found I couldn’t run the tool unless I saved the output as a GeoPackage! So if you get errors, try saving the output.)
· The rest of the settings can be left as the defaults.
The output should be a vector layer called Vectorized which has the same outlines as the raster file.
[bookmark: selecting-the-correct-watersheds]Selecting the correct watersheds
If you make the vector half-basins layer transparent and turn off the raster half-basins layer, you should be able to see that the boundary between two of the half-basins fairly well follows the river upstream. These are the two that we want.
· Use the Select Features by area or single click tool from the toolbar
· Click on each of the two half-basins in turn, holding down the Ctrl key to select both. They should look like the bright yellow selected features in the image below.
[image: images/raster/SelectedHalfBasins_small.png]
The half-basins of the Hebden Water selected.
We can convert these to a single polygon and save as a new layer at the same time.
· On the menu bar go to Vector > Geoprocessing Tools and have a look at the choices available to you. The little icons are very useful!
· The tool we need is Dissolve which combines features into new features, so click on that.
· The input layer is the temporary vectorized layer.
· Tick Selected features only.
· Under Dissolved click on the three dots button to save the output to a geopackage. This is the final result that we need. You can save it to an existing geopackage and give the layer the name Watershed.
· Run the tool.
The output, once symbolised as an outline with no fill, should look something like the image below.
You can remove all the temporary layers as those are no longer required.
[image: images/raster/Watershed_small.png]
The final watershed symbolised as an outline with no fill to show the watershed of the Hebden Water.
[bookmark: suggested-layout-1][bookmark: _Toc160015531]Suggested layout
Use the layers that you have created to layout a map similar to the one below. Include your chosen interpolated rainfall surface, a hillshade layer and a topographic background layer. Don’t forget to include the usual map elements, such as title, key, scalebar etc. Refer to the Layout and presentation chapter for ideas and instructions.
[image: images/raster/FinalMap1_small.png]
An example of a final map of the total rainfall of the Hebden Bridge area in 2016.
[bookmark: next-practical][bookmark: _Toc160015532]Next practical
Please note that the next chapter is raster analysis part two. You will need the output and project from the exercises here to complete the exercises in part two, so make sure that you keep it all. Try to make sure that you remember where you have stored the files, and what you have called them.
[bookmark: recommended-reading-for-raster-analysis][bookmark: _Toc160015533]Recommended reading for Raster analysis
Many of the books in the reading list[footnoteRef:25] have general information about elevation data. Suggestions include the following: [25:  The reading list is available in Minerva and from the library (search for the number of this module).] 

Heywood (2011), Chapter 6, p. 198-217. Sections on Spatial Interpolation and Analysis of Surfaces.
Longley (2011), Section 13.3.6, p. 313-317. Spatial Interpolation and Section 15.3. p. 386-393. Analysis of Surfaces.
[bookmark: further-information]Further information
Hans van der Kwast from the IHE Delft has created a series of videos with in-depth information about various GIS subjects. His video on Raster Processing would be helpful for the background to this chapter and it would also be worth looking at his other theory videos for help with other chapters. His practical video clips are also very good and he does use QGIS.
[bookmark: raster-analysis-2][bookmark: _Toc160015534]Raster analysis 2
Last Modified: 17 Jan 24, 09:24:45
The background to raster analysis will be covered in the lecture segment at the beginning of the class, and the presentation and any other supporting materials will be available in Minerva. The lecture segment should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-8][bookmark: _Toc160015535]Learning outcomes
When you have completed this section of the workbook you should be able to
· Demonstrate the use of masks to limit processing areas and explain the reasons to do so
· Use the raster calculator to build expressions in order to analyse raster layers
[bookmark: introduction-6][bookmark: _Toc160015536]Introduction
In the previous chapter, Raster Analysis 1, you looked in more detail at the properties of GIS raster files and how these make a difference to settings and usage. You ran some of the raster processing tools available in the toolbox to interpolate a grid from point data and to delineate a watershed or catchment area.
In this chapter, Raster Analysis 2, you’ll do further raster processing using more advanced tools from the toolbox including the Raster Calculator.
[bookmark: data-for-this-chapter][bookmark: _Toc160015537]Data for this chapter
For the exercises in this chapter you will need the project for the Hebden Bridge area that you worked on in the previous chapter - including the output that you created.
You will also need to download a new geopackage - CrimsworthDean.gpkg from Minerva.
If you wish to save some disk space and tidy up your files then you can delete the original Terrain 5 dtm files. You only need to keep the merged dtm. If by some chance you do need the files again after deleting them, you can either unzip them from the original download or download them again from Digimap.
[bookmark: using-a-vector-mask-to-clip-a-raster][bookmark: _Toc160015538]Using a vector mask to clip a raster
For the exercises in this chapter it would be useful to restrict further geoprocessing to the area of the Hebden Water watershed.
[bookmark: Xe95cf4410608067c2e15cdbfa88fab162c61c7f]Clipping to extent vs. clipping to a mask
In the elevation chapter we clipped the DTM to the extent of the study area vector layer. That left us with a raster layer containing data for the whole area, including the parts of the raster outside of the Lake District National Park.
This time, we want to clip the raster so we only have data within the watershed of the Hebden Water. The raster will still be rectangular (i.e. still have the same extent), but this time the area outside of the watershed will have a nodata value, and therefore won’t be included in our calculations.
[image: images/svg/help_outline-black-24dp.png] Why limit processing area?
What do you think are the advantages of restricting your datasets and processing tasks to a smaller geographic area?
[bookmark: clipping-the-raster]Clipping the raster
We’ll start by clipping the Terrain 5 merged DTM to the area of the watershed.
To clip the raster to the correct area you need a vector layer to use as a mask. This should contain a single polygon covering the area you wish to analyse. Luckily we already have a layer that will do this job for us - the Hebden Water watershed.
[image: images/svg/videocam-black-24dp.png] Using a vector mask to clip a raster in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· From the menu bar go to Raster > Extraction > Clip raster by mask layer...
· The Input layer will be the merged dtm
· The Mask layer will be the vector polygon watershed layer
· Under Assign a specified nodata value to output bands enter -9999 - this will tell QGIS not to display this part of the output or use it in analysis
· Tick to Match the extent... and Keep resolution of the input raster.
· Under Clipped (mask) use the three dots button to browse to where you want to store the output and give the output a name.
· Click on Run
[image: images/raster/ClipRasterByMaskLayer_small.png]
Clipping the Terrain 5 merged DTM to the outline of the Hebden Water watershed.
Hopefully a new layer will be added to your map. It should look very similar to the original dtm layer, but this time it will only fill the area within the watershed. Turn the rest of the layers off if you want to check this.
[image: images/raster/ClippedRasterDTM_small.png]
The DTM raster clipped to the watershed boundary.
[image: images/svg/create-black-24dp.png] Check the processing area
Check that this works to restrict processing by running the hillshade tool with the clipped dtm as the input. Check where the new hillshade layer is generated for - it should just be within the watershed.
[bookmark: raster-statistics-1][bookmark: _Toc160015539]Raster statistics
At the moment the interpolated rainfall surface that you generated in the previous chapter covers a larger area than the watershed. If we want to work out the total rainfall that fell on the watershed during 2016, but not include anything from outside of the watershed, we’ll need to restrict it to just that area first.
[image: images/svg/create-black-24dp.png] Restricting the rainfall surface to the watershed
Above you used the vector watershed layer to clip the dtm raster. Repeat the process, but this time clip your interpolated rainfall surface to the watershed.
Once you have the output rainfall change the symbology as you did for the whole raster.
[image: images/raster/ClippedRasterRainfall_small.png]
The clipped rainfall layer. Yours may well look different as you probably chose different styling.
[bookmark: background-to-raster-statistics]Background to raster statistics
GIS carries out three main categories of operation on rasters: Local; Neighbourhood and Zonal.
· Local operations work on a cell-by-cell basis - reclassification is an example of this and you’ll be doing more of that soon.
· Neighbourhood operations involve a focal cell and its surrounding cells - terrain analysis such as slope and aspect are examples of this.
· Zonal operations work with groups of cells with the same values or similar features, for example zonal statistics.
You have a raster showing the annual rainfall for 2016 for the Hebden Water watershed, now how do you use that to calculate statistics for the area, such as the mean rainfall or the total sum?
[bookmark: using-the-zonal-statistics-tool]Using the Zonal Statistics tool
We’ll use the Zonal Statistics tool from the QGIS toolbox as that puts the statistics into a table that we can store and look at later too.
[image: images/svg/videocam-black-24dp.png] Using the Zonal Statistics tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Processing Toolbox search for the Zonal Statistics tool and open it
· Under Input layer you’ll need to choose the vector watershed layer
· Under Raster layer select your clipped rainfall layer
· Click on the three dots button next to Statistics to calculate and tick the statistics you require. In this case go for at least:
· Count
· Sum
· Mean
· Click on OK to go back to the form and click on the three dots button at the end of the Zonal Statistics field
· Select to Save to file... and navigate to where you want to save the output. Give it a name and set the Save as type: to csv
· Click Save, then click on Run
[image: images/raster/ZonalStatisticsForm_small.png]
Filling in the Zonal Statistics form.
The output will be saved to your computer, but also added to your Layers panel as a table.
To view the results within QGIS:
· Open the attribute table of the new layer
You’ll have an attribute table with just one row. That row will include the statistics that you chose to calculate for your rainfall within the watershed.
[image: images/raster/RainfallStatistics_small.png]
The attribute table of the output from the Zonal Statistics tool.
In this case we were looking for the sum rainfall in this area in 2016. In other words, the total amount of rainfall that could potentially flow through the outflow of the watershed.
The _sum field above shows the sum total of all the pixels in the clipped raster.
You should be able to view the csv output outside of QGIS by opening the file in a spreadsheet program or text editor.
It is also possible to save the output as other GIS formats, but in those cases you will need to export the output to csv to view it outside of GIS.
[bookmark: using-the-raster-calculator][bookmark: _Toc160015540]Using the raster calculator
Once you have a raster containing data it isn’t usually a case of just editing it to make changes. Instead there are plenty of tools which will help you to combine, clip, and alter the data in a raster.
The raster calculator allows you to perform calculations on the pixels or cells within a raster layer. The results are written to a new raster layer.
[bookmark: converting-the-units-of-the-dtm]Converting the units of the dtm
[image: images/svg/videocam-black-24dp.png] The raster calculator in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Just as an example, let’s convert the dtm data from the current units of metres, to feet. This involves multiplying the measurements in metres by 3.281.
[image: images/svg/help_outline-black-24dp.png] DTM in metres
In the layers panel have a look at the dtm that you clipped to the watershed boundary. What are the minimum and maximum values for height?
Now let’s do the conversion.
· To open the raster calculator go to Raster > Raster calculator on the menu bar.
The raster calculator should open and look something like the following.
[image: images/raster/RasterCalculator_small.png]
The raster calculator when it is first opened.
The panel at the top-left should include a list of all the raster layers in your project (note that rasters have to be in your map to be used in the raster calculator).
The panel to the top-right sets the layer to which to write the results. You have to fill in an output layer or the tool won’t run. The default format is usually GeoTIFF.
The panel at the bottom is where you compile the expression that you wish to use and the operators above will help you to do that.
· Start by setting the Output Layer by clicking on the three dots at the end of the line and browsing to where you want to store your output.
· To limit the extent you can click on one of the layers in the raster bands list and then click on Selected Layer Extent - do this now with your clipped dtm.
· Now build up the Raster Calculator Expression by first double-clicking on the clipped dtm layer in the Raster Bands panel
· Next click on the * under Operators
· Then click in the expression box and type the number 3.281
· If you’ve done it correctly it should say Expression valid under the expression box. Once that happens click on OK.
[image: images/raster/MetresToFeet_small.png]
Converting dtm metres to feet with the raster calculator.
The new layer which appears on your map should look the same as the original clipped dtm layer but if you look at the Layers panel the values should now be much higher. You can easily check that they are correct by using the Identify Features tool on the map, then multiplying the metres value for one location by 3.281.
· This is only an example. You won’t need the DTM in feet again, so remove this layer from your map so it doesn’t confuse you later.
[bookmark: using-a-mask]Using a mask
With the raster calculator you can mask out certain parts of a raster. For example, if you have a rainfall raster which you want to restrict to areas that you consider high rainfall.
[image: images/svg/videocam-black-24dp.png] Setting a mask with the raster calculator in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
For the purposes of this exercise let’s say that we are only interested in the areas with total rainfall in 2016 of equal to or above 1350 mm.
If you look at the clipped rainfall raster for the Hebden Water watershed, the values range from approximately 1160 to 1431, so we want to mask the lower values.
· Open the raster calculator and set the result layer. Give it a name indicating it shows areas of high rainfall, and set the extent to the same as the clipped rainfall layer.
· In the Raster Calculator Expression use the Raster Bands and Operators to build up the following expression
("clipped_rainfall@1" >= 1350) * "clipped_rainfall@1"
Effectively you are building up a conditional statement. If part of the statement evaluates to true for a particular cell it will be given the value 1 otherwise it will be given the value 0. So in the first part of the expression, if a cell has a value above or equal to 1350 it will have the value 1. This means that in the second part of the expression when cells are multiplied by their value in the original raster, the cells with a value of 0 will be given that value (multiplying by 0 always gives the answer 0), while the cells with a value of 1 will regain their previous value.
Don’t worry if this seems complicated! I have to stop and think it through each time I use the raster calculator. There are examples in the QGIS user manual which may help too, though these examples were based on those.
· Once your statement is evaluated as valid, click on OK to run the expression.
The output should be added to your map, but may look rather odd. (It keeps reminding me of Belted Galloway cattle!)
[image: images/raster/MaskedRainfall_small.png]
The masked rainfall layer when it is first added to your map.
To display it properly you need to style it.
· Go to the Layer Styling panel and click on the Transparency tab.
The areas that you don’t want to display should have a value of 0. Check this with the Identify Features tool if you want to be sure. To prevent these areas from displaying you need to tell QGIS that 0 is a no data value.
· Next to Additional no data value enter the figure 0.
The areas with a value of 0 should disappear from your map.
· While you are on the transparency tab set the Global Opacity so that any layers underneath the rainfall layer will show through.
· Now return to the Symbology tab and style the remaining data with a colour ramp in the usual way so that the layer looks something like the image below.
[image: images/raster/MaskedRainfallStyled_small.png]
The styled rainfall showing only the areas with total rainfall above 1350 mm in 2016.
[bookmark: reclassifying-a-raster-1]Reclassifying a raster
In this section we’ll look at how it is possible to use the raster calculator to reclassify a raster to extract areas which agree with certain criteria. The example we will use is simulating flooding with a dtm, but there are plenty of other potential applications.
In the previous example, we kept the original values from the rainfall layer. This time we only want to indicate that a particular criteria is true. So we are reclassifying the raster as two values - in effect, true and false.
[image: images/svg/videocam-black-24dp.png] Reclassifying a raster with the raster calculator in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
Imagine that there is a plan to build a reservoir where Crimsworth Dean Beck runs into the Hebden Water.
If you haven’t already, download the file CrimsworthDean.gpkg from Minerva and save it to the folder for this project to use for this exercise.
The geopackage contains a feature class called CDWatershed - add that to your Hebden Bridge map. We’ll use this watershed to limit the potential reservoir to the valley above that point rather than flooding the whole of the area of the DTM under that height.
Don’t worry if the outline of the Crimsworth Dean watershed doesn’t completely line up with the outline of your Hebden Water watershed. There is some variation in processing and in this case that doesn’t matter as long as they are fairly similar.
[image: images/raster/CrimsworthDeanBeck_small.png]
The watershed of Crimsworth Dean Beck (blue) within the Hebden Water watershed (red outline).
If you have a raster which goes down to sea-level you may well not need to use a watershed. If the flooding came from the sea then you are unlikely to need the watershed to restrain it, in fact it could well be misleading.
[bookmark: X7df8870a75796083cd07ddd72c4d8b3a2fce318]Clip the DTM to the Crimsworth Dean watershed
· Use the Crimsworth Dean watershed to clip the dtm again to this smaller area.
Use this smaller clipped version of the dtm for the rest of the steps in this section.
[bookmark: finding-the-height-of-the-initial-point]Finding the height of the initial point
Before we can reclassify the raster to show flooding we need to know the height of the land at the point where the dam is to be built.
To find this, use Type to Locate to find the following grid reference:
398862 429076
Check that your Terrain 5 dtm layer is visible (the original one in metres, not the one in feet). Then use the Identify Features tool to find out the value of Band 1 at that point - checking that it is just within the Crimsworth Dean Beck watershed and on the beck itself. That value will be the height above sea-level in metres - make a note of it for later.
[bookmark: Xe53e825910d44d304dccf52ac45a25cfa37b35b]Reclassifying the raster with the raster calculator
· Open the raster calculator and set the result layer. Give it a name, which could be something like Reclass30, where 30 indicates you’re reclassifying to 30 m above the lowest point, and set the extent to the same as the dtm layer you clipped to the Crimsworth Dean watershed.
· Use the Raster Bands and Operators to set up the following expression where clipped_dtm@1 is the dtm layer clipped to the Crimsworth Dean watershed.
"clipped_dtm@1" < (132.6 + 30)
where 132.6 is the height above sea-level that you made a note of earlier - use the height above sea-level you found, which may well be different to mine. 30 is the figure below which we want to “flood” the raster.
· When your statement is valid, click on OK.
The output should be black and white, with one area indicating a value of 0 and the other a value of 1. There should be a small area close to the confluence where the cells have the value of 1. This is the flooded area.
[bookmark: X6c1ece2193150f904df807a57b861cce16a0b1d]Converting the result to a vector polygon
In many cases it will be most useful to have the output as a vector polygon. This is a very similar process to that we used to convert the viewsheds in the elevation chapter so have a go at that now. Make sure that the area that you keep is the small part near the outflow of Crimsworth Dean Beck. It should look something like the image below if you delete the vector feature with a value of 0.
[image: images/raster/CrimsworthFlooding30_small.png]
The flooded area with a height of 30 m above the outflow of Crimsworth Dean Beck.
[bookmark: Xa0c6934ec9d91d2f00c8437f9c887fe27546ba1][bookmark: _Toc160015541]Reclassifying rasters with Reclassify by Table
The section above showed you how to reclassify a raster using the raster calculator. That is a very flexible way of doing it, and often gives you more control, but it’s also useful to know how to use the Reclassify by Table tool, particularly if you want to use batch processing.
We’ll carry out the same task again so that you can compare the results.
[image: images/svg/videocam-black-24dp.png] Reclassifying a raster with Reclassify by Table in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
We want to flood the valley up from the confluence of Crimsworth Dean Beck with the Hebden Water to a maximum depth of 30 m. You should already have a note of the height above sea-level of the outflow of Crimsworth Dean Beck.
· In the Processing Toolbox search for Reclassify by table and open the tool from the Raster Analysis section.
· Under Raster layer select your Crimsworth Dean clipped dtm (metres not feet)
· Click on the three dots button next to Reclassification table
· In the table click on Add Row
· Then click in the boxes on the row and set as follows
· Minimum = 0
· Maximum = the height at the outflow, plus 30 m. e.g. 162.6.
· Value = 1
· You can set multiple classes here, but we only need one.
· Click on OK
[image: images/raster/ReclassTable_small.png]
The table for reclassifying.
· Drop down the Advanced Parameters.
· Set Output no data value to -9999.
· Tick next to Use no data when no range matches value.
· Select Output data type as Int16 - we won’t need any decimal places for the output.
· Set Reclassified raster to your output location and give it a name.
· Click Run.
[image: images/raster/ReclassifyByTable_small.png]
The Reclassify By Table form. Note the settings under Advanced Parameters.
Once the tool has run you should find that you have output very similar to that from the raster calculator. Though because you set the no data, you won’t see that on the map.
[image: images/svg/create-black-24dp.png] Compare the two results
Again, polygonize the result and compare it to the result from the raster calculator.
I said earlier that this method will work better if you need to use batch processing. Use the Reclassify by Table tool in batch processing mode to produce polygons showing the size of a reservoir for dams of the following heights at the outflow of Crimsworth Dean Beck:
40; 50; 60; 70 and 80 m.
[bookmark: final-map-for-this-chapter][bookmark: _Toc160015542]Final map for this chapter
For your final map for this chapter polygonize the potential reservoir sizes and present them as possible alternatives to show the effect of each height of dam.
The outlines will look rather “square”. This is because they were generated from a raster layer consisting of 5 m pixels. Those 5 m still show as part of the outline. One solution to this that you could try is to use the Vector geometry Smooth tool from the processing toolbox.
[image: images/raster/FinalMap2_small.png]
Possible final map for this chapter showing possible reservoir sizes for different dam heights on Crimsworth Dean Beck.
Once you have completed your map, export it as either an image or a pdf.
[bookmark: next-chapter][bookmark: _Toc160015543]Next chapter
The next chapter on downloading and using census data follows on from this one. You’ll need your Hebden Bridge map again, so save it now.
[bookmark: Xf2e2be41a1beef13d16f46357f448f1a11beb89][bookmark: _Toc160015544]Recommended reading: Raster analysis and reclassification
Refer back to the recommended reading at the end of the Raster 1 chapter.
[bookmark: further-information-1]Further information
You can find more about the raster calculator in the QGIS user guide.
· QGIS user guide on the raster calculator
· QGIS Tutorials and Tips has a tutorial on Basic Raster Styling and Analysis which is basically a guide on how to use the raster calculator with gridded population data.
[bookmark: Xd0b06d39288d9028ea43c1e2854e172113d3a86][bookmark: _Toc160015545]Census data for England and Wales: Census 2021 edition
Last Modified: 24 Jan 24, 12:16:54
The background to census data will be covered in the lecture, and the presentation and any other supporting materials will be available in Minerva. The lecture should help you to understand why you are doing these exercises. If you still aren’t sure, please ask Clare.
[bookmark: learning-outcomes-9][bookmark: _Toc160015546]Learning outcomes
When you have completed this section of the workbook you should be able to
· Download data from the 2021 UK census for use in GIS.
· Demonstrate how to prepare data for a limited area from larger datasets.
· Explain how to join attribute data to a feature class in QGIS.
· Combine census data with other data in a GIS to answer questions.
[bookmark: introduction-to-the-census][bookmark: _Toc160015547]Introduction to the census
In the previous two chapters you were looking at the watershed, or catchment, of the Hebden Water north of Hebden Bridge, and the rainfall in that area which is prone to flooding.
To find out more about the population for the area we’ll download the census data for this area and use that to work out how many people live within the catchment of the Hebden Water.
[image: images/svg/info-black-24dp.png] Other sources of population data
The census isn’t the only source of population data for the UK.
The Office for National Statistics also publishes Population Estimates for various area geographies and at annual intervals. These can be invaluable for looking at population change, or for officially-produced statistics in the years between censuses.
The national census is a tremendous source of data about the population of Great Britain, but it is not always easy to find what you need.
The census takes place every 10 years, the latest one being in 2021, and collects data from every person resident in the UK on a particular date in that year, usually in March. Very general data is released first, with more detail being made available later, though the full personal data is only made available after 100 years. [footnoteRef:26] [26:  Find more information about the census on the website of the Office for National Statistics.] 

We will be using data from the 2021 census for these exercises. As of February 2023 this is being made freely available online, with more appearing as analysis and breakdown is completed.
A lot of the data is based around social identifiers, such as type of house, or occupation, but the Office for National Statistics also provide key sets of data which can be combined with physical data to allow useful analysis. For example, in conjunction with viewshed analysis, population data extracted from the Age by single year of age dataset can be used to find out approximately how many people live within sight of a proposed wind farm or would be affected by other types of development.
[image: images/svg/create-black-24dp.png] See an interactive map of census data
The Office for National Statistics Census maps allow you to play around with different data and view the results on a map. Zoom in to see more detail.
Try looking at the percentage of houses with four or more bedrooms in Hyde Park compared to most other parts of Leeds, or where are people with professional qualifications most likely to live in Leeds? Think about why the distribution is like that.
[bookmark: downloading-uk-census-data][bookmark: _Toc160015548]Downloading UK Census data
[image: images/svg/warning-black-24dp.png] Warning
Some of the data we will be downloading and processing in this chapter will take up quite a bit of space, for example, you will need at least 1.5 GB of space to be able to download and unzip the census data.
The data for the 2021 England and Wales Census is freely available for download from the Office for National Statistics (ONS) Nomis interface.
The data from Nomis needs to be joined with boundary data, also from the ONS, to display in GIS. You will also be shown where and how to download this and how to link it to the population data from the census.
[bookmark: downloading-census-data-from-nomis]Downloading census data from Nomis
Nomis has an overview page for the 2021 Census with links to both summaries about the topics and bulk data downloads.
· Go to the Bulk data downloads page on nomis.
· Have a look at the information at the top of the page. The links here allow you to download bulk data by single census datasets.
We are going to download age data and use that to show total populations for output areas.
· Once you’ve read the information in the introduction to the bulk downloads, look under the Demography and migration heading for TS007A Age by five-year age bands.
· Download the zip file to the right of the category - census2021-ts007a.zip
· Save the zip file to a folder for this project, then unzip the data.
You should have a series of .csv files. The final few letters of the file name show the level of census boundary into which the data is divided.
[image: images/census2021/UnzippedDataSets_small.png]
The downloaded census2021-ts007a.zip file with the contents also listed.
You can see a diagram of the different statistical geographies for the UK in an ONS document (Downloads as pdf).
We will be using Output areas as our geographical units and those are included in the census2021-ts007a-oa.csv file. These are the smallest statistical building blocks available.
[image: images/svg/info-black-24dp.png] Why five year data instead of single?
Data isn’t available at all levels of detail for all categories, which is why I’ve suggested data for five-year age bands, not single year of age, as otherwise we wouldn’t be able to use Output areas, which are a smaller geographic area than most of the other options.
[bookmark: downloading-boundary-data-from-the-ons]Downloading boundary data from the ONS
The census data is provided in spreadsheet form and doesn’t include GIS location information. We will need to download boundary data from the ONS separately and join the two datasets together.
To download boundary data:
· Go to the ONS Geoportal.
· Use the search box near the top of the screen to search for Output Areas and look in the resulting list for Output Areas (2021) Boundaries EW BFC. Click on that heading.
The result should be a map of England and Wales. This is a large dataset, so it probably won’t be displayed on the map unless you zoom further in. You don’t want to download the whole dataset as it is very large.
To restrict the dataset:
· Search for Hebden Bridge in the search box at the top of the map and press Enter to zoom to the town.
· Zoom out by clicking on the minus button three times.
· Click on the Filter symbol on the left of the map and set Filter as map moves to on by moving the slider to the right.
· Now click on the Download icon and next to Toggle Filters check that the slider is also to the right.
This should restrict the number of records to be downloaded. The original is something like 188,880 records, but once you’ve set the filters, you should get a much lower number listed above the Toggle filters slider. Mine read Records: (Filtered) 5,342. This is a much more manageable download!
To actually download the data:
· If you’re not already on the Download tab, click on the Download button to get a choice of download formats (they should be listed to the left of your window).
· Click on the Download button under GeoPackage.
The download could take a while, so be patient.
As usual, save the resulting file to your project folder. The result should be a GeoPackage with the extension .gpkg.
[image: images/svg/create-black-24dp.png] Download Local Authority Boundaries
There is another boundary it will be useful to have to be able to restrict the more detailed data to our area of interest.
• Go back to the data portal and download the Local Authority Boundaries by searching for:
• Local Authority Districts.
• Download the Local Authority Districts (December 2021) BG BFE data. Again, as a GeoPackage.
[bookmark: adding-census-and-boundary-data-to-a-map][bookmark: _Toc160015549]Adding census and boundary data to a map
Once you have downloaded a csv text file (also known as attribute data) containing census data, and separate boundary data, you need to tell QGIS how to link the attribute data in the csv file to the boundary data in the shapefile. To do this you will join the data.
[bookmark: preparing-the-census-data]Preparing the census data
We need to start by cleaning up the csv file containing the age/population data so that it will work in QGIS.
CSV stands for Comma-separated value and stores data as a series of rows with the columns separated by commas. Csv files will open in either a text editor or a spreadsheet program, such as Excel. It is much easier to do operations such as deleting columns in a spreadsheet rather than a text editor.
· Open the census2021-ts007a-oa.csv file in a spreadsheet program such as Excel (note that Excel on the web won’t save csv files as csv, but it is possible to save them as xlsx, which will also work with QGIS.)
· Check that the data matches that seen below - that is
· date, giving the year
· geography which contains codes for particular output areas
· geography code which contains the same codes for particular output areas. As we already have geography, this column isn’t necessary and can be deleted.
· and a column, Age: Total, which contains the number of persons in each output area.
· There are also a series of columns containing the number of persons in each five year age group in each output area. We don’t need these, so it’s fine to delete those columns.
[image: images/census2021/CensusDataCSV_small.png]
The columns and data in the census csv file as they appear in a spreadsheet program.
· Check column headers.
· For import to GIS it is usually best to use headers that start with a letter, and don’t contain spaces or punctuation, though I found this still worked when I didn’t. But rename the column headers if necessary. If you’ve deleted all the columns you don’t need, this should be a bit easier!
· Save the file as either .csv or .xlsx and close it.
· Open a blank map in QGIS, if it isn’t already open
· Add the csv file or spreadsheet to your map as a layer in the usual way by dragging and dropping it from the Browser panel. Don’t use the spreadsheet plugin to add this spreadsheet - it won’t help.
The table should appear in the Layers panel but not on the map. You’ll see a table icon next to it in the Layers panel.
[image: images/census2021/TableIcon_small.png]
The census data table, showing the icon on the Layers panel.
· If you right-click and open the attribute table, it should look the same as your edited csv file.
[bookmark: adding-the-boundary-data-to-a-map]Adding the boundary data to a map
The csv data refers to output areas by a code, but doesn’t contain the geographic data QGIS needs to be able to display it on a map. For that, we need to start with the appropriate boundary data.
· Add the output areas boundaries to the same map you added the census data to. You’ll need to look inside your output areas GeoPackage and add the layer from there to your map.
· Check that the map CRS is set to EPSG:27700. If it isn’t, set it now and also check that the output areas CRS is EPSG:27700.
[image: images/census2021/OutputAreasAll_small.png]
Lots of small polygons which make up the Output Areas for the area around Hebden Bridge.
This layer may take a while to load. Your layer will probably show at least a slightly different area to mine - that doesn’t matter.
[bookmark: restricting-the-data-to-calderdale]Restricting the data to Calderdale
As usual, it makes sense to restrict the data to just the area you need, in this case, Hebden Bridge is in the Calderdale Local Authority, and we can use that information to restrict the output area data.
The output areas attribute table doesn’t include data about Local Authorities, but we can use the other boundary data we downloaded from the ONS to select the correct data.
· You also have a GeoPackage for the Local Authority Districts - add the layer from this to the same map.
[image: images/census2021/LocalAuthorityDistrictsAll_small.png]
The larger polygons making up the Local Authority Districts layer for England, Wales and Scotland.
This is similar to the Output areas map, but the polygons are much larger. This should contain a boundary polygon which covers the area we need (Calderdale) but you need to find that from the attribute table.
Let’s start by restricting the data in the way we have done with vector layers before. By extracting the polygon for Calderdale, then intersecting the Output areas.
Use the Extract by expression tool to extract the Local Authority District for Calderdale.
· First, check the attribute table for the Local Authority Districts to find out which field contains names - in this case it’s LAD21NM.
· So the Expression you use in Extract by expression should read something like
"LAD21NM" = 'Calderdale'
· Once you have a layer which just contains the polygon for Calderdale, remove the full Local Authority Districts layer from your map to prevent confusion later, and to help your map to redraw more quickly.
· Restyle the Calderdale Local Authority as just an outline, so you can see the Output areas too.
[image: images/census2021/LAAndOA_small.png]
Calderdale Local Authority District and all Output Areas.
[bookmark: select-by-location-1]Select by location
· Now run select by location to select just those output areas that intersect with the Calderdale Local Authority.
[image: images/svg/help_outline-black-24dp.png] Is the resulting selection what you need?
Have a look at the result. Are the selected output areas just within the Calderdale Local Authority?
I found that they weren’t. My result included the output areas within Calderdale, but also those outside that touched the boundary.
[image: images/census2021/SelectedIntersect_small.png]
Select by location using intersect. Output areas around the outside of the local authority are selected too.
· Clear your selection using the Deselect Features from All Layers button on the Selection toolbar.
· Try running select by location again, but this time untick intersect and tick next to are within.
[image: images/svg/help_outline-black-24dp.png] Do you have the selection you need this time?
Again, have a look at the result. Has QGIS selected all the output areas in Calderdale?
This time I found that only output areas within Calderdale which didn’t touch the boundary were selected.
[image: images/census2021/SelectedWithin_small.png]
Select by location using are within. This time only output areas within the local authority, but which don’t touch the boundary, are selected.
Feel free to try the other options under Select by Location. I didn’t find any combination which selected exactly those output areas I wanted to use.
One option at this stage, is to use the selected output areas from the are within result, then use the Select features by single click tool from the Selection toolbar to click on each of the remaining output areas within Calderdale.
This isn’t ideal, and can be a bit fiddly with some of the smaller areas. Instead, it is possible to do the correct selection by using the Selection Within plugin.
[bookmark: selecting-centroids-within-a-polygon]Selecting centroids within a polygon
Start by installing a plugin in the usual way.
· In the menu bar go to Plugins > Manage and Install Plugins...
· Click on All or Not installed and search for Select within.
· Install the Select Within plugin.
[image: images/census2021/PluginsSelectWithin_small.png]
Installing the Select Within plugin.
· Find the plugin by going to Vector > Select within > Select within.
· Start filling in the dialog by entering the output areas layer under Select all features from:
· Under Where check Centroid is selected.
· Is within: should be set to the Calderdale local authority layer.
· Select Creating new selection.
· Click OK to run the selection process.
[image: images/census2021/SelectWithin_small.png]
Filling in the Select within dialog to select output areas with centroids within the Calderdale Local Authority.
As it’s selecting from a lot of records, this may take a while, but you should end up with all of the output areas within Calderdale selected, but none from outside.
You can now Export the selections as a new layer and remove the output areas for the whole of England and Wales from your map. This should speed up redrawing of your map!
You can also delete the original Local Authority and Output Area layers from your disk if you need to save space.
[image: images/census2021/CalderdaleOA_small.png]
The Calderdale Local Authority with all the output areas which have a centroid within it.
[bookmark: X98d439dba646f3918a5b35560acff1f21331f40][bookmark: _Toc160015550]Joining data from a table to a feature class
Finally we are ready to add the census data to the output area boundaries.
If you have a look at the attribute table of the output area boundaries, you’ll see that there is no total population. This is contained in the separate census data that you downloaded.
So how do you map both sets of data together? You do it by joining the data table and the boundary layer into a single data source.
[image: images/svg/videocam-black-24dp.png] Joining data from a table to a feature class in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
To join the data you need to have fields in each source file that match. So have a look at the attribute tables of both the boundary layer and the data file now. This is where you need to be able to think about, and understand, the data that you have downloaded.
[image: images/svg/help_outline-black-24dp.png] Which fields contain matching data?
Which fields in the output areas layer and the csv file contain matching data that can be used to join them? The fields will probably have different names in each file, but should contain the same data.
You are looking for a field which holds a code for each output area. Don’t worry if the codes you see aren’t the same in both files, there are an awful lot of codes in the census data! Just look for a similar style of data.
Close the attribute tables then join the attribute data to the shapefile as follows:
· Double-click on the boundary shapefile in the Layers panel or right-click and go to Properties...
· On the left select the Joins tab
· Click on the plus button at the bottom of the blank window so that the Add Vector Join window opens
· Next to Join layer select the csv table from the dropdown
· Next to Join field select the field that you picked from the csv table as matching a field in the output areas layer - that should be geography in this example.
· The Target field should be the matching field from the output areas layer - that should be OA21CD
· Keep Cache join layer in memory ticked - it speeds up display of the data once you’ve done the join.
· To keep the result tidy tick the Joined fields box and select the fields you want to be able to see in your final data. In this case, select all three.
[image: images/census2021/AddVectorJoin_small.png]
Filling in the fields to create the join.
· Click OK to add the join to the properties window. If you want to check the details you can click on the arrow next to the Setting for a summary.
· Click Apply to set the join, then OK to exit the properties window.
[image: images/census2021/CheckingJoin_small.png]
The summary of the join in the Layer properties for the output areas layer.
You won’t see any obvious difference, but now open the attribute table of the output areas layer again.
If you scroll to the right you should see that the new fields have been added to the attribute table.
At the moment this is a temporary change. If you remove the output areas layer from your map then add it back in, the fields will disappear and you’d have to set up the join again.
To make the join permanent you could export the feature class as a new feature class, as you’ve done previously. There is another change that would be useful, though, and we can combine the two operations and save just the final output to file.
[bookmark: X77f06c3cec1a9d5b152078c4ef83036458e410c]Changing feature class field names and types
The name of the newly joined fields are not tidy - they have the name of the original table before them. It would be useful to change the name to something more helpful. It is possible to do that by using the Refactor fields tool and that tool will also change the type of data, e.g. from text to integer (number).
[image: images/svg/videocam-black-24dp.png] The Refactor fields tool in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the Processing toolbox search for Refactor fields and open the tool from the Vector table toolbox
The form for this tool looks rather complex, but basically it is a list of the fields in your feature class with details of type and length.
· Check that your output areas layer is selected in the dropdown at the top of the form
· In the list of fields look for the new fields - probably at the bottom of the list
· Click in the NAME field for each of the new fields and type a new field name - in this case delete the name of the original table, leaving fields named date and geography.
· Click in the NAME field for the field containing the population data. In my example it is called Age: Total, which isn’t very helpful. I’ll rename it TotalPopulation - as usual, no spaces or odd characters.
· All the data in the total population (TotalPopulation if you’ve renamed it as above) field should be whole numbers, but at the moment the Type may be set to Text (string). Drop down the box under Type and select Whole number (integer - 64bit). This will make it possible to sort the field by population or sum the totals.
· You are creating a new layer with this tool, so click on the three dots button next to Refactored and Save to Geopackage.... You can save this to an existing geopackage. Give your new layer a name, such as OAPopulation
· Run the tool to generate your new layer and add it to your map.
[image: images/census2021/RefactorFields_small.png]
Changing the name and type of the population field with the Refactor Fields tool.
Check the attribute table to see that the changes have been made. The fields will be permanent now. So if you remove the feature class from your map and then add it back again the fields will still be there. Try it if you wish!
[image: images/census2021/JoinedData_small.png]
The output area attribute table showing the joined data.
You can remove the original output areas layer and the csv table from your map now to keep things tidy.
[bookmark: X771c28efe476c8d2cf7907d550048ef59ffdfae][bookmark: _Toc160015551]What is the total population of the Hebden Water watershed?
Let’s see how we can answer this question with the data that we have prepared so far.
You should already have a vector version of the watershed for Hebden Water. Add that to your map now.
· Use Select by Location to select all output areas in the census data that intersect with the watershed polygon.
· Export the selection as a new layer.
At this stage you could open the attribute table and add up the population total for all the output areas, but that’s rather a lot! Let’s get QGIS to do the work instead.
[image: images/svg/videocam-black-24dp.png] Basic statistics for fields in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· In the menu bar go to Vector > Analysis Tools > Basic Statistics for Fields...
· Check that the feature class of the output areas within the watershed is selected as the Input Layer
· The Field to calculate statistics on should be the TotalPopulation
· Under Statistics set the location and name of the output, which will be a web page html file, not a geopackage.
· Then Run the tool
· Don’t close the Log - that will show the results.
[image: images/census2021/BasicStatisticsForFields_small.png]
The processing Log showing the results of the field statistics. Look for the SUM of the TotalPopulation.
Don’t worry if you do close the Log, though, the Results Viewer should open on the right of your map. You can double-click on the Statistics entry to open a webpage with the results. The html file will also be saved to your computer and that should open in a browser if you double-click on it.
· Have a look at the results. For our question, the answer is the SUM, but have a look at what else has been calculated.
[image: images/svg/create-black-24dp.png] Think about your results
Make a note of the sum population in the output areas that intersect the watershed.
Then stop and think about the data that you have used and look at your map.
Output areas are the smallest unit that we can download for census population data. How do those match the area that we are analysing? How would you phrase the explanation of the figures that you have just produced to make it clear what the data shows?
There will be some areas around the edge of the watershed which aren’t covered by the output areas, and also some parts of the output areas which aren’t within the watershed. This is a typical geographical problem, and using the data we have there isn’t much we can do beyond being aware of it.
[bookmark: population-density][bookmark: _Toc160015552]Population density
It’s useful to have a figure for the total number of people resident in our study area, but often population density is a more useful statistic.
In this section we’ll work out the number of people resident per square kilometre (km2) in each output area.
· Open the attribute table of your layer with the total population for output areas within the Hebden Water watershed.
[image: images/svg/help_outline-black-24dp.png] What data do you need to calculate population density?
Think about what data you need to be able to calculate the number of people per square kilometre in each output area.
Looking at your attribute table, do you have all of that data?
Hopefully you’ll have realised that you need both the total population and the area of each output area. You already have the total population data, but you don’t yet have the area. Luckily that is easy to calculate in GIS.
[bookmark: checking-the-measurement-units]Checking the measurement units
For this exercise we want to calculate the number of people per square kilometre.
Before we set up the calculation, it’s worth checking what units QGIS is set to use for our data.
· Open the project properties (Project > Properties or Ctrl-Shift-P) and go to the General tab.
· Look for the Measurements subheading and make a note of what it says next to Units for area measurement. Don’t try to change the units here - that will cause problems later!
The Units for area measurement should be set to Square Meters.
A quick online search shows that the formula for converting square metres to square kilometres is:
m2 / 1,000,000
[bookmark: Xc44a4fd0e8ccc9e4768187714f0685df2b61cf1]Creating an area field with the field calculator
Now we have that information, we can add a new field to our table which will contain the data we need.
You’ve used the field calculator in the last chapter to add new data to a table. We can use that again here.
· Open the attribute table for the population layer.
· Click on the Field calculator button on the toolbar at the top - it’s the button that looks like an abacus.
· In the field calculator, check the Create a new field box is ticked.
· Don’t tick the Create virtual field option - we want this to be permanent.
· Fill in the Output field name with a name that tells you what the field contains, but doesn’t have any spaces or odd characters - I used AreaKM2.
· Set Output field type to Decimal number (real).
· Type area in the search box above the central box.
If you click on a term in the results, you should get more information about it in the right-hand box. Have a look at the information for $area. This is the one that does what you want.
· Double-click on $area. It should be added to the left-hand box, which is where we need to build up the expression.
If you look below the left-hand box, you should see a Preview: of the result. It should be plain that this is calculating the area, but the result is still in square metres, not square kilometres.
To change the result to square kilometres:
· Set up the following expression in the left-hand box, using the $area function you’ve already added.
$area/1000000
· Now the preview shows the result in square kilometres, but has a lot of significant places. We don’t need all of these!
· To round the result, change your expression to the following:
round($area/1000000,4)
Click through the preview results to check that this is a sensible number of significant places and change the number 4 in the expression if you need to.
· Once you are happy with the preview, click OK.
[image: images/census2021/CalculateArea_small.png]
Using the field calculator to calculate the area of each output area in square kilometres.
QGIS should add a new field (column) to the end of your table. Check that this is what you are expecting.
QGIS puts the layer into edit mode to add the new data, so it’s important to remember to Save the edits, then toggle the pencil icon off so you can’t edit anything else by mistake.
[bookmark: calculating-population-density]Calculating population density
Now we have both the total population and the area in square kilometres in our attribute table and are ready to calculate the number of people per square kilometre in each output area.
· Once again, open the field calculator.
· Again, tick to Create a new field and enter a name for your new field.
· Again, this will be a Decimal number (real) field.
· Set up an expression which divides the total population by the area in square kilometres, using the list of fields in the central box to make sure you have entered your field names correctly.
· Use rounding, as above, to reduce the number of significant places to something that suits your data - in this case, make sure you don’t end up with any areas showing a result of just zero.
The expression I used was:
round("TotalPopulation" / "AreaKM2" , 2)
Again, once you’ve added the new field, save the edits, then toggle editing off.
Have a look at your results and check that they look as you expect them to.
In this case, if you want to check against an external source, try the ONS Census Maps web site. You should be able to zoom in on Hebden Bridge and click on an output area to check that your results are similar. Use the Identify tool in QGIS to pick out an output area and have a look at the population density you have calculated.
Note that your results probably won’t be exactly the same as the ONS results, but they shouldn’t be too far out.
[bookmark: Xee5aea0ddce271e565ddd5e4e3737c43ef6ed8f]Displaying population density on your map
Now that you have the population density in your attribute table, you can use styles to display your results on your map.
This type of map is called a Choropleth map and you can use graduated symbols to display the data.
[bookmark: graduated-symbols]Graduated symbols
[image: images/svg/videocam-black-24dp.png] Styling a vector layer with graduated symbols in QGIS
This video clip can be found in the module area of Minerva or in the full list of video clips.
· Select the layer which contains the population density and open the Layer styling panel.
· Dropdown Single symbol at the top and select Graduated. Your layer will probably disappear from your map at this stage, don’t worry just keep following along.
· Dropdown the Value box and select the name of the field your population density data is in.
· Below the white box, click on Classify.
[image: images/census2021/GraduatedStyle_small.png]
Setting a graduated style for your population density area. Choose a suitable colour ramp and set blending mode.
Your layer should reappear.
· You can now change the colour ramp as required.
· Then change any of the other settings, e.g. Mode and have a look at the difference it makes the display of your data.
· You can set Opacity in two different ways.
· The first is to click on the colour box next to Symbol and set Opacity there.
· The second is to use the Layer Rendering settings at the bottom of the Layer styling panel. You can also set the Blending mode here, so this may be the most satisfactory.
Try out different settings to show your data most effectively. Then save your map and go on to setting up a layout to display your data.
[bookmark: suggested-layout-2][bookmark: _Toc160015553]Suggested layout
Use the layers that you have generated to create a map similar to the one below. Include the watershed outline and the output areas which intersect the watershed. Style the output areas by the population density and label each output area with the total population.
You should also include a brief explanation of what you are showing, and the number of people in the selected output areas. Don’t forget to include the usual map elements, such as title, key, scalebar etc.
When you have finished your map, export it as either pdf or an image.
[image: images/census2021/FinalMap_small.png]
Example of a final map for the census data and flooding the Hebden Water. As usual you will have made your own decisions about styles and layout.
[bookmark: X144807777c3d5dad1e7f67b51fde7a05120425c][bookmark: _Toc160015554]Recommended reading and further information on census data
Many of the books in the reading list[footnoteRef:27] have general information about elevation data. Suggestions include the following: [27:  The reading list is available in Minerva and from the library (search for the number of this module).] 

· Longley (2015) discusses the considerations around census data and data about individuals in chapter 17 - particularly section 17.3.1 onwards. p.394+
· Darkes and Spence (2017) - pages 28 onwards look at census and statistical data and at how to display it. Unfortunately this section is not in the downloadable version.
[bookmark: further-information-2]Further information
· The geographer Alastair Rae works extensively with UK statistical data. His blog article entitled Hey, what’s an MSOA? may help to give you a bit more of an idea about census geography. In this chapter we’ve been using OASAs, which are smaller, but the principles are the same. More recently, he has been posting articles based on data from the 2021 census.
[bookmark: going-further-with-gis][bookmark: _Toc160015555]Going further with GIS
Last Modified: 17 Jan 24, 10:03:37
This is the end of the main workbook. When you get this far you should have a good idea of the basics of GIS and you’ll have covered all the essential skills for completing the assessments.
However, there is a lot more to GIS.
In the rest of this module I’ll be introducing further skills. Some of these could help you to take your assessments further, but the lectures over the next few weeks and the chapters in the next workbook will also show you more advanced uses of GIS that you could find useful in the future, not least for your final year dissertation.
The lectures and practicals in the next few weeks cover
· Vector data analysis
· Environmental decision making
· Making repetition more efficient
· Viewing your data in 3D
· Dynamic / time data in GIS
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Multiple operations are possible for converting coordinates between these two Coordinate Reference Systems.
Please select the appropriate conversion operation, given the desired area of use, origins of your data, and any other constraints
which may alter the "fit for purpose"” for particular transformation operations.

Source CRS ~ EPSG:3035 - ETRS89-extended / LAEA Europe
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Remarks: Approximate alternative to official OSTN15 method (tfm code 7953). May be taken as approximate transformation OSGB36 to WGS 84 -
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Ireland; Italy; Kosovo; Latvia; Liechtenstein; Lithuania; Luxembourg; Malta; Monaco; Montenegro; Netherlands; North Macedonia; Norway including
Svalbard and Jan Mayen; Poland; Portugal including Madeira and Azores; Romania; San Marino; Serbia; Slovakia; Slovenia; Spain including Canary
Islands; Sweden; Switzerland; Tirkiye (Turkey); United Kingdom (UK) including Channel Islands and Isle of Man; Vatican City State., United Kingdom
(UK) - offshore to boundary of UKCS within 49°45'N to 61°N and 9°W to 2°F; onshore Great Britain (England, Wales and Scotland). Isle of Man onshore.
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Multiple operations are possible for converting coordinates between these two
Coordinate Reference Systems. Please select the appropriate conversion operation, given
the desired area of use, origins of your data, and any other constraints which may alter the "fit
for burpose" for particular transformation operations.
Source RS EPSG:27700 - OSGB 1936 / British National Grid
Destination CRS EPSG:4326 - WGS 84

Transformation Accuracy (meters)
bl Inverse of British National Grid + OSGB 1936 to WGS 84 (9) 1 Britain and UKCS

2 Inverse of British National Grid + OSGB 1936 to WGS 84 (6) 2 UK - Britain and UKCS 4¢

3 Inverse of British National Grid + OSGB 1936 to WGS 84 (2) UK - Britain and UKCS 4¢

>

Inverse of British National Grid + OSGB 1936 to WGS 84 (9)

Scope: Accuracy 1m.

Remarks: Parameter values taken from OSGB 1936 to ETRS89 (3) (tfm code 7709) assuming
that ETRS89 is coincident with WGS 84 within the accuracy of the tfm. Replaces 0SGB 1936 to
WGS 84 (7) (tfm code 5339).
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Metadata Preview

General
Name NY03.asc
Path K:\gis\EnvSci\Elevation 2023\Data\terrain-50-dtminy\NY03.asc

Sidecar file NYO03.asc.aux.xml

Total size 188 KB

Last modified 17 January 2023 16:08:18 (NY03.asc)

Provider  gdal

Information from provider

Extent

Width

Height

Data type

GDAL Driver Description
GDAL Driver Metadata
Dataset Description
Compression

Band 1

More information
Dimensions

Pixel Size

300000.0000000000000000,530000.0000000000000000 :
310000.0000000000000000,540000.0000000000000000

200

200

Floaté4 - Sixty four bit floating point

AAIGrid

Arc/Info ASCII Grid
K:/gis/EnvSci/Elevation_2023/Data/terrain-50-dtm/ny/NY03.asc

® STATISTICS_MAXIMUM=131.4

® STATISTICS_MEAN=41.897115

© STATISTICS_MINIMUM=-2.5

® STATISTICS_STDDEV=35.136136436392
® STATISTICS_VALID_PERCENT=100

X: 200 Y: 200 Bands: 1
300000.0000000000000000,540000.0000000000000000
50,-50

Coordinate Reference System (CRS)

Name OSGB36 / British National Grid
Units meters
Method Transverse Mercator

Celestial body Earth

Reference Static (relies on a datum which is plate-fixed)
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python3 -m gdal_merge -ot Float64 -of GTiff -o K:/gis/EnvSci/Elevation_Q/
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processing_nGvRVb/a9e8967c4fc14d56be773c049dc99eb5/
mergelnputFiles.txt
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Slope
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GDAL/OGR console call

gdaldem slope K:/gis/EnvSci/Elevation_Q/output/T50_dtm.tif K:/gis/
EnvSci/Elevation_Q/output/T50_slope.tif -of GTiff -b 1 -s 1.0
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K:/gis/EnvSci/Elevation_Q/output/T50_aspect.tif v
v Open output file after running algorithm

GDAL/OGR console call

gdaldem aspect K:/gis/EnvSci/Elevation_Q/output/T50_dtm.tif K:/gis/
EnvSci/Elevation_Q/output/T50_aspect.tif -of GTiff -b 1
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‘@ Plugins | Installed (1)

9 DB Manager

Installed Plugins

Here you only see plugins installed on your QGIS.
Click on the name to see details.

Click the checkbox or double-click the name to activate or deactivate the
plugin.

You can change the sorting via the context menu (right click).

Upgrade Al Uninsall Pugin Reinstall Plugin

Cose | Help
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@ Plugins | Not installed (931)

Q spreadsheet
% GooGIS

Spreadsheet Layers

Load layers from spreadsheet files (*.ods, *.xls, *.xIsx)

This plugin adds a "Add spreadsheet layer" entry in "Layer" / "Add new Layer"
menu and a corresponding button in the "Layers" toolbar.

These two links open the same dialog to load a layer from a spreadsheet file (*.ods,
*.xls, *.xIsx) with some options (use header at first line, ignore some rows and
optionally load geometry from x and y fields).

When this dialog is accepted, it creates a new GDAL VRT file in same folder as the
source data file and layer name, expanded with a .vrt suffix which is loaded into
QGIS using OGR VRT driver.

When reusing the same file twice, the dialog loads its values from the existing .vrt
file,

No need to install additional dependencies.

o7 ve7e7Y 99 rating vote(s), 179321 downloads

Tags excel, xisx, ods, xls, spreadsheet, calc
More info homepage bug tracker ~code repository
Author Camptocamp
Available version (stable) 2.0.1
Upgrade Al Install Plugin
Close | | Help




image134.png
% BR-B-SR-¢-|E





image135.png
@ Create a Layer from a Spreadsheet File X

File Name ‘K:/gisIEnchi/ElevationiQicEGIDoBIH/DOBIH7V177276d.xlsx Browse...
Sheet |hills v

Layer name |Hills

Rows Number of lines to ignore ‘0 ‘ = Header at first line End of file detection
V| Geometry
Fields X field Xcoord v | Y field Ycoord + | Show fields in attribute table
Reference system |Pruject CRS: EPSG:27700 - OSGB 1936 / British National Grid N7 l %\
Number Name Metres Xcoord Ycoord <
|
Integer v |String ¥ |Real v | Integer v | Integer v ‘
1 1 Ben Chonzie 931.0 277324 730857
2] 2 Creagan na Bei... 888.0 274441 736854
3 3 Creag Uchdag 879.0 270828 732324
4 4/ Auchnafree Hill 789.0° 280862 730811117

Help Cancel
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Q National_Parks__England___Natural_England — Features Total: 10, Filtered: 10, Selected: 1
J < ] EENLTYESD ZE 8 8@
CODE NAME MEASURE DESIG_DATE HOTLINK
10 SOUTH DOWNS  1653.00000000... 2009-11-02 http://southdow...

3 EXMOOR 693.000000000... 1954-10-01 http://www.ex...

YORKSHIRE

3 9 DALES 2185.00000000... 2016-08-01 http://www.yor...

4 8 PEAK DISTRICT ~ 1438.00000000... 1951-04-01 http://www.pea...

Click there to select 2 DARTMOOR 956.000000000... 1994-04-01 http://www.dart...

the Lake District NORTH YORK
° MOORS

1441.00000000... 1952-11-01 http://www.nort...
7 5 NEW FOREST 567.000000000... 2005-03-01 http://www.ne...
8 6 NORTHUMBERL... 1051.00000000... 1956-04-01 http://www.nort...

- LAKE DISTRICT 62.00000000

1 THE BROADS 302.000000000...
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File name  K:\gis\EnvSci\Elevation_Q\LakeDistrict.gpkg

Layer name [LakeDistrictNationaIParld

CRS EPSG:27700 - OSGB 1936 / British National Grid

Encoding UTF-8

V' Save only selected features

» Select fields to export and their export options
v Geometry

Geometry type Automatic v

Force multi-type

v Add saved file to map Cancel| Help
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-9999.000000

» Advanced Parameters
Clipped (extent)
K:/gis/EnvSci/Elevation_Q/output/dtm_clipped.tif v

L1

v Open output file after running algorithm

GDAL/OGR console call

gdal_translate -projwin 303282.5887 541489.5595 362257.4908
477647.5841 -a_nodata -9999.0 -of GTiff K:/gis/EnvSci/Elevation_Q/output/
dtm_merged.tif K:/gis/EnvSci/Elevation_Q/output/dtm_clipped.tif

0% Cancel

Run as Batch Process... Run | Close @ Help
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Q r.viewshed X
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Elevation =
=" t50dtm2019 [EPSG:27700] v

Coordinate identifying the viewing position

324467.827328,507219.444437 [EPSG:27700]

Viewing elevation above the ground [optional]

1.750000 a g
Offset for target elevation above the ground [optional]

0.000000 a3
Maximum visibility radius. By default infinity (-1) [optional]

-1.000000 a g
Refraction coefficient [optional]

0.142860 a s
Amount of memory to use in MB [optional]

500 a s

v Advanced Parameters
Consider earth curvature (current ellipsoid)
Consider the effect of atmospheric refraction
v/ Output format is invisible = 0, visible = 1
Output format is invisible = NULL, else current elev - viewpoint_elev
GRASS GIS 7 region extent [optional]
280000.0000,370000.0000,469999.9998,549999.9998 [EPSG:27700] a|| .-
GRASS GIS 7 region cellsize (leave 0 for default)
50.000000 a g
Output Rasters format options (createopt) [optional]

0% Cancel
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Q Polygonize (Raster to Vector) X
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Input layer <
=" vshHallsfell [EPSG:27700] v
Band number
Band 1 (Palette) v
Name of the field to create
DN
Use 8-connectedness
v Advanced Parameters

Additional command-line parameters [optional]

Vectorized

[Save to temporary file]

v Open output file after running algorithm
GDAL/OGR console call

python3 -m gdal_polygonize K:/gis/EnvSci/Elevation_Q/output/Viewsheds/vshHallsfell.tif C:/Users/
Amber/AppData/Local/Temp/processing_tzCIVP/51a9085fe1e245a7bcdedeacl 1d534f5/OUTPUT.gpkg
-b 1 -f "GPKG" OUTPUT DN

0% Cancel

Run as Batch Process... Close | Help
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